Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, refer to the “Important Safety Instructions” listed below to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy certain regulatory compliance requirements. Notices have been included in this publication to call attention to these specific requirements.

Symbol Meanings

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Protective Earth" /></td>
<td>This symbol identifies a Protective Earth (PE) terminal, which is provided for connection of the supply system’s protective earth (green or green/yellow) conductor.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>This symbol on the equipment refers you to important operating and maintenance (servicing) instructions within the Product Manual Documentation. Failure to heed this information may present a major risk of damage or injury to persons or equipment.</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td>The symbol with the word “Warning” within the equipment manual indicates a potentially hazardous situation, which if not avoided, could result in death or serious injury.</td>
</tr>
<tr>
<td><img src="image" alt="Notice" /></td>
<td>The symbol with the word “Caution” within the equipment manual indicates a potentially hazardous situation, which if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.</td>
</tr>
<tr>
<td><img src="image" alt="Notice" /></td>
<td>The symbol with the word “Notice” within the equipment manual indicates a situation, which if not avoided, may result in major or minor equipment damage or a situation, which could place the equipment in a non-compliant operating state.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Hazardous Voltages" /></td>
<td>This symbol is intended to alert the user to the presence of uninsulated “dangerous voltage” within the product enclosure that may be of sufficient magnitude to constitute a risk of shock to persons.</td>
</tr>
<tr>
<td><img src="image" alt="ESD Susceptibility" /></td>
<td>This symbol is used to alert the user that an electrical or electronic device or assembly is susceptible to damage from an ESD event.</td>
</tr>
</tbody>
</table>

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with a dry cloth.
7) Do not block any ventilation openings. Install in accordance with manufacturer’s instructions.
8) Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The third prong is provided for your safety. If the provided plug does not fit in to your outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.

11) Only use attachments/accessories specified by the manufacturer.

12) Unplug this apparatus during lightning storms or when unused for long periods of time.

13) Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

14) Do not expose this apparatus to dripping or splashing, and ensure that no objects filled with liquids, such as vases, are placed on the apparatus.

15) To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord plug from the AC receptacle.

16) The mains plug of the power supply cord shall remain readily operable.

17) The SD (Video Production Switcher) chassis is to be rack mounted only.

**Warning**

18) **Indoor Use: WARNING:** To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

19) The safe operation of this product requires that a protective earth connection be provided. A grounding conductor in the equipment's supply cord provides this protective earth. To reduce the risk of electrical shock to the operator and service personnel, this ground conductor must be connected to an earthed ground.

20) **WARNING:** This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

21) **CAUTION:** These service instructions are for use by qualified service personnel only. To reduce the risk of electric shock, do not perform any servicing other than that contained in the operating instructions unless you are qualified to do so. (Installation Guide only.)

22) This apparatus contains a Lithium battery, which if replaced incorrectly, or with an incorrect type, may cause an explosion. Replace only with the same type. Dispose of used batteries according to the manufacturer’s instruction.

23) Service barriers within this product are intended to protect the operator and service personnel from hazardous voltages. For continued safety, replace all barriers after servicing.

24) Certain parts of this equipment still present a safety hazard with the power switch in the OFF position. To avoid electrical shock, disconnect all A/C power cords from the chassis' rear appliance connectors before servicing.

25) This product contains safety critical parts, which, if incorrectly replaced, may present a risk of fire or electrical shock. Components contained within the product’s power supplies and power supply area are not intended to be customer-serviced and should be returned to the factory for repair.

26) To reduce the risk of fire, replacement fuses must be the same type and rating.
27) Use only power cords specified for this product and certified for the country of use. Refer to the Product Power Cord Requirement section that follows.

28) The safe operation of this equipment requires that the User heed and adhere to all installation and servicing instruction contained within the equipment’s manuals.

**Product Power Cord Requirements**

**North American Line Voltages 100 - 120 Volt**

This product is supplied with certified 10A/125V SVT type supply cords. Conductors are color coded white (neutral), black (line) and green or green/yellow (ground).

Operation of this equipment at line voltages exceeding 130V requires that alternative supply cords with appropriate voltage and current ratings be used.

**International Line Voltages 200 - 240 Volts**

This product has been designed for use with certified IEC 320- C13 10A/250V - H03 VV-F3G 1.00mm² type line cord.

International product orders are supplied with a certified 10A/250V line cords, utilizing a molded 3-pin IEC 320-C13 type connector at one end and stripped conductors on the other. One line cord is provided. Conductors are CEE color coded; blue (neutral), brown (line), and green/yellow (ground).

Installation by a qualified electrician, of an appropriately approved A/C wall plug certified for the country of use, is required.

Alternatively, other IEC 320 C-13 type power cords may be used, provided that they meet the necessary safety certification requirements for the country in which they are to be used. Refer to the correctly specified line cord above.

**EMC Notices**

**United States of America**

**FCC Part 15**

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**Notice**

Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.

**CANADA**

This Class “A” digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe “A” est conforme a la norme NMB-003 du Canada.
EUROPE
This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

INTERNATIONAL
This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002, and found to comply with the limits for a Class A Digital device.

Notice
This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

General Handling Guidelines
• Careful handling, using proper ESD precautions, must be observed.
• Power down the system before PCB removal.

A Word About Static Discharge
Throughout the many procedures in this guide, please observe all static discharge precautions.

Notice
Avoid handling the switcher circuit boards in high static environments such as carpeted areas, and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame, and exercise proper grounding precautions when working on circuit boards.
Warranty and Repair Policy

Ross Video Limited (Ross) warrants its switchers and related options, to be free from defects under normal use and service for a period of THREE YEARS from the date of shipment. Fader handle assemblies are warranted for the life of the product. If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

Software upgrades for switchers may occur from time to time, and are determined by Ross Video. The upgrades are posted on the Ross Video website, and are free of charge for the life of the switcher.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.
Company Address

Ross Video Limited
8 John Street
Iroquois, Ontario, K0E 1K0
Canada

Ross Video Incorporated
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

Technical Support: (+1) 613 • 652 • 4886
After hours emergency: (+1) 613 • 349 • 0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com
Website: http://www.rossvideo.com
## Contents

### Volume I

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Control Panel Introduction</td>
<td>2</td>
</tr>
<tr>
<td>Using the Menu System</td>
<td>3</td>
</tr>
<tr>
<td>Switcher Basics</td>
<td>4</td>
</tr>
<tr>
<td>Background Transitions</td>
<td>5</td>
</tr>
<tr>
<td>Pattern Control</td>
<td>6</td>
</tr>
<tr>
<td>Keying</td>
<td>7</td>
</tr>
<tr>
<td>Memory Functions and More</td>
<td>8</td>
</tr>
<tr>
<td>Custom Controls</td>
<td>9</td>
</tr>
<tr>
<td>Glossary of Terms</td>
<td>GL</td>
</tr>
<tr>
<td>Index</td>
<td>IX</td>
</tr>
</tbody>
</table>
Synergy Series Operation Guide (v18)

Contents

Ultimatte Insider

Ultimatte Insider Option Overview ................................................................. 12-2
Ultimatte Carrier Mode Overview ................................................................. 12-2
Ultimatte Bus Mode Overview ................................................................ 12-3
Ultimatte Insider Setup – Carrier Mode ...................................................... 12-4
Ultimatte Insider Setup – Bus Mode .............................................................. 12-6
Ultimatte Auto Select Key Setup ................................................................. 12-10
Ultimatte Insider Operation ....................................................................... 12-11
Color Gates ............................................................................................... 12-16
Ultimatte Insider Operating Tips ................................................................. 12-19

Dual Aspectizer

Dual Aspectizer Option and Overview ........................................................... 13-2
Dual Aspect Production Overview ............................................................... 13-2
Dual Aspectizer Mode Descriptions .............................................................. 13-4
Single Output Production – Input Mode .................................................... 13-4
Single Output Production – Bus Mode ....................................................... 13-5
Dual Output Production – Downstream Mode ........................................... 13-5
Dual Output Production – With Extra Content ........................................... 13-6
Dual Aspectizer Mode Comparisons ............................................................ 13-7
Input Mode ............................................................................................... 13-7
Bus Mode ............................................................................................... 13-8
Downstream Mode .................................................................................... 13-9
Conclusion .............................................................................................. 13-9
Dual Aspectizer Setup ............................................................................... 13-10
Configuring the Aspectizer for Operation ................................................ 13-10
Input Mode Setup ..................................................................................... 13-12
Input Mode Setup ..................................................................................... 13-12
Input Mode Menus .................................................................................. 13-13
Input Mode Operation ............................................................................... 13-18
Warnings – General Rules ..................................................................... 13-18
Single Output Production – Input Mode .................................................... 13-19
Example 1.1 ............................................................................................ 13-19
Example 1.2 ............................................................................................ 13-20
Bus Mode Setup ..................................................................................... 13-24
Bus Mode Setup ..................................................................................... 13-24
Bus Mode Menus ................................................................................... 13-28
Bus Mode Operation ............................................................................... 13-33
Single Output Production – Bus Mode .................................................... 13-34
Downstream Mode Setup ....................................................................... 13-37
Downstream Mode Setup ....................................................................... 13-37
Downstream Mode Menus ...................................................................... 13-40

Clip Control

Clip Control Overview ............................................................................... 14-2
Clip Control Overview ............................................................................... 14-2
Setting Up and Playing Clips Overview .................................................... 14-3
Communications Setup ........................................................................... 14-5
Communications Setup ........................................................................... 14-5
Programming Custom Control Buttons .................................................... 14-6
Programming VTR and Video Server Custom Controls ......................... 14-6
Programming Audio Server Custom Controls ........................................ 14-7
Programming Clips ................................................................. 14-8
  Programming VTR Clips ..................................................... 14-8
Grabbing a Timecode ............................................................... 14-10
Programming Video Server Clips ........................................... 14-11
  Grabbing a Timecode ........................................................... 14-15
Previewing Audio Server Clips ............................................... 14-16
  Previewing Audio Server Clips .............................................. 14-16
Programming Audio Server Clips ............................................ 14-18
  Programming Audio Server Clips ........................................... 14-18
Running VTR and Video Server Clips ....................................... 14-21
  Using the Remote Control Menu .......................................... 14-21
Running Clips .......................................................................... 14-22
Application Notes ...................................................................... 14-27
  Using Clips and Subclips on the Leitch ASC ........................... 14-27

External DSK 3/4 (CDK-111A-M) ............................................... 15
  Overview ............................................................................... 15-2
  External Downstream Keyer (CDK-111A-M) Setup .................... 15-3
  Operation ............................................................................... 15-6
    Downstream Key Groups ...................................................... 15-6
    Key Functions ..................................................................... 15-7

Appendix A. Menu Trees ......................................................... 16
  BNC Configuration Menu Tree ............................................... 16-2
  Installation Setup Menu Tree ................................................ 16-3
  Communications Menu Tree .................................................. 16-4
  Custom Control Menu Tree .................................................... 16-5
  Custom Control Banks Menu Tree .......................................... 16-6
  Disk Menu Tree ...................................................................... 16-7
  Recall Factory Menu Tree ....................................................... 16-8

Appendix B. How Do I… .......................................................... 17
  Smoothly Move a Key ............................................................ 17-2
  Create a 3D Over-the-Shoulder Box and Save it for Reuse ........... 17-8
  Move a 3D Over-the-Shoulder Box .......................................... 17-18
  Make an Effect Repeat Indefinitely .......................................... 17-29
  Connect Serial Devices Via the Remote Port Expander ............... 17-38
  Set Up Communications for the Remote Port Expander ............... 17-40
  Connect Devices to the Panel through the Remote Port Expander ... 17-43
  Create a Six-Box Effect and Save it for Reuse ......................... 17-46
  Build Sequences for a Six-Box Effect ...................................... 17-53
  Build Custom Controls to run a Six-Box Effect ......................... 17-61
  Run a 6-Box Effect .................................................................. 17-68

Glossary of Terms ................................................................. GL

Index ...................................................................................... IX
Peripheral Device Control

In This Chapter

This chapter provides instructions for using peripheral devices, such as character generators and remote cameras, and additional features such as Aux Buses. The following topics are discussed:

- GPI Control
- Remote Camera Control Interface
- Character Generator Interface
- Still Store Interface
- Editor Interface
- Router Interface
- Aux Bus Group
- Remote Aux Panels
GPI Control

The Synergy switcher’s GPI function provides 12 input ports and 12 output ports, each of which can be programmed for specific functions.

- The **GPI Input** function allows you to associate a GPI input pulse with an *area, button, Custom Control, and memory recall* on the switcher that you would like to trigger, when that specific pulse is received from an external device. For example, trigger MLE 3 Auto Trans, or trigger Custom Control Bank 1 Button 2, or memory recall.

- The **GPI Output** function allows you to set up triggers that can be used to activate functions on remote devices. For example, Play Forward on a VTR, Advance to Next Still on a Still Store, or tallies.

GPI Input Control — Area and Button

**Note**
Consult with your facility engineer as required. Refer to your GPI Input Worksheet for information on the switcher locations and GPI assignments of your facility.

The **GPI Input Setup Menu** allows you to associate each GPI Input with an *area and button* on the switcher that you would like to trigger.

Use the following procedure to set up and trigger your GPI input functions for an area and button:

1. Ensure that GPI lines are properly connected from the desired external devices to the Synergy switcher.

2. Ensure that each GPI line is properly set up using the **GPI Setup Menu**. Setup parameters include GPI number, trigger location on the switcher, transition type, and polarity.

Refer to the section, “**GPI Setup**” of the *Synergy Series Installation Guide*, for further instructions.

3. If you want to change a switcher location for a particular GPI input pulse, navigate to the **GPI Setup Menu** as follows:

   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ GPI I/O ⇒ Inputs.

4. Set up your GPI Input ports as follows:

   - Use the **GPI** knob to select the GPI Input port to which you want to assign a transition type and location. You can select between 1 and 12.
• Use the **Function** knob to select between **Off**, **Auto**, **Cut**, **Cust Ctrl**, and **Mem Recall**.

• Use the **Area** knob to select the switcher area to trigger. Choose between **MLE 1, 2, 3, 4** or the **Fade to Black Group**.

  ~ When **Auto** or **Cut** is selected and an **MLE** is chosen, the **CUT** or **AUTO TRANS** button in the **Transition Group** of the selected MLE is triggered, respectively — when a GPI input pulse is received.

  ![GPI Trigger Locations — MLE Transition Group](image)

  ~ When **Auto** or **Cut** is chosen and the “**Fade to Black**” area is selected, the **CUT** or **FADE** button in the **Fade to Black Group** is triggered, respectively — when a GPI input pulse is received.

  ![GPI Trigger Locations — Fade to Black Group](image)

  ~ When **OFF** is chosen, *nothing* will happen when an incoming pulse is received from an external device.

5. If you selected **Cust Ctrl**, or **Mem Recall**, see the procedures for their GPI input control on the following pages.

6. Repeat steps 5 through 7 for any additional GPI input ports that you wish to change.

7. To enable the switcher to receive (and act upon) a GPI input pulse:

   • Enable the **GPI** button in the **Remote Section** of the **Global Memory System Group**.

     ~ When **GPI** is lit, remote GPI control is enabled (but local operation can still be performed).

     ~ When **GPI** is not lit, external GPI control is disabled.

This completes the procedure to set up and trigger your GPI input functions for an area and button.
GPI Input Control — Custom Control

Use the following procedure to set up and trigger Custom Controls with your GPI input function:

1. Navigate to the GPI I/O Setup Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ GPI I/O.

GPI Custom Control Setup Menu

2. Set up your Custom Control with a GPI Input function as follows:
   - Use the GPI Input knob to select the GPI input you will use to trigger the Custom Control.
   - Use the Function knob to select the Cust Ctrl function. Notice that the bottom knob label changes to Cust Ctrl.
   - Use the Cust Ctrl knob to select the Custom Control you wish to have triggered by the selected GPI input. The list displays the default name, and the bank, status, and button number of the custom controls available.

This completes the procedure to set up and trigger Custom Controls with your GPI input function.

GPI Input Control — Memory Recall

Use the following procedure to set up and trigger memory recalls with your GPI input function:

1. Navigate to the GPI I/O Setup Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ GPI I/O.

GPI Memory Recall Menu

2. Set up your Memory Recall with a GPI Input function as follows:
   - Use the GPI Input knob to select the GPI input you will use to trigger the memory recall.
   - Use the Function knob to select the Mem Recall function. Notice that the bottom knob label changes to Memory.
• Use the **Memory** knob to select the memory you wish to have triggered by the selected GPI input.

This completes the procedure to set up and trigger memory recalls with your GPI input function.

**GPI Output Control**

Each of the 12 GPI Outputs are *named* using the **GPI Output Setup Menu**. This function is performed by your facility engineer during switcher installation. Refer to the section, “**GPI Setup**” in the *Synergy Series Installation Guide*, for instructions on naming each GPI output.

GPI Outputs are triggered by programming a custom control button. Refer to the section “**Custom Control Overview**” for more information.
Remote Camera Control Interface

The Synergy Switchers can interface with specific remote camera control devices. Remote Camera Controllers allow you to control various aspects of the camera, such as pan, tilt and zoom, depending on the camera you are controlling from the switcher.

Important

The Synergy switcher cannot control a Robotic Camera that has been disabled in the OverDrive menus. You must toggle the EDITOR button OFF to enable control of the camera from the Synergy switcher. Refer to the OverDrive documentation for details.

The Robotic System Interface option must be installed in order to control a remote camera mount using the Synergy switcher. Refer to the section, “Setting up the Switcher” in Chapter 19 of the Synergy Series Installation Guide, for full configuration instructions. For information on programming custom controls for your remote camera controller, refer to the section, “Robotic Camera Custom Controls” in Chapter 19 of the Synergy Series Installation Guide.

This section provides procedures to control specific robotic cameras from the Synergy switcher.

Telemeterics Remote Camera Controller

Use the following procedure to control a Telemeterics Remote Camera from your Synergy switcher:

1. Navigate to the Remote Control Select Menu as follows:

   Operating Tip

   You can press the crosspoint button that is assigned to the Remote Camera you want to control to display the Camera Head Control Menu directly.

   • Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.

2. Press Robotic Camera to display the Robotic Camera Menu.

3. Use the BNC knob to select the BNC that the camera you want to control is connected to.

4. Press GO!! to display the Camera Head Control Menu.

5. Adjust the Pan, Tilt, and Zoom of the camera as follows:

   • Press Pan/Tilt/Zoom to display the Pan/Tilt/Zoom Menu.
Camera Head Control — Pan/Tilt/Zoom Menu

- Use the **Pan** knob to have the camera turn right or left:
  - **Pan Right** — Turn the **Pan** knob to the right (clockwise).
  - **Pan Left** — Turn the **Pan** knob to the left (counter-clockwise).

- Use the **Tilt** knob to have the camera look up or down:
  - **Tilt Up** — Turn the **Tilt** knob to the right (clockwise).
  - **Tilt Down** — Turn the **Tilt** knob to the left (counter-clockwise).

- Use the **Zoom** knob to have the camera zoom in or out:
  - **Zoom In** — Turn the **Zoom** knob to the right (clockwise).
  - **Zoom Out** — Turn the **Zoom** knob to the left (counter-clockwise).

6. Adjust the Iris, Focus and Pedestal of the camera as follows:

   **Note**

   On the Telemetrics Camera, the **Iris Control** must be set to **manual** in order to be able to control it from the Synergy switcher.

- Press **Lens** to display the **Lens Menu**.

Camera Head Control — Lens Menu

- Use the **Iris** knob to have the iris on the camera open and close:
  - **Iris Open** — Turn the **Iris** knob to the right (clockwise).
  - **Iris Closed** — Turn the **Iris** knob to the left (counter-clockwise).

- Use the **Focus** knob to have the camera focus in or out:
  - **Focus Background** — Turn the **Focus** knob to the right (clockwise).
  - **Focus Foreground** — Turn the **Focus** knob to the left (counter-clockwise).

- Use the **Pedestal (Black)** knob to adjust the Master Pedestal, or Black levels, for picture contrast and quality.
7. Adjust the Trolly, Televator or Dolly of the camera as follows:

- Press **Location** to display the **Location Menu**.

- Use the **Televator/Trolley** knob to move the camera up or down on the Televator:
  - **Camera UP** — Turn the **Televator/Trolley** knob to the **right** (clockwise) to extend the Televator up.
  - **Camera Down** — Turn the **Televator/Trolley** knob to the **left** (counter-clockwise) to retract the televator down.

- Use the **Dolly** knob to have the camera move on the Camera Track.

8. Store the current shot as follows:

- Press **Store Shot** to display the **Store Shot Menu**.

- Use the **Shot** knob to select the location (**0-63**) you wish to store the current shot.
- Press **Perform Store** to store the shot in the selected location.

---

Operating Tip

You can use the Positioner to move the camera around quickly.

---

Operating Tip

If the **Shot Offset** feature is set to **0** on the Synergy **Extra Options Menu**, the shot number displayed on the Synergy **Store Shot** and **Recall Shot Menus** will not match the Shot Box number on the Telemetrics camera. Refer to the **Synergy Installation Guide** for information on setting this menu option.
9. Recall a saved shot as follows:
   - Press **Recall Shot** to display the **Recall Shot Menu**.
   - Use the **Shot** knob to select the location (0-63) you wish to recall a shot from.
   - Press **Perform Recall** to recall the shot from the selected location.

This completes the procedure for controlling a Telemeterics Remote Camera from the Synergy switcher.

**Radamec Robotic Camera Controller**

Use the following procedure to control a Radamec Robotic Camera from your Synergy switcher:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.

2. Press **Robotic Camera** to display the **Robotic Camera Menu**.

3. Use the **BNC** knob to select the BNC that the camera you want to control is connected to.

4. Press **GO!!** to display the **Camera Head Control Menu**.

5. Adjust the Pan, Tilt, and Zoom of the camera as follows:
   - Press **Pan/Tilt/Zoom** to display the **Pan/Tilt/Zoom Menu**.
Camera Head Control — Pan/Tilt/Zoom Menu

- Use the **Pan** knob to have the camera turn right or left:
  - **Pan Right** — Turn the **Pan** knob to the **right** (clockwise).
  - **Pan Left** — Turn the **Pan** knob to the **left** (counter-clockwise).
- Use the **Tilt** knob to have the camera look up or down:
  - **Tilt Up** — Turn the **Tilt** knob to the **right** (clockwise).
  - **Tilt Down** — Turn the **Tilt** knob to the **left** (counter-clockwise).
- Use the **Zoom** knob to have the camera zoom in or out:
  - **Zoom In** — Turn the **Zoom** knob to the **right** (clockwise).
  - **Zoom Out** — Turn the **Zoom** knob to the **left** (counter-clockwise).

6. Adjust the Iris, Focus and Pedestal of the camera as follows:

- Press **Lens** to display the **Lens Menu**.

Camera Head Control — Lens Menu

- Use the **Iris** knob to have the iris on the camera open and close:
  - **Iris Open** — Turn the **Iris** knob to the **right** (clockwise).
  - **Iris Closed** — Turn the **Iris** knob to the **left** (counter-clockwise).
- Use the **Focus** knob to have the camera focus in or out:
  - **Focus Background** — Turn the **Focus** knob to the **right** (clockwise).
  - **Focus Foreground** — Turn the **Focus** knob to the **left** (counter-clockwise).
- Use the **Pedestal (Black)** knob to adjust the Master Pedestal, or Black levels, for picture contrast and quality.

7. Store the current shot as follows:

- Press **Store Shot** to display the **Store Shot Menu**.
Camera Head Control

Use the Shot knob to select the location (0-63) you wish to store the current shot.

- Press Perform Store to store the shot in the selected location.

8. Recall a saved shot as follows:

- Press Recall Shot to display the Recall Shot Menu.

- Use the Shot knob to select the location (0-63) you wish to recall a shot from.

- Press Perform Recall to recall the shot from the selected location.

This completes the procedure for controlling a Radamec Robotic Camera from the Synergy switcher.

**Canon Robotic Camera Controller**

**Important**

When the Canon Robotic Camera recovers from a loss of power, it may automatically reset its values for positions such as Iris and Focus. These changes may not be updated in the Synergy switcher menu system. Refer to your Canon camera documentation for more information.

Use the following procedure to control a Canon Robotic Camera from your Synergy switcher:

1. Navigate to the Remote Control Select Menu as follows:

2. Press Robotic Camera to display the Robotic Camera Menu.

3. Use the BNC knob to select the BNC that the camera you want to control is connected to.
4. Press **GO!!** to display the **Camera Head Control Menu 1-2**.

5. Adjust the Pan, Tilt and Zoom of the camera as follows:

   **Operating Tip**
   
   You can also use the Positioner to move the camera around quickly.

   - Press **Pan/Tilt/Zoom** to display the **Pan/Tilt/Zoom Menu**.

   ![Camera Head Control — Pan/Tilt/Zoom Menu]

   - Use the **Pan** knob to have the camera turn right or left:
     - **Pan Right** — Turn the **Pan** knob to the **right** (clockwise).
     - **Pan Left** — Turn the **Pan** knob to the **left** (counter-clockwise).

   - Use the **Tilt** knob to have the camera look up or down:
     - **Tilt Up** — Turn the **Tilt** knob to the **right** (clockwise).
     - **Tilt Down** — Turn the **Tilt** knob to the **left** (counter-clockwise).

   - Use the **Zoom** knob to have the camera zoom in or out:
     - **Zoom In** — Turn the **Zoom** knob to the **right** (clockwise).
     - **Zoom Out** — Turn the **Zoom** knob to the **left** (counter-clockwise).

6. Select a **Lens Mode** as follows:

   - Press **Lens** to display the **Lens Menu**.

   ![Camera Head Control — Lens Menu]

   - Toggle **Set to** between **Manual** and **Auto** as follows:
     - **Manual** — Select this option to allow you to set the Lens values from the Synergy **Lens Menu**.
7. Adjust the Iris and Focus of the camera as follows:
   • Press **Lens** to display the **Lens Menu**.
   • Use the **Iris** knob to have the iris on the camera open and close:
     ~ **Iris Open** — Turn the **Iris** knob to the **right** (clockwise) to set a value up to 100%.
     ~ **Iris Closed** — Turn the **Iris** knob to the **left** (counter-clockwise) to set a value up to 0%.
   • Use the **Focus** knob to have the camera focus in or out:
     ~ **Focus Background** — Turn the **Focus** knob to the **right** (clockwise).
     ~ **Focus Foreground** — Turn the **Focus** knob to the **left** (counter-clockwise).

8. Press **Run Wiper** to activate the Lens Wiper on the Canon robotic camera.

9. Store the current shot as follows:
   • Press **Store Shot** to display the **Store Shot Menu**.

<table>
<thead>
<tr>
<th>Camera Head Control (1-29)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: Ruko (25)</td>
</tr>
<tr>
<td>Camera: Canon (RS) — Camera 6</td>
</tr>
<tr>
<td>Shot: (1)</td>
</tr>
</tbody>
</table>

   Camera Head Control — Store Shot Menu

   • Use the **Shot** knob to select the location (0-63) you wish to store the current shot to.
   • Press **Perform Store** to store the shot in the selected location.

10. Recall a stored shot as follows:

   ~ **Auto** — Select this option to disable Synergy switcher control over the Canon camera.

   **Note**
   When the Canon camera recovers from a loss of power, it may automatically reset its mode to **Auto** without updating the Synergy switcher. Refer to your Canon camera documentation for more information.

   **Important**
   When the Canon camera recovers from a loss of power, it may automatically set its Iris value to fully **Open**. This change may not be updated in the Synergy switcher menu system. The Synergy switcher may display the last Iris value before the loss of power on the Canon camera. Refer to your Canon camera documentation for more information.

   **Note**
   When you manually adjust the **Focus** on the Canon camera, the new values may not be updated on the Synergy switcher. Refer to your Canon camera documentation for more information.
• Press **Recall Shot** to display the **Recall Shot Menu**.

![Camera Head Control — Recall Shot Menu]

- Use the **Speed** knob to set the time in seconds before the Synergy switcher recalls the next shot.
- Use the **Shot** knob to select the location (0-63) you wish to recall a shot from.
- Press **Perform Recall** to recall the shot from the selected location.

This completes the procedure for controlling a Canon Robotic Camera from the Synergy switcher.

### Sony Robotic Camera Controller

Use the following procedure to control a Sony Robotic Camera from your Synergy switcher:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press HOME ➔ Effects ➔ MORE ➔ Remote Control Select.
2. Press **Robotic Camera** to display the **Robotic Camera Menu**.

![Remote Control Select — Robotic Camera Menu]

3. Use the **BNC** knob to select the BNC that the camera you want to control is connected to.
4. Press **GO!!** to display the **Camera Head Control Menu 1-2**.
5. Adjust the Pan, Tilt and Zoom of the camera as follows:

   - Press **Pan/Tilt/Zoom** to display the **Pan/Tilt/Zoom Menu**.

   ![Operating Tip]
   You can also use the Positioner to move the camera around quickly.

---

10–14 • Peripheral Device Control

Synergy Series Operation Guide (v18)
Camera Head Control — Pan/Tilt/Zoom Menu

- Use the Pan knob to have the camera turn right or left:
  - Pan Right — Turn the Pan knob to the right (clockwise).
  - Pan Left — Turn the Pan knob to the left (counter-clockwise).

- Use the Tilt knob to have the camera tilt up or down:
  - Tilt Up — Turn the Tilt knob to the right (clockwise).
  - Tilt Down — Turn the Tilt knob to the left (counter-clockwise).

- Use the Zoom knob to have the camera zoom in or out:
  - Zoom In — Turn the Zoom knob to the right (clockwise).
  - Zoom Out — Turn the Zoom knob to the left (counter-clockwise).

6. Toggle the D-Zoom between On and Off as follows:

- On — Select this option to set the Zoom feature to Digital with a zoom limit of 48x. Refer to the Sony documentation for more information on using the Digital Zoom feature of your robotic camera.
- Off — Select this option turn the Digital Zoom feature off. The Zoom feature is now set to Optical with a zoom limit of 18x.

7. Select a Lens Mode as follows:

- Press Lens to display the Lens Menu.

- Toggle the Mode button between Manual and Auto as follows:
  - Manual — Select this option to allow you to set the Lens values from the Synergy switcher. This option must be enabled to use the Synergy Lens Menu.
  - Auto — Select this option to have the robotic camera control the Lens values.
8. Adjust the Iris, Focus and Shutter speed of the camera as follows:
   • Use the Iris knob to have the iris on the camera open and close:
     ~ Iris Open — Turn the Iris knob to the right (clockwise).
     ~ Iris Closed — Turn the Iris knob to the left (counter-clockwise).
   • Use the Focus knob to have the camera focus in or out:
     ~ Focus Background — Turn the Focus knob to the right (clockwise).
     ~ Focus Foreground — Turn the Focus knob to the left (counter-clockwise).
   • Use the Shutter Speed knob to adjust the shutter speed of the camera. Refer to your robotic camera documentation for details on selecting the required shutter speed for your particular camera.

9. Adjust the White Balance, Picture Effect or Image Ratio of the camera as follows:
   • Press Picture to display the Picture Menu.

<table>
<thead>
<tr>
<th>Camera Head Control (1-2)</th>
<th>White Balance Mode:</th>
<th>Effect:</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: BNC 10 (16)</td>
<td>Auto 432K</td>
<td>None</td>
</tr>
<tr>
<td>Camera: Sony (R1) - Camera 2</td>
<td>Auto 64K</td>
<td>Negative</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pan/Tilt</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lens</td>
<td>Picture</td>
<td>Store</td>
</tr>
<tr>
<td>Picture</td>
<td>Shot</td>
<td>Recall</td>
</tr>
<tr>
<td>Store Shot</td>
<td>Shot</td>
<td>Image Ratio: 4:3</td>
</tr>
</tbody>
</table>

Camera Head Control — Picture Menu

   • Use the White Balance Mode knob to match the mode the white balance color temperature with the light source. This creates an accurate reproduction of natural colors. You can choose from the following:
     ~ Auto — Select this option to permit the camera to automatically find the best possible white balance.
     ~ 32K — Select this option to set the color temperature to 3200 Kelvin which is suitable for indoor lighting.
     ~ 64K — Select this option to set color temperature to 6400 Kelvin which is suitable for outdoor lighting.
   • Use the Effect knob to apply a special effect to the image. You can choose from the following:
     ~ None — Select this option to ensure that no effects are applied.
     ~ Negative — Select this option to display a brightness and color-converted form of the image.
     ~ Black and White (B&W) — Select this option to display a gray-scale image.
   • Use the Image Ratio knob to set the image ratio of the camera output.

10. Store the current shot as follows:
   • Press Store Shot to display the Store Shot Menu.
11. Recall a saved shot as follows:

- Press **Recall Shot** to display the **Recall Shot Menu**.

12. Press **MORE** to display the **Camera Head Control Menu 2-2**.

13. Toggle the **IR Receive** button between **On** and **Off** as follows:

**Important**

The Synergy switcher can control up to 8 robotic cameras whereas the Sony Infrared Remote Controller has a limit of 3. Ensure that when the Infrared Remote Controller is enabled, that you are controlling the desired camera(s).

Refer to the Sony documentation for information on using the Infrared Remote Controller with multiple robotic cameras.
• **On** — Select this option to allow both the Synergy switcher and the Sony Infrared Remote Controller to control up to 3 Sony robotic cameras. Any values changed by the Infrared Remote Controller are updated on the Synergy switcher.

• **Off** — Select this option to turn the Infrared Remote Controller off. The Infrared Remote Controller is set to **Off** by default.

This completes the procedure for controlling a Sony robotic camera from the Synergy switcher.

**Eagle Pan Tilt System**

**Note**

The knob values in the **Remote Control Select Menu** for the Eagle Pan Tilt System display velocity and not position. This means that as you adjust the camera, the change in values will be displayed in the **Remote Control Select Menu**. However, the values will return to 0 once you stop adjusting your camera.

Use the following procedure to control an Eagle PT-101 Pan Tilt System from your Synergy switcher:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME** ⇒ **Effects** ⇒ **MORE** ⇒ **Remote Control Select**.

2. Press **Robotic Camera** to display the **Robotic Camera Menu**.

3. Use the **BNC** knob to select the BNC that the camera you want to control is connected to.

4. Press **GO!!** to display the **Camera Head Control Menu 1-2**.

5. If you are using a Fujinon/Canon lens with your Eagle Pan Tilt System, you can toggle the **Lens Mode** as follows:
   - Press **MORE** to display the **Camera Head Control Menu 2-2**.
   - Toggle the **Lens Mode** to set the type of lens control as follows:
     - **Speed** — Use this option to enable the Speed Mode for adjusting the lens. When **Store Shot** is selected, a message is displayed in the main area of the Camera Head Control Menu to toggle the Lens Mode to **Position** before attempting to save a prepared shot. This is the default setting.
6. Adjust the Pan, Tilt and Zoom of the camera as follows:

• Press MORE to display the Camera Head Control Menu 1-2.

7. Adjust the Iris, Focus and Pedestal of the camera as follows:

• Press Lens to display the Lens Menu.

---

**Important**

When you toggle the Lens Mode from **Speed** to **Position**, the Eagle Pan Tilt System returns to its default position. Refer to your Eagle documentation for details on this function.

~ **Position** — Use this option to enable the Position Mode for adjusting the lens. You must select this option before setting up and saving a shot.

• Press MORE to display the Camera Head Control Menu 1-2.

---

**Operating Tip**

You can also use the Positioner to adjust the pan, tilt and zoom values.
• Toggle the **Iris Mode** to **Manual**.

• Use the **Iris** knob to have the iris on the camera open and close:
  - **Iris Open** — Turn the **Iris** knob to the **right** (clockwise).
  - **Iris Closed** — Turn the **Iris** knob to the **left** (counter-clockwise).

• Use the **Focus** knob to have the camera focus in or out:
  - **Focus Background** — Turn the **Focus** knob to the **right** (clockwise).
  - **Focus Foreground** — Turn the **Focus** knob to the **left** (counter-clockwise).

• Use the **Pedestal (Black)** knob to adjust the Master Pedestal, or Black levels, for picture contrast and quality.

8. Press and **hold Run Wiper** to activate the Lens Wiper on the camera connected to the Eagle Pan Tilt System.

9. Store the current shot as follows:

   **Important**
   
   You must have the Lens Mode toggled to **Position** before setting up and saving a shot when using a Fujinon/Canon lens. A message is displayed in the main area of the **Camera Head Control Menu** to toggle the Lens Mode from **Speed** to **Position** before attempting to save a prepared shot.

   Remember that when you toggle the Lens Mode between **Position** and **Speed**, the Eagle Pan Tilt System returns to its default position. Refer to your Eagle documentation for details on this function.

   • Press **Store Shot** to display the **Store Shot Menu**.

   ![Store Shot Menu](image)

   - **Camera Head Control — Store Shot Menu**
   
   • Use the **Shot** knob to select the location (1-31) you wish to store the current shot to.
   
   • Press **Perform Store** to store the shot in the selected location.

10. Recall a shot as follows:

   • Press **Recall Shot** to display the **Recall Shot Menu**.
Camera Head Control — Recall Shot Menu

- Use the **Shot** knob to select the shot location (1-31) you wish to recall.
- Press **Perform Recall** to recall the selected shot.

This completes the procedure to control an Eagle Pan Tilt System from your Synergy switcher.

**Panasonic Pan/Tilt Head**

Use the following procedure to control a Panasonic Pan/Tilt Head from your Synergy switcher:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME** ⇒ **Effects** ⇒ **MORE** ⇒ **Remote Control Select**.

   **Operating Tip**
   You can also press the crosspoint button that is assigned to the **Panasonic Pan/Tilt Head** you want to control to display the **Camera Head Control Menu** directly.

2. Press **Robotic Camera** to display the **Robotic Camera Menu**.

3. Use the **BNC** knob to select the BNC that the camera you want to control is connected to.

4. Press **GO!!** to display the **Camera Head Control Menu 1-2**.

5. Adjust the Pan, Tilt and Zoom of the camera as follows:
   - Press **Pan/Tilt/Zoom** to display the **Pan/Tilt/Zoom Menu**.

   **Operating Tip**
   You can also use the Positioner to adjust the pan, tilt and zoom values.
Cameras Head Control — Pan/Tilt/Zoom Menu

- Use the **Pan** knob to have the camera turn right or left:
  - **Pan Right** — Turn the **Pan** knob to the right (clockwise).
  - **Pan Left** — Turn the **Pan** knob to the left (counter-clockwise).

- Use the **Tilt** knob to have the camera tilt up or down:
  - **Tilt Up** — Turn the **Tilt** knob to the right (clockwise).
  - **Tilt Down** — Turn the **Tilt** knob to the left (counter-clockwise).

- Use the **Zoom** knob to have the camera zoom in or out:
  - **Zoom In** — Turn the **Zoom** knob to the right (clockwise).
  - **Zoom Out** — Turn the **Zoom** knob to the left (counter-clockwise).

6. Adjust the Iris or Focus of the camera as follows:
   - Press **Lens** to display the **Lens Menu**.

   Camera Head Control — Lens Menu

   - Toggle the **Iris Mode** to **Manual**.
   - Use the **Iris** knob to have the iris on the camera open and close:
     - **Iris Open** — Turn the **Iris** knob to the right (clockwise).
     - **Iris Closed** — Turn the **Iris** knob to the left (counter-clockwise).

   - Use the **Focus** knob to have the camera focus in or out:
     - **Focus Background** — Turn the **Focus** knob to the right (clockwise).
     - **Focus Foreground** — Turn the **Focus** knob to the left (counter-clockwise).

7. Press **Run Wiper** to activate the Lens Wiper on the camera connected to the Panasonic Pan/Tilt Head.
8. Store the current shot as follows:
   - Press **Store Shot** to display the **Store Shot Menu**.

   ![Camera Head Control — Store Shot Menu](image)

   - Use the **Shot** knob to select the location (0-49) you wish to store the current shot to.
   - Press **Perform Store** to store the shot in the selected location.

9. Recall a shot as follows:
   - Press **Recall Shot** to display the **Recall Shot Menu**.

   ![Camera Head Control — Recall Shot Menu](image)

   - Use the **Shot** knob to select the shot location (0-49) you wish to recall.
   - Press **Perform Recall** to recall the selected shot.

This completes the procedure to control a Panasonic Pan/Tilt Head from your Synergy switcher.

**Parkervision CameraMan 3e 3-CCD Robotic Camera**

![Note]

On startup, the Parkervision CameraMan is in Calibration Mode and may be unresponsive to the Synergy switcher for the first 15 seconds.

Use the following procedure to control a Parkervision CameraMan 3e 3-CCD camera from your Synergy switcher:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select**.

![Operating Tip]

You can also press the crosspoint button that is assigned to the Parkervision CameraMan 3e 3-CCD camera you want to control to display the **Camera Head Control Menu** directly.
2. Press **Robotic Camera** to display the **Robotic Camera Menu**.

   ![Remote Control Select — Robotic Camera Menu]

3. Use the **BNC** knob to select the BNC that the camera you want to control is connected to.

4. Press **GO!!** to display the **Camera Head Control Menu 1-2**.

5. Adjust the Pan, Tilt, and Zoom of the camera as follows:

   ![Camera Head Control — Pan/Tilt/Zoom Menu]

   - Press **Pan/Tilt/Zoom** to display the **Pan/Tilt/Zoom Menu**.

   - Use the **Pan** knob to have the camera turn right or left:
     - **Pan Right** — Turn the **Pan** knob to the **right** (clockwise).
     - **Pan Left** — Turn the **Pan** knob to the **left** (counter-clockwise).

   - Use the **Tilt** knob to have the camera look up or down:
     - **Tilt Up** — Turn the **Tilt** knob to the **right** (clockwise).
     - **Tilt Down** — Turn the **Tilt** knob to the **left** (counter-clockwise).

   - Use the **Zoom** knob to have the camera zoom in or out:
     - **Zoom In** — Turn the **Zoom** knob to the **right** (clockwise).
     - **Zoom Out** — Turn the **Zoom** knob to the **left** (counter-clockwise).

6. Adjust the Iris, Focus and Pedestal of the camera as follows:

   - Press **Lens** to display the **Lens Menu**.

   ![Operating Tip — You can use the Positioner to move the camera around]
Camera Head Control — Lens Menu

- Toggle the **Iris Mode** to **Manual**. If you select

> When **Iris Mode** is toggled from **Auto** to **Manual**, the Iris value is automatically set to *60.0%*.

- Use the **Iris** knob to have the iris on the camera open and close:
  
  ~ **Iris Open** — Turn the **Iris** knob to the right (clockwise).
  
  ~ **Iris Closed** — Turn the **Iris** knob to the left (counter-clockwise).

- Use the **Focus** knob to have the camera focus in or out:
  
  ~ **Focus Background** — Turn the **Focus** knob to the right (clockwise).
  
  ~ **Focus Foreground** — Turn the **Focus** knob to the left (counter-clockwise).

7. Store the current shot as follows:

- Press **Store Shot** to display the **Store Shot Menu**.

   - Use the **Shot** knob to select the location (1-125) you wish to store the current shot.
   
   - Press **Perform Store** to store the shot in the selected location.

8. Recall a saved shot as follows:

   - Press **Recall Shot** to display the **Recall Shot Menu**.
   
   - Use the **Shot** knob to select the location (1-125) you wish to recall a shot from.
   
   - Press **Perform Recall** to recall the shot from the selected location.

This completes the procedure for controlling a Parkervision CameraMan 3e 3-CCD camera from the Synergy switcher.
Shotoku TR-8S Control System

Use the following procedure to control a camera connected to the Shotoku TR-8S Control System from your Synergy switcher:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.

   [Operating Tip]
   You can also press the crosspoint button that is assigned to the Shotoku TR-8S you want to control to display the Camera Head Control Menu directly.

2. Press Robotic Camera to display the Robotic Camera Menu.

3. Use the BNC knob to select the BNC that the camera you want to control is connected to.

4. Press GO!! to display the Camera Head Control Menu 1-2.

5. Adjust the Pan, Tilt, and Zoom of the camera as follows:

   [Operating Tip]
   You can use the Positioner to move the camera around.

   - Press Pan/Tilt/Zoom to display the Pan/Tilt/Zoom Menu.

   [Operating Tip]
   Use the Pan knob to have the camera turn right or left:
   - Pan Right — Turn the Pan knob to the right (clockwise).
   - Pan Left — Turn the Pan knob to the left (counter-clockwise).

   - Use the Tilt knob to have the camera look up or down:
   - Tilt Up — Turn the Tilt knob to the right (clockwise).
   - Tilt Down — Turn the Tilt knob to the left (counter-clockwise).
• Use the **Zoom** knob to have the camera zoom in or out:
  ~ **Zoom In** — Turn the **Zoom** knob to the right (clockwise).
  ~ **Zoom Out** — Turn the **Zoom** knob to the left (counter-clockwise).

• Use the **Toggle x1/x4** button to select a camera speed:

6. Adjust the Iris and Focus of the camera as follows:

• Press **Lens** to display the **Lens Menu**.

<table>
<thead>
<tr>
<th>Camera Head Control (1-20)</th>
<th>Iris:</th>
<th>( $,B&lt;) ↔</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: BNC 20 (2B)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera: Shotoku (R4) – Camera 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pan/Tilt</td>
<td>Lens</td>
<td>Location</td>
</tr>
<tr>
<td>Zoon</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Camera Head Control — Lens Menu**

• Use the **Iris** knob to have the iris on the camera open and close:
  ~ **Iris Open** — Turn the **Iris** knob to the right (clockwise).
  ~ **Iris Closed** — Turn the **Iris** knob to the left (counter-clockwise).

• Use the **Focus** knob to have the camera focus in or out:
  ~ **Focus Background** — Turn the **Focus** knob to the right (clockwise).
  ~ **Focus Foreground** — Turn the **Focus** knob to the left (counter-clockwise).

7. Adjust the Trolly, Televator or Dolly of the camera as follows:

• Press **Location** to display the **Location Menu**.

<table>
<thead>
<tr>
<th>Camera Head Control (1-20)</th>
<th>Telelevator/Trolley:</th>
<th>( $,B&lt;) ↔</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC: BNC 20 (2B)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera: Shotoku (R4) – Camera 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pan/Tilt</td>
<td>Lens</td>
<td>Location</td>
</tr>
<tr>
<td>Zoon</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Camera Head Control — Location Menu**

• Use the **Televator/Trolley** knob to move the camera up or down on the Televator:
  ~ **Camera UP** — Turn the **Televator/Trolley** knob to the right (clockwise) to extend the Televator up.
  ~ **Camera Down** — Turn the **Televator/Trolley** knob to the left (counter-clockwise) to retract the televator down.

• Use the **Dolly** knob to have the camera move on the Camera Track.

You can use the Positioner to move the camera around quickly.
8. Store the current shot as follows:
   
   - Press **Store Shot** to display the **Store Shot Menu**.

   ![Store Shot Menu Table]

   - Use the **Shot** knob to select the location (1-600) you wish to store the current shot.
   - Press **Perform Store** to store the shot in the selected location. The softkey label automatically changes to **Cancel** until the shot is stored.
   - Press **Cancel** to stop the Synergy switcher from saving the selected shot.

9. Recall a saved shot as follows:
   
   - Press **Recall Shot** to display the **Recall Shot Menu**.

   ![Recall Shot Menu Table]

   - Use the **Shot** knob to select the location (1-600) you wish to recall a shot from.
   - Press **Perform Recall** to recall the shot from the selected location. The softkey label automatically changes to **Cancel** until the shot is recalled.
   - Press **Cancel** to stop the Synergy switcher from recalling the selected shot.

This completes the procedure for controlling a Shotoku TR-8S Control System from the Synergy switcher.
AMX AXB-PT PosiTrack Camera Controller

Use the following procedure to control an **AMX AXB-PT PosiTrack Camera Controller** from your Synergy Switcher:

1. Navigate to the **Remote Control Select Menu** as follows:
   
   - Press **HOME** (to display the **Main Menu 1-2**).
   - **Effects** (to display the **Effects Menu 1-2**).
   - **MORE** (to display the **Effects Menu 2-2**).
   - **Remote Control Select** (to display the **Remote Control Select Menu**).

2. Press **Robotic Camera** to display the **Robotic Camera Menu**.

3. Use the **BNC** knob to select the BNC that the camera you want to control is connected to.

4. Press **GO!!** to display the **Camera Head Control Menu 1-2**.

5. If you are using a Fujinon/Canon lens with your AMX AXB-PT PosiTrack Camera Controller, you can toggle the **Lens Mode** as follows:
   
   - Press **MORE** to display the **Camera Head Control Menu 2-2**.
   - Toggle the **Lens Mode** to set the type of lens control as follows:
     
     ~ **Speed** — Use this option to enable the Speed Mode for adjusting the lens. A message is displayed in the main area of the **Camera Head Control Menu** to toggle the Lens Mode to **Position** before attempting to save a prepared shot. This is the default setting.

     ~ **Position** — Use this option to enable the Position Mode for adjusting the lens. You must select this option before setting up and saving a shot.

   - Press **MORE** to display the **Camera Head Control Menu 1-2**.

---

**Operating Tip**

You can also press the crosspoint button that is assigned to the AMX AXB-PT PosiTrack Camera Controller you want to control to display the **Camera Head Control Menu** directly.

**Important**

When you toggle the Lens Mode from **Speed** to **Position**, the AMX AXB-PT PosiTrack Camera Controller returns to its default position. Refer to your AMX documentation for details on this function.

---
6. Press **Pan/Tilt/Zoom** to display the **Pan/Tilt/Zoom Menu**.

7. Toggle the **Tilt Curve** to select the tilt direction of the camera as follows:
   - **Normal** — Use this option to adjust the Pan/Tilt direction when your camera is in the normal mounting position. This is the default setting.
   - **Invert** — Use this option to adjust the Pan/Tilt direction when your camera is in the inverted mounting position.

8. Adjust the Pan of the camera as follows:
   - If you selected **Normal**, adjust the Pan as follows:
     - **Pan Right** — Turn the **Pan** knob to the **left** (counter-clockwise).
     - **Pan Left** — Turn the **Pan** knob to the **right** (clockwise).
   - If you selected **Invert**, adjust the Pan as follows:
     - **Pan Right** — Turn the **Pan** knob to the **right** (clockwise).
     - **Pan Left** — Turn the **Pan** knob to the **left** (counter-clockwise).

9. Adjust the Tilt of the camera as follows:
   - If you selected **Normal**, adjust the Tilt Curve of the camera as follows:
     - **Tilt Up** — Move the **Positioner** down to tilt the camera controller up.
     - **Tilt Down** — Move the **Positioner** up to tilt the camera controller down.
   - If you selected **Invert**, adjust the Tilt Curve of the camera as follows:
     - **Tilt Up** — Move the **Positioner** up to tilt the camera controller up.
     - **Tilt Down** — Move the **Positioner** down to tilt the camera controller down.

10. Adjust the Zoom of the camera as follows:
    - Use the bottom **Zoom** knob to have the camera zoom in or out:
      - **Zoom In** — Turn the **Zoom** knob to the **right** (clockwise).
      - **Zoom Out** — Turn the **Zoom** knob to the **left** (counter-clockwise).

    **Operating Tip**
    You can also use the **Positioner**, instead of the knobs, to adjust the pan, tilt and zoom values.
11. Press **Lens** to display the **Lens Menu**.

```
<table>
<thead>
<tr>
<th>Pan/Tilt</th>
<th>Lens</th>
<th>Store</th>
<th>Recall</th>
<th>Iris Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Local</td>
</tr>
</tbody>
</table>
```

**Camera Head Control — Lens Menu**

12. Adjust the Iris and Focus of the camera as follows:
   - Toggle the **Iris Mode** to **Local**.
   - Use the **Iris** knob to have the iris on the camera open and close:
     - **Iris Open** — Turn the **Iris** knob to the **right** (clockwise).
     - **Iris Closed** — Turn the **Iris** knob to the **left** (counter-clockwise).
   - Use the **Focus** knob to have the camera focus in or out:
     - **Focus Background** — Turn the **Focus** knob to the **right** (clockwise).
     - **Focus Foreground** — Turn the **Focus** knob to the **left** (counter-clockwise).

13. Store the current shot as follows:

   **Important**

   You must have the Lens Mode toggled to **Position** before setting up and saving a shot when using a Fujinon/Canon lens.

   Remember that when you toggle the Lens Mode between **Position** and **Speed**, the AMX AXB-PT PosiTrack Camera Controller returns to its default position. Refer to your AMX documentation for details on this function.

   - Press **Store Shot** to display the **Store Shot Menu**.

```
<table>
<thead>
<tr>
<th>Pan/Tilt</th>
<th>Lens</th>
<th>Store</th>
<th>Recall</th>
<th>Shot</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Camera Head Control — Store Shot Menu**

- Use the **Shot** knob to select the location (**1-255**) you wish to store the current shot to.
- Press **Perform Store** to store the shot in the selected location.
14. Recall a shot as follows:

- Press **Recall Shot** to display the **Recall Shot Menu**.

- Use the **Shot** knob to select the shot location (1-255) you wish to recall.

- Press **Perform Recall** to recall the selected shot.

This completes the procedure to control an AMX AXB-PT PosiTrack Camera Controller from your Synergy switcher.
Character Generator Interface

Synergy Series switchers interface with character generators. With the Character Generator software option installed, you can load and run effects, load and navigate through a playlist or a Character Generator (CG) template, and edit CG text directly from the Synergy control panel and keyboard.

The following configurations must be completed before the Synergy switcher can be set up to control the Character Generator:

- Ensure that Character Generator BNCs are configured appropriately. Refer to the sections, “Setting up BNC Types” and “Setting Up Character Generator BNCs” in Chapter 15 of the Synergy Series Installation Guide for configuration instructions.
- Ensure that BNCs are associated to the Alpha. Refer to the sections, “Setting up Alphas” and “Setting Up Auto Keys” in Chapter 15 of the Synergy Series Installation Guide for configuration instructions.
- Ensure that the remote ports are configured appropriately. Refer to the section, “Communications Setup” in Chapter 15 of the Synergy Series Installation Guide for configuration instructions.

Leitch (Inscriber) Inca CG

This section provides information on operating your Leitch (Inscriber) Inca CG. The following topics are discussed:

- Selecting a Mode
- Using Sequence Mode
- Using Manual Mode
- Modifying Text
- Modifying an Effect
- Selecting Channels

Selecting a Mode

The Leitch (Inscriber) Inca CG can be operated in either Sequence Mode or Manual Mode:

- **Sequence Mode** – This mode is used to select a sequence file (INS).
- **Manual Mode** – This mode is used to modify individual pages on an as-required basis (ICG).

Selecting a Mode

Use the following procedure to select a mode:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.

Operating Tip

Refer to your specific Character Generator documentation for additional configuration details.
3. Use the **BNC** knob to select the BNC for your device.

4. Press **GO!!** to display the **Character Generator Control Menu 1-2**.

   ▶️ **Operating Tip**

   You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu 1-2**.

5. Press **MORE** to display the **Character Generator Control Menu 2-2**.

6. Toggle **Mode Seq./Man.** between **Seq.** and **Man.** as follows:
   - **Seq.** — Use this option to set the Inscriber CG to Sequence Mode.
   - **Man.** — Use this option to set the Inscriber CG to Manual Mode.

   ▶️ **Note**

   The current **Mode, Channel** and **Folder/FileName** information is saved in non-volatile memory on the switcher and is stored and recalled with the **Personality Settings**. This allows you to retain your CG settings if the switcher powers down.

This concludes the procedure to select a mode.

### Using Sequence Mode

This section includes instructions when the Inscriber CG is set to **Sequence Mode** in the Synergy menu system.

The following topics are discussed:

- Selecting a File.
- Loading a Page
- Recalling an Event
- Running an Event

### Selecting a File.

**Important**

A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

Use the following procedure to select a file while in Sequence Mode:

1. Ensure the Inscriber CG is set to **Sequence Mode** in the Synergy menu system. Refer to the section “**Selecting a Mode**” on page 10–33 for details.

2. Press **Select File** to select the sequence file.
3. Use the keyboard to enter the address of the required sequence file.

**Important**
Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

This completes the procedure to select a file while in Sequence Mode.

**Loading a Page**

Use the following procedure to load an event to the current program preview:

1. Ensure the Inscriber CG is set to **Sequence Mode** in the Synergy switcher menu system. Refer to the section “**Selecting a Mode**” on page 10–33 for details.

2. Toggle the **View Lst/Crnt** button to **Lst**. A list of the available events is displayed on the Character Generator Control Menu.

3. Use the middle knob to select an event from the current file.

4. Load the selected event to a Character Generator channel as follows:

   - Press **List To PV** to load the currently selected page to the Character Generator Preview channel.

**OR**

   - Press **List to PGM** to load the currently selected page to the Character Generator Program channel.

This concludes the procedure to display a list of all events on the Character Generator Program or Preview channel.
Recalling an Event

Use the following procedure to recall the page selected in the preview or program channel as an event:

1. Ensure the Inscriber CG is set to **Sequence Mode** in the Synergy switcher menu system. Refer to the section “Selecting a Mode” on page 10–33 for details.

2. Press **MORE** to display the Character Generator Control Menu 1-2.

3. Recall a selected event to the Preview channel of the Character Generator as follows:
   - Press **Recall CG to PV**.
   - Select an event using the Synergy Global Memory System to recall it to the Preview channel of the Character Generator. The selected files tag information will be displayed in the **PV** column.

4. Recall a selected event to the Program channel of the Character Generator as follows:
   - Press **Recall CG to PGM**.
   - Select an event using the Synergy Global Memory System to recall it to the Program channel of the CG. The selected files tag information will be displayed in the **PGM** column. This page is now available for keying.

This concludes the procedure to recall the page selected in the Preview or Program channel as an event.

Running an Event

Use the following procedure to make the next event available for keying to air:

1. Ensure an event is loaded to the Preview column. Refer to the section “Recalling an Event” on page 10–36 for more information.

2. Press **Run Effect** to advance the Character Generator page displayed in the Preview (PV) column to the Program (PGM) column. This action will automatically display the next page of the list in the Preview column.

Using Manual Mode

This section includes instructions when the Inscriber CG is set to **Manual Mode** in the Synergy menu system.

The following topics are discussed:

- Selecting a Folder
- Recalling a Page
- Running an Effect
Selecting a Folder

All pages that are recalled in manual mode will be searched for in the defined folder.

Use the following procedure to select a folder in Manual mode:

1. Ensure the Inscriber CG is set to Manual Mode in the Synergy switcher menu system. Refer to the section “Selecting a Mode” on page 10–33 for details.

2. Press MORE to display the Character Generator Control Menu 2-2.

3. Select a folder as follows:
   - Press Select Folder.
   - Use a standard PS/2 keyboard connected to the Synergy switcher to enter the address of the required folder.

Important

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

This completes the procedure to select a folder in Manual mode.

Recalling a Page

Use the following procedure to recall a page in Manual mode:

1. Ensure the Inscriber CG is set to Manual Mode in the Synergy switcher menu system. Refer to the section “Selecting a Mode” on page 10–33 for details.

2. Press MORE, with the folder loaded to the Character Generator to return to the Character Generator Menu 1-2.
3. Recall a page to the Preview channel of the Inscriber CG as follows:
   - Press **Recall CG to PV**.
   - Select a file using the Synergy **Global Memory System** to recall it to the Preview channel of the Character Generator.

   **Important**
   Files stored with non numerical names cannot be recalled using this method. Refer to the section “**Setting up the Character Generator**” of the **Synergy Series Installation Guide** for configuration instructions.

   The tag information for the file is now displayed in the **PV** column of the Character Generator Menu 1-2.

4. Recall a page to the Program channel of the Inscriber CG as follows:
   - Press **Recall CG to PGM**
   - Select a file using the Synergy **Global Memory System** to recall an event directly to the PGM bus. This event will be taken to air immediately.

   The tag information for the file is now displayed in the **PGM** column of the Character Generator Menu 1-2.

This concludes the procedure to recall a page to the Preview or Program channel of the Inscriber CG.

**Running an Effect**

Use the following procedure to move the effect and its tag information in the Preview (PV) column, to the Program (PGM) column:

1. Ensure the Inscriber CG is set to **Manual Mode** in the Synergy switcher menu system. Refer to the section “**Selecting a Mode**” on page 10–33 for details.

2. Ensure a file is loaded to the Preview column of the Character Generator Menu. Refer to the section “**Selecting a File**” on page 10–34 for details.

3. Press **Run Effect** to advance the current preview file displayed in the preview (PV) column to the program (PGM) column. This action will automatically display the next file in the Preview column.

This concludes the procedure to move the effect in the Preview (PV) column to the Program (PGM) column.
Modifying Text

The text displayed in the Preview (PV) column or Program (PGM) column of the Synergy Character Generator Menu can be modified.

Important

Character Generator parameters that are modified from the Synergy switcher are only in effect for the current session.

The following topics are discussed:

• Modifying PGM Text
• Modifying PV Text

Important

A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

Modifying PGM Text

Use the following procedure to modify the Program (PGM) text:

1. Load a page to the PGM Channel of the Inscriber CG. Refer to the section “Loading a Page” on page 10–35 or the section “Recalling a Page” on page 10–37 for instructions on loading a page.

2. Press Change PGM Text to display the CharGen – Change PGM Text Menu.

3. Change the tag information for the event on air by pressing the applicable softkey and editing the text using the keyboard. The menu softkeys are renamed to coincide with the tag names.

Important

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

4. Press UP ONE to return to the Character Generator Menu 1-2.

This concludes the procedure to change the text of a loaded page in the Program (PGM) Channel of the Inscriber CG.

Modifying PV Text

Use the following procedure to modify the Preview (PV) text:

1. Load a page to the PV Channel of the Inscriber CG. Refer to the section “Loading a Page” on page 10–35 or the section “Recalling a Page” on page 10–37 for instructions on loading a page.
2. Press **Change PV Text** to display the **CharGen – Change PV Text Menu**.

   ![CharGen - Change PV Text Menu](image)

3. Modify the tag information for the event on the **PV** bus by pressing the applicable softkey and editing the text using a standard PS/2 keyboard connected to the Synergy switcher. The menu softkeys are renamed to coincide with the tag names.

   **Important**  
   Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

4. Press **UP ONE** to return to the **Character Generator Menu 1-2**.

   **Note**  
   You will not be able to see animations or special effects, and only the first frame of an active texture will be displayed.

This concludes the procedure to change the Preview (**PV**) text of a loaded page on the Inscriber CG.

**Modifying an Effect**

**Important**  
Character Generator parameters that are modified from the Synergy switcher are only in effect for the current session.

The following effects can be modified and applied to the Preview video output of the Character Generator when it is transitioned to the Program output (**PGM**):

- Effect
- Pattern
- Speed
- Ease
- Reverse
- Row Direction.

**Note**  
You will not be able to see animations or special effects, and only the first frame of an active texture will be displayed.

Use the following procedure to modify an effect:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select**.
2. Press **Character Generator** to display the **Character Generator Remote Control Menu**.

3. Use the **BNC** knob to select the BNC for your device.

4. Press **GO!!** to display the **Character Generator Menu 1-2**.

---

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu 1-2**.

---

5. Press **Select Effect** to display the **Character Generator — Select Effect Menu**.

6. Select an effect to modify as follows:
   - Press **Effect** to display the **Effect Menu**.

   - Use the **Effect** knob to select an effect type. You can choose between the following:
     ~ Wipe
     ~ Push
     ~ Hide
     ~ Reveal
     ~ Dissolve
     ~ Cut

7. Select the pattern of an effect as follows:
   - Press **Effect** to display the **Effect Menu**.
   - Use the **Effect** knob to select an effect type.
   - Press **Pattern** to display the **Pattern Menu**.
Use the **Pattern** knob to select a pattern. You can select from the following:

- Horizontal Slide Wipe
- Vertical Slide Wipe
- Horizontal Split Wipe
- Vertical Split Wipe
- Box Wipe
- Row Slide/Wipe
- Row by Row Scanline
- Screen Scanline Wipe
- Pixel Wipe

8. Modify the number of frames it takes for the effect to end as follows:

   - Press **Effect** to display the **Effect Menu**.
   - Use the **Effect** knob to select an effect type.
   - Press **Speed** to display the **Speed Menu**.

   Use the **Speed** knob to select the speed, in frames, for the transition to occur. You can choose a speed between 0 and 150 frames.

9. Modify the result of Ease on the effect: as follows:

   - Press **Effect** to display the **Effect Menu**.
   - Use the **Effect** knob to select an effect type.
   - Press **Ease** to display the **Ease Menu**.
Current Effect:
Effect:...Hide
Pattern:...Vertical Slide Wipe
Speed:...15 frames
Ease:...Ease In
Reverse:...On
Row Direction...Up

Use the **Ease** knob to select an Ease effect. You can choose between the following:
- No Ease
- Ease In
- Ease Out
- Ease In&Out

10. Reverse the direction of the effect as follows:
- Press **Effect** to display the **Effect Menu**.
- Use the **Effect** knob to select an effect type.
- Toggle the **Reverse** button between **On** and **Off** as follows:
  - **On** — Select **On** to perform the effect in reverse.
  - **Off** — Select **Off** to perform the effect in the normal forward direction.

11. Define the direction of the row as follows:
- Press **Effect** to display the **Effect Menu**.
- Use the **Effect** knob to select an effect type.
- Press **Row Direction** to display the **Row Direction Menu**.

Use the **Row Direction** knob to select the direction that you would like the rows of text to be transitioned off the screen.

This concludes the procedure to modify an effect.
Selecting Channels

Use the following procedure to select the channel to setup:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu 1-2.

5. Press MORE to display the Character Generator Control Menu 2-2.

6. Toggle the Channel A/B button between Channel A and B to select the channel output on the Inscriber CG.
   - Channel A — This option sets the output on the Inscriber CG to Channel A.
   - Channel B — This option sets the output on the Inscriber CG to Channel B.

This concludes the procedure to select the channel to setup.

Chyron Character Generators

This section outlines the operation of the Chyron Duet LEX and HyperX character generators. The following topics are discussed:

- Selecting a Folder
- Recalling a Template
- Changing the Text
- Swapping Preview and Program
- Playing Animation

Selecting a Folder

Use the following procedure to select a folder from the Chyron character generator:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press **Character Generator** to display the **Character Generator Remote Control Menu**.

3. Use the **BNC** knob to select the BNC for your device.

4. Press **GO!!** to display the **Character Generator Menu 1-2**.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu 1-2**.

5. Press **MORE** to display the **Character Generator Control Menu 2-2**.

6. Select a new folder as follows:
   - Press **Select Folder**.
   - Use a standard PS/2 keyboard connected to the Synergy switcher to enter the address of the required folder.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

This concludes the procedure to recall a folder from a Chyron Duet LEX or a HyperX character generator.

**Recalling a Template**

To recall a template to the **Preview (PV)** or **Program (PGM)** output of the Chyron Duet LEX or a HyperX, you must first select the folder and then enter the template name.

**Note**

This procedure recalls the selected template to the Preview or Program of the Chyron character generator only and NOT to the Preview or Program Monitor of the Synergy switcher.

Use the following procedure to recall a template to the Character Generator Preview:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select**.
2. Press **Character Generator** to display the **Character Generator Remote Control Menu**.
3. Use the **BNC** knob to select the BNC for your device.
4. Press **GO!!** to display the **Character Generator Menu 1-2**.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu 1-2**.

5. Select a folder as follows:
   - Press **MORE** to display the **Character Generator Control Menu 2-2**.
   - Press **Select Folder**.
   - Use a standard PS/2 keyboard connected to the Synergy switcher to enter the address of the required folder.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

6. Recall a template to the **PV** of the Chyron character generator as follows:
   - Press **MORE** to return to the **Character Generator Menu 1-2**.

   - **Char Gen: BNC 3 (1-2)**
     - PU: 0:000 1: text 2: 900 3: first I
     - PGM: NONE
     - Folder: I:\#AB 2004 LEX\Messages

   **Character Generator — Recall CG to PV Menu**

   - Press **Recall CG to PV**.
   - Select a template using the Synergy **Global Memory System Group** to recall it to the Preview of the Chyron character generator. The field information is now displayed in the PV column of the **Character Generator Menu 1-2**.

**Important**

Files stored with non numerical names cannot be recalled using this method. Refer to Chapter 15, “**Character Generators**” in the **Synergy Series Installation Guide** for configuration instructions.

7. Select a template to recall to the **PGM** of the Chyron character generator as follows:
   - Press **MORE** to return to the **Character Generator Menu 1-2**.
   - Press **Recall CG to PGM**.
   - Select a template using the Synergy **Global Memory System Group**. The field information is now displayed in the PGM column of the **Character Generator Menu 1-2**.

**Important**

Templates stored with non numerical names cannot be recalled using this method. Refer to Chapter 15, “**Character Generators**” in the **Synergy Series Installation Guide** for configuration instructions.
This concludes the procedure to recall a template to the Preview of the Chyron Duet LEX or HyperX character generator.

**Modifying the Text**

You can modify text for loaded templates using the Synergy switcher menu system. The text displayed in either the Preview (PV) column or Program (PGM) column can be modified using a standard PS/2 keyboard connected to the Synergy switcher.

**Important**

Character Generator parameters that are modified from the Synergy switcher are only in effect for the current session.

Use the following procedure to change the Preview (PV) or Program (PGM) text for a loaded template on the Chyron character generator:

1. **Navigate to the Remote Control Select Menu** as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press **Character Generator** to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press **GO!!** to display the Character Generator Menu 1-2.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.
5. Change the text for the template on the Preview (PV) of the Chyron character generator as follows:

- Select a folder as follows:
  ~ Press MORE to display the Character Generator Menu 2-2.
  ~ Press Select Folder.
  ~ Use a standard PS/2 keyboard connected to the Synergy switcher to enter the address of the required folder.

  **Important**
  Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

- Recall a template to the PV column as follows:
  ~ Press MORE to return to the Character Generator Menu 1-2.
  ~ Press Recall CG to PV.
  ~ Select a template using the keypad in the Synergy Global Memory System Group to recall it to the Preview (PV) of the Chyron character generator.

  **Important**
  Templates stored with non numerical names cannot be recalled using this method. Refer to Chapter 15, “Character Generators” in the Synergy Series Installation Guide for configuration instructions.

- Press Change PV Text to display the Change PV Text Menu.

  ![Character Generator Menu — Change PV Text]

- Change the text for the fields on the Preview of the Chyron character generator by pressing the applicable softkeys and editing the text using a standard PS/2 keyboard. The menu softkeys are renamed to coincide with the field names.

6. Change the text for the template on the Program (PGM) of the Chyron character generator as follows:

- Select a folder as follows:
  ~ Press MORE to display the Character Generator Menu 2-2.
  ~ Press Select Folder.
  ~ Use a standard PS/2 keyboard connected to the Synergy switcher to enter the address of the required folder.

- Select a template as follows:
  ~ Press MORE to return to the Character Generator Menu 1-2.
  ~ Press Recall CG to PGM.
~ Select a template using the keypad in the Synergy Global Memory System Group to recall it to the Program (PGM) of the Chyron character generator. The text should now be displayed in the PGM column of the Character Generator Menu 1-2.

**Important**

Templates stored with non numerical names cannot be recalled using this method. Refer to Chapter 15, “Character Generators” in the Synergy Series Installation Guide for configuration instructions.

- Press **Change PGM Text** to display the Change PGM Text Menu.

<table>
<thead>
<tr>
<th>Char Gen — Change PGM Text:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty 1: Have fun</td>
</tr>
<tr>
<td>Empty 2: CHY 2005</td>
</tr>
</tbody>
</table>

**Character Generator Menu — Change PGM Text**

- Change the text for the event on air by pressing the applicable softkeys and editing the text using a standard PS/2 keyboard. The menu softkeys are renamed to coincide with the tag names.

This concludes the procedure to change the Program (PGM) text for the Chyron character generator.

**Swapping Preview and Program**

Use the following procedure to exchange what is loaded on the Chyron character generator Preview (PV) with the file loaded on the Program (PGM):

**Important**

A standard PS/2 keyboard is required to input data. Contact Ross Video Technical Support for relevant information.

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press **Character Generator** to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press **GO!!** to display the Character Generator Menu 1-2.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu 1-2.
5. Recall a template to the PV column as follows:
   - Press **MORE** to display the **Character Generator Control Menu 2-2**.
   - Press **Select Folder**.
   - Use a standard PS/2 keyboard connected to the Synergy switcher to enter the address of the required folder.

   **Important**
   Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

   - Press **MORE** to return to the **Character Generator Menu 1-2**.
   - Press **Recall CG to PV**.

6. Recall a template to the PGM column as follows:
   - Press **MORE** to display the **Character Generator Control Menu 2-2**.
   - Press **Select Folder**.
   - Use a standard PS/2 keyboard connected to the Synergy switcher to enter the address of the required folder.
   - Press **MORE** to return to the **Character Generator Menu 1-2**.
   - Press **Recall CG to PGM**.

7. Toggle the **Swap PV/PGM** button to swap the templates for the PV and PGM.

This concludes the procedure to exchange a loaded template on the Preview (PV) of the Chyron character generator with the loaded template on the Program (PGM).

**Playing Animation**

Use the following procedure to play an animation template:

**Important**
No other commands will be processed by the Chyron character generator from the Synergy switcher until the animation is finished playing.

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select**.
2. Press **Character Generator** to display the **Character Generator Remote Control Menu**.
3. Use the **BNC** knob to select the BNC for your device.
4. Press **GO!!** to display the **Character Generator Menu 1-2**.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu 1-2**.

5. Select a folder from the character generator as follows:
   - Press **MORE** to display the **Character Generator Control Menu 2-2**.
   - Press **Select Folder**.
   - Use a standard PS/2 keyboard connected to the Synergy switcher to enter the address of the required folder.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

6. Select an animation template as follows:
   - Press **MORE** to return to the **Character Generator Menu 1-2**.
   - Press **Recall CG to PGM**.
   - Select a template using the keypad in the Synergy **Global Memory System Group** to recall it to the Program of the Chyron character generator.

**Important**

Files stored with non numerical names cannot be recalled using this method. Refer to Chapter 15, **“Character Generators”** in the **Synergy Series Installation Guide** for configuration instructions.

The template information is displayed in the PGM column of the **Character Generator Menu 1-2**.

7. Press **Play Animation** to enable the Synergy switcher to play the selected template.

This concludes the procedure to play an animation file from the Chyron character generator.
Pinnacle FXDeko II

This section outlines the operation of the Pinnacle FXDeko II character generator. The following topics are discussed:

- Recalling a Template to Preview
- Recalling a Template to Program
- Selecting Effects
- Changing Text
- Swapping Preview and Program

Recalling a Template to Preview

To recall a template to the Preview (PV) output of the Pinnacle FXDeko II, you must first select the folder and then enter the template name.

Note

This procedure recalls the selected template to the Preview (PV) of the Pinnacle FXDeko II only and NOT to the Preview Monitor of the Synergy switcher.

Use the following procedure to recall a template to the Character Generator Preview:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.

Remote Control Select Menu

3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu.

Operating Tip

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu.
5. Press **Recall CG to PV**.

6. Select a template using the keypad in the **Global Memory System Group** to recall it to the Preview of the Pinnacle FXDeko II.

   **Important**

   Files stored with non-numerical names cannot be recalled using this method. Refer to Chapter 15, “**Character Generators**” in the **Synergy Series Installation Guide** for configuration instructions.

   The template information is displayed in the **PV** column of the **Character Generator Menu**.

This concludes the procedure to recall a template to the Preview of the Pinnacle FXDeko II.

### Recalling a Template to Program

To recall a template to the Program (PGM) of the Pinnacle FXDeko II, you must first select the folder and then enter the template name using the Synergy **Character Generator Menu**.

   **Important**

   This procedure will recall the selected template to the Program of the Synergy switcher if the BNC assigned to the Pinnacle FXDeko II is currently on air.

   Use the following procedure to recall a template to the Program (PGM) of the Pinnacle FXDeko II:

1. Navigate to the **Remote Control Select Menu** as follows:
   - Press **HOME** ⇒ **Effects** ⇒ **MORE** ⇒ **Remote Control Select**.
2. Press **Character Generator** to display the **Character Generator Remote Control Menu**.
3. Use the **BNC** knob to select the BNC for your device.
4. Press **GO!!** to display the **Character Generator Menu**.

   **Operating Tip**

   You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu**.
5. Press **Recall CG to PGM**.

6. Select a template using the keypad in the Synergy **Global Memory System**.

   **Important**
   
   Templates stored with non numerical names cannot be recalled using this method. Refer to Chapter 15, “**Character Generators**” in the **Synergy Series Installation Guide** for configuration instructions.

   The template information is displayed in the **PGM** column of the **Character Generator Menu**.

7. Press **ENTER** on the keypad.

   **Character Generator Menu — Recall CG to PGM**

This concludes the procedure to recall a template to the Program of the Pinnacle FXDeko II.

**Modifying an Effect**

**Important**

Character Generator parameters that are modified from the Synergy switcher are only in effect for the current session.

The following effects can be modified and applied to the Preview video output of the Character Generator when it is transitioned to the Program output (**PGM**):

- Effect
- Pattern
- Duration
- Reverse

**Note**

You will not be able to see animations or special effects, and only the first frame of an active texture will be displayed.
Use the following procedure to select and modify an effect for the Pinnacle FXDeko II:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu.

**Operating Tip**
You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu.

5. Recall the clip to the PV column of the Character Generator Menu that you wish to select the effect for as follows:
   - Press Recall CG to PV
   - Select a template using the keypad in the Synergy Global Memory System Group. The template information is displayed in the PV column of the Character Generator Menu.
   - Press ENTER on the keypad.
6. Select an effect to modify as follows:
   - Press Select Effect to display the Character Generator – Select Effect Menu.
   - Press Effect to display the Effect Menu.

   **Char Gen: BNC 2B Channel 1 Deko (RL)**
   - **PU:** NONE
   - **PCN:** NONE
   - No Field Info
   - No Field Info
   - **Recall CG to PV**
   - **Recall CG to PCN**
   - Character PO
   - Character PO
   - Select
   - Select
   - Effect
   - Effect
   - PV <→ PCN

**Character Generator Menu**

   **Current Effect:**
   - Effect: Effects
   - Pattern: Patterns
   - Duration: 30 frames
   - Ease: No Ease
   - Reverse: Off
   - Row Direction: Down

**Char Gen - Select Effect — Effect Menu**

   - Use the Effect knob to select an effect type.
7. Select the pattern for an effect as follows:
   • Press Pattern to display the Pattern Menu.

   ![Pattern Menu]

   Char Gen - Select Effect — Pattern Menu

   • Use the Pattern knob to select a pattern.

8. Modify the number of frames it takes for the effect to end as follows:
   • Select an effect to modify as follows:
     ~ Press Effect to display the Effect Menu.
     ~ Use the Effect knob to select an effect type.
   • Press Duration to display the Duration Menu.

   ![Duration Menu]

   Char Gen - Select Effect — Duration Menu

   • Use the Duration knob to select the speed, in frames, for the transition to occur. You can choose a speed between 0 and 150 frames.

9. Reverse the direction of an effect as follows:
   • Select an effect to modify as follows:
     ~ Press Effect to display the Effect Menu.
     ~ Use the Effect knob to select an effect type.
   • Toggle the Reverse button between On and Off as follows:
     ~ On — Select On to perform the effect in reverse.
     ~ Off — Select Off to perform the effect in the normal forward direction.

10. Change the row direction of an effect as follows:
    • Select an effect to modify as follows:
      ~ Press Effect to display the Effect Menu.
      ~ Use the Effect knob to select an effect type.
    • Press the Row Direction button to display the Row Direction Menu.
Use the Direction knob to select a direction.

This concludes the procedure to select and modify an effect for the Pinnacle FXDeko II.

**Changing the Text**

Use the following procedure to change the text tags for the Pinnacle FXDeko II:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu.

5. Change the text for the template on the Preview of the Pinnacle FXDeko II as follows:
   - Recall a template to the PV column as follows:
     - Press Recall CG to PV.
     - Select a template using the keypad in the Synergy Global Memory System Group. The template information is displayed in the PV column of the Character Generator Menu.
     - Press ENTER on the keypad.
• Change the text for the template by pressing the applicable softkeys and editing the text using a standard PS/2 keyboard. The menu softkeys are renamed to coincide with the tag names.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Synergy switcher acting unpredictably.

6. Change the text for the template on the **Program (PGM)** of the Pinnacle FXDeko II as follows:

• Recall a template to the **PGM** column as follows:
  ~ Press **Recall CG to PGM**.
  ~ Select a template using the keypad in the Synergy **Global Memory System Group**. The template information is displayed in the **PGM** column of the **Character Generator Menu**.
  ~ Press **ENTER** on the keypad.

• Change the text for the template by pressing the applicable softkeys and editing the text using a standard PS/2 keyboard. The menu softkeys are renamed to coincide with the tag names.

This completes the procedure to change the text tags for the Pinnacle FXDeko II character generator.

**Swapping Preview and Program**

Use the following procedure to exchange what is loaded on the Pinnacle FXDeko II Preview (PV) with the file loaded on the Program (PGM):

1. Navigate to the **Remote Control Select Menu** as follows:
   • Press **HOME** ⇒ **Effects** ⇒ **MORE** ⇒ **Remote Control Select**.
2. Press **Character Generator** to display the **Character Generator Remote Control Menu**.
3. Use the **BNC** knob to select the BNC for your device.
4. Press **GO!!** to display the **Character Generator Menu**.

**Operating Tip**

You can also press the Character Generator crosspoint on the MLE to display the **Character Generator Menu**.
5. Recall a template to the PV column as follows:
   • Press Recall CG to PV.
   • Select a template using the keypad in the Synergy Global Memory System Group. The template information is displayed in the PV column of the Character Generator Menu.
   • Press ENTER on the keypad.

6. Recall a template to the PGM column as follows:
   • Press Recall CG to PGM.
   • Select a template using the keypad in the Synergy Global Memory System Group. The template information is displayed in the PGM column of the Character Generator Menu.
   • Press ENTER on the keypad.

7. Toggle the Swap PV/PGM button to swap the templates for the PV and PGM.

This concludes the procedure to exchange a loaded template on the Preview (PV) of the Pinnacle FXDeko II with the loaded template on the Program (PGM).

Vizrt Viz|Trio Character Generator

This section outlines the operation of the Vizrt Viz|Trio character generator. The following topics are discussed:

• Recalling a File to Preview
• Sending a File from Preview to Program

Recalling a File to Preview

Note

This procedure recalls the selected file to the Preview (PV) of the Viz|Trio Client system only and NOT to the Preview Monitor of the Synergy switcher.

To recall a file to the Preview (PV) Window of the Viz|Trio Client system, you must first select Preview as the destination and then enter the file number. The folder that the Synergy switcher defaults to is set on the Viz|Trio Client system during setup. Refer to the section “Setting Up the Character Generator” in the Synergy Series Installation Guide for instructions.

Use the following procedure to recall a file to the Preview Window of the Viz|Trio Client system:

1. Navigate to the Remote Control Select Menu as follows:
   • Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Character Generator to display the Character Generator Remote Control Menu.
3. Use the BNC knob to select the BNC for your device.
4. Press GO!! to display the Character Generator Menu.

Operating Tip

You can also press the Character Generator crosspoint on the MLE to display the Character Generator Menu.
5. Press **Recall CG to PV**.

6. Select a template using the keypad in the **Global Memory System Group** to recall it to the Preview of the Vizrt Viz|Trio.

**Important**

Files stored with non-numerical names cannot be recalled using this method.

The file information is now displayed in the **PV** column of the **Character Generator Menu** and the Preview Window of the Viz|Trio Client system.

This concludes the procedure to recall a template to the Preview Window of the Viz|Trio Client system.

**Sending a File from Preview to Program**

Use the following procedure to send a file from the Preview Window of the Viz|Trio Client system to the Program of the Synergy switcher:

1. Recall a template to the Preview Window of the Viz|Trio Client system as outlined in the section “**Recalling a File to Preview**” on page 10–59.

2. Toggle the **Take PV/PGM** button to send the file from the **Preview Window** to the Program output of the Synergy switcher.

This completes the procedure to send a file from the Preview Window of the Viz|Trio Client system to the Program of the Synergy switcher.
Still Store Interface

Synergy series switchers interface with still store devices using Intelligent Interface protocol. You can access different stills that are stored on the still store device directly from the switcher.

Refer to the section “Communications Setup” in Chapter 11 of the Synergy Series Installation Guide, for full configuration instructions. Refer to your still store’s installation and operating manuals for details of its functionality.

Changing the Still ID

Use the following procedure to change the Still ID that the still store device is sending to the Synergy switcher.

1. Select the still store crosspoint on the desired MLE.
   
   The Global Memory System Group switches to Still Store mode, and the display area provides information pertaining to the still store’s output.

   The upper line indicates the four digit number of the still that the still store is sending to Synergy.

   If Synergy has not received the requested Still ID from the still store, the line reads: Still not loaded

   The lower line indicates which channel the still store is using to send stills to Synergy.

   When the Global Memory System Group is in Still Store mode, the VTR CLIP button lights as an indicator.

2. Change the Still ID number by entering the new number using the Global Memory System number buttons.

3. When the new number shows in the display area, press the lit ENTER button.

   The displayed four digit Still ID will return to the original value for a moment after the ENTER button is pressed. However, it updates to the new value after the still store cues the new still image.

This completes the procedure to change the Still ID that the still store device is sending to the Synergy switcher.
Editor Interface

The Editor Interface button in the Global Memory System Group allows the Synergy switcher to be controlled by a remote editing system, using a GVG Editor Protocol, or the OverDrive Production Control System.

Note

The Editor Interface Option must be installed in order to be able to connect an editor or the OverDrive system to the Synergy switcher.

Toggle the EDITOR button ON, lit, to enable control of the Synergy switcher from the editor or OverDrive system. In Editor mode, you can still perform most switcher functions.

Important

When the OverDrive Production Control System is connected to the switcher, activating the Editor button will turn on the Roll VTR buttons, and set the Roll VTR Mode to Arm, disabling the Roll VTR Mode selection in the Personality Menu.

All remote editors must be connected to the Editor port on the back of the Synergy frame. The OverDrive Production Control System also requires that you connect it to the Aux 1 port on the back of the Synergy control panel. Refer to Chapter 12, “Editors”, of the Synergy Series Installation Guide for more information on connecting a remote editor or OverDrive Production Control System to the Synergy switcher. Refer to Chapter 12, “Editors”, of the Synergy Series Installation Guide for more information on setting up communications for the editor or OverDrive system.

Using OverDrive with a Synergy 2 Switcher

The OverDrive Editor requires at least two Effects MLEs in order to operate. With a Synergy 2 Switcher, there is only one Effects MLE and the PGM MLE. OverDrive will compensate for this lack of a second Effects MLE by using the PGM MLE as an Effects MLE. This requires OverDrive to configure the switcher in a manner that will alter the way the PGM MLE operates. This configuration involves how OverDrive recalls a shot and performs a transition and how you will be able to use the control panel when it is in Editor mode.

Synergy 2 Limitations with OverDrive

Important

These operational limitation will only apply if the EDITOR button in the Global Memory System Group is On and an OverDrive Editor has been set up in the Communications Menus.

Because OverDrive must use MLE 2 of the switcher as both a BKGD/PST MLE and a PGM/PST MLE, there are a number of special limitations that result. These limitations are as follows:

- The two internal DSKs are turned into Keyers for MLE 2; therefore, they cannot be used as Downstream Keyers. If you attempt to transition a DSK on-air when MLE 2 is off-air, a warning message will pop up. If DSKs are required, the Additional Downstream Keyer option will be required.

- If a Key is included in the shot set up on MLE 2, a transition of both the Background and any Keys will be required. In this case you cannot perform an S&T Wipe transition because the Key is included. This limitation only applies if there are Keys on-air in the memory recall.
• If a Key is flown in the memory recall on MLE 2, an S&T Wipe cannot be used to transition the memory on-air. This limitation applies whether the Key is on-air or not.

• You will not be able to preview a transition on MLE 2 as you can on MLE 1.

• Because OverDrive has to recall memories on MLE 2, you will have to duplicate your memories on MLE 1 and MLE 2.

Operating Tip

<table>
<thead>
<tr>
<th>Operating Tip</th>
</tr>
</thead>
<tbody>
<tr>
<td>It will be easier to create your memories in MLE 1 and copy them down onto MLE 2, than trying to recreate them on MLE 2.</td>
</tr>
</tbody>
</table>

These limitations apply to both the Synergy 2 Switcher and the OverDrive Editor. If full functionality of your Synergy 2 Switcher is required, you can toggle the EDITOR button Off, to return to normal switcher operation.
Router Interface

The Router Matrix Control Menu allows you to assign different Router sources to a BNC that is assigned to the Router.

**Operating Tip**
You can access the Router input that is assigned to a BNC by pressing the corresponding crosspoint button. The Router Matrix Control Menu will be displayed.

Changing the Source

Use the following procedure to change the source on a Router:

1. Navigate to the Remote Control Select Menu as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Remote Control Select.
2. Press Router Control to show a list of BNCs assigned to a Router.

   - Use the BNC knob to select the BNC you want to change the source for.
4. Press GO!! to display the Router Matrix Control Menu.

When you first enter the Router Matrix Control Menu, messages are sent to all connected Routers to determine the current Source-to-Destination (Router output to Synergy) mappings. Another message is sent to retrieve the names or numbers of all sources connected to the Router.

**Note**
If a “COMMUNICATIONS LOST” message appears on the menu, the Synergy switcher has been unsuccessful at receiving a response from the Router. Check the cable connections and the configuration on the switcher and the Router.
If either of these messages is not supported (in particular, the messages concerning mnemonics) then default values are created (i.e. “Src ###”, “Dest ###”).

5. Press **Refresh Sources** to update the list of available sources on the Router.

6. Select the source on the Router you want to assign to the selected BNC as follows:
   - Use the **x1** knob to move through the source list 1 at a time.
   - Use the **x10** knob to move through the source list 10 at a time.
   - Use the **x100** knob to move through the source list 100 at a time.

When the source is selected, the Router automatically assigns it to the BNC.

This completes the procedure to change the source on a Router.

**Router Communications Notes**

When properly configured, there is consistent communication from the Synergy to the Router.

- If the Synergy switcher has not received a response of any sort from the Router for one full second, a message is sent to generate a response.
- If the Synergy switcher has not received a response for two seconds, it is assumed that there is a communications problem. The message “COMMUNICATIONS LOST” will be displayed in the **Router Matrix Control Menu**.

**Operating Tip**

You can select a different BNC at this point by pressing the corresponding softkey.
Aux Bus Group

Each Synergy switcher provides 12 Aux Buses, each of which can be used to route video to monitors, DVEs, still stores, VTRs, etc. The layout of the Aux Bus Crosspoint Row is slightly different on each switcher, based on the differing numbers of crosspoints and MLEs. The layout of the Aux Bus Assign Group is identical on the Synergy 3 and 4, while on the Synergy 2 the group is displayed beneath the Aux Bus row.

This section discusses the following topics:

- Aux Bus Group Layout
- Using the Aux Bus

Aux Bus Group Layout

This section provides illustrations of the Aux Bus Group of the Synergy 2, 3 and 4 switchers.

Synergy 2 Aux Bus Group

The following figure illustrates the Synergy 2 Aux Bus Group.
**Synergy 3 Aux Bus Group**

The following figure illustrates the Synergy 3 Aux Bus Group.

![Synergy 3 Aux Bus Group Diagram](image)

1. Aux Bus Crosspoint Row
2. Shift Button
3. Special Aux Bus Crosspoints
4. On Air LED
5. Non-Sync LED
6. Aux Bus Assign Group

**Synergy 4 Aux Bus Group**

The following figure illustrates the Synergy 4 Aux Bus Group.

![Synergy 4 Aux Bus Group Diagram](image)

1. Aux Bus Crosspoint Row
2. Shift Button
3. Special Aux Bus Crosspoints
4. On Air LED
5. Non-Sync LED
6. Aux Bus Assign Group

1. **Aux Bus Crosspoint Row**

   The sources on the Aux Bus Crosspoint Row can be mapped in one of two ways. One method is to map the crosspoints identical (in both name and quantity) to those on each switcher’s Program/Preset and MLE buses. You can also map BNCs to the Aux Bus Crosspoint Row without changing the crosspoints on the MLE buses.

   All sources are present except for re-entry crosspoints. Because each switcher includes 12 Aux Buses, this row is shared between all Aux Buses. When you select a specific bus...
in the Aux Bus Assign Group and then choose a source on the Aux Bus Crosspoint Row, the selected source is routed to a specific external destination (such as a DVE, still store or VTR).

Note

You cannot select a crosspoint that is mapped to OFF, NONE, BUS HOLD, or a Color Background on the Aux Bus. If attempted, a Pop-Up Help message is displayed.

2. Shift Button

The SHIFT button’s function is identical to those on the Program/Preset and MLE bus. The button is used to access video and key sources that have been mapped to crosspoints beyond the number of available buttons. Due to the flexibility of the input mapping procedure (during switcher installation), all desired crosspoints can be made available — either on the shifted or un-shifted bus rows.

Use the following procedure to access a shifted source on an Aux Bus:

a) Press and hold the SHIFT button.
b) Press the desired crosspoint.
c) Release both buttons.

The SHIFT button plus the selected source both stay lit.

Please note:

• With a shifted source selected on an Aux Bus, to take an unshifted source, simply press its button.
• With a shifted source selected, to take another shifted source, repeat the procedure above.
• If you press SHIFT and then decide not to select a source, simply release the SHIFT button. No change will occur on the Aux Bus.
• Any crosspoint on the Synergy control panel can be assigned the Shift function.

3. Special Aux Bus Crosspoints

Each Aux Bus includes a section that is reserved for additional crosspoints (many of which are not found on the MLE buses).

• DVE SEND (not available on 2003 edition panels) — When lit, indicates that an associated DVE SEND button is lit in an MLE’s Transition Group, and that a partially layered output of that MLE is being routed to the DVE to produce the required transition. The DVE Send and Remote Control Option must be installed. Refer to the section “DVE Communications Setup” in the Synergy Series Installation Guide, for instructions.
• MLE 1 (All Switchers) — Allows you to route MLE 1’s output to the assigned Aux Bus destination.
• MLE 2 (Synergy 3 and 4 only) — Allows you to route MLE 2’s output to the assigned Aux Bus destination.
• MLE 3 (Synergy 4 only) — Allows you to route MLE 3’s output to the assigned Aux Bus destination.
• CLEAN FEED (All Switchers) — Allows you to route the Clean Feed output to the assigned Aux Bus destination.
• **PGM (All Switchers)** — Allows you to route the Program output to the assigned Aux Bus destination.

4. **On Air LED**

The ON AIR LED indicates, when lit, that the video selected on the assigned Aux Bus is contributing to the switcher’s main program output. In addition, the source selected on that bus will be tallied. Refer to the section, “Aux Bus Setup” of the Synergy Series Installation Guide, for instructions on setting up Aux Bus tallies.

5. **Non-Sync LED**

The N/S LED indicates, when lit, that the source selected on that specific Aux Bus is non-synchronous. The N/S LED serves as a warning only, indicating that the input’s timing should be fixed at the source. When a non-sync LED is lit, the source is still usable, but it will be shifted vertically.

6. **Aux Bus Assign Group**

The Aux Bus Assign group is an array of 12 buttons that determines the output to which the Aux Bus Crosspoint Row is assigned. For example, if ASSIGN 1 is lit, source selections are routed to the switcher’s Aux 1 output. If ASSIGN 6 is selected, sources are routed to the Aux 6 output.

### Using the Aux Bus

<table>
<thead>
<tr>
<th>Note</th>
<th>Consult with your facility engineer as required. Refer to your Auxiliary Output Worksheet for information on the Aux Bus outputs and their destinations of your facility.</th>
</tr>
</thead>
</table>

Use the following procedure to use the Aux Bus:

1. Ensure that each Aux Bus is properly connected to the desired external devices.

2. In the Aux Bus Assign Group, press the button for the Aux Bus on which you want to select a source. Press AUX 1 or AUX 2 to select Aux Bus 1 or Aux Bus 2 respectively.

<table>
<thead>
<tr>
<th>Operating Tip</th>
<th>If desired, on the Aux Bus Menu (automatically displayed when AUX 1 or AUX 2 is pressed), you can select AUX 3 through AUX 12.</th>
</tr>
</thead>
</table>

This completes the procedure to use the Aux Bus.
Remote Aux Panels

Remote Aux Panels are one-piece panels that provide remote control (or monitoring) capability of one (or more) of the switcher frame’s Aux Buses. These panels are typically mounted close to the destination devices to which they route their sources. Video does not flow through the panels — the actual Aux Bus outputs originate from the frame using separate wiring paths to the destination devices.

There are two types of remote Aux panels available for each Synergy switcher:

- A **Dedicated Remote Aux Panel** controls one Aux Bus output. It allows you to route sources to one destination only.
- An **Assignable Remote Aux Panel** controls all 12 Aux Bus outputs. It performs the same function as the Aux Bus group of the switcher.

The following topics are discussed in this section:

- Remote Aux Panels
- Operation Modes
- Using a Dedicated Remote Aux Panel
- Using an Assignable Remote Aux Panel

Remote Aux Panels

The following figures illustrate Remote Aux Panels for each switcher:

**Synergy 2 Remote Aux Panels**

The following figure illustrates the Dedicated Remote Aux Panel for the Synergy 2 switcher:

Synergy 2 Dedicated Remote Aux Panel

The following figure illustrates the Assignable Remote Aux Panel for the Synergy 2 switcher:

Synergy 2 Assignable Remote Aux Panel
Synergy 3 Remote Aux Panels

The following figure illustrates the Dedicated Remote Aux Panel for the Synergy 3 switcher.

Synergy 3 Dedicated Remote Aux Panel

The following figure illustrates the Assignable Remote Aux Panel for the Synergy 3 switcher:

Synergy 3 Assignable Remote Aux Panel

Synergy 4 Remote Aux Panels

The following figures illustrate the Dedicated Remote Aux Panels for the Synergy 4 switcher.

Synergy 4 Dedicated Remote Aux Panel

The following figure illustrates the Assignable Remote Aux Panel for the Synergy 4 switcher:

Synergy 4 Assignable Remote Aux Panel

Dedicated Crosspoint Buttons

In addition to crosspoints, all panels include dedicated “special” crosspoint buttons for DVE Send, Program, all the available MLEs on your switcher, and Clean Feed as illustrated below.

Assignable panels (only) also include an Aux Bus Assign Group that is used to select which Aux Bus the panel is controlling. All panel types include a bright “on-air” or “active” LED that indicates (when lit) that the Aux Bus controls a signal that forms a part of the program output.
Operation Modes

During switcher installation, both types of Remote Aux Panels can be programmed to operate in certain special modes, as listed below.

Please consult with your facility engineer to learn what operational mode has been programmed for each Remote Aux Panel in your facility. Refer to the section, “Aux Bus Setup” of the Synergy Series Installation Guide, for instructions on configuring remote Aux panel modes.

Note
A GPI input can be assigned to override the current signal selection of a Remote Aux Panel to a pre-configured one. When the GPI trigger is received by the switcher, it will switch the predetermined Aux Bus to a predetermined BNC output. Refer to the section, “Aux Bus Setup” of the Synergy Series Installation Guide, for details.

Dedicated Aux Panels

A single Dedicated Aux Panel is pre-configured to a single Aux Bus output. This single output can be placed in one of two modes, as follows:

- **Regular Mode** — The remote Aux panel has full access to all of the crosspoints and the remote user can assign any crosspoint to the Aux Bus. The sources can be changed from both the remote Aux panel and the local control panel. The crosspoint button is lit steadily.

- **Follow Mode** — The remote Aux panel will only display the currently selected crosspoint on the control panel. The remote user can follow what crosspoints are being selected on the control panel, but cannot change the crosspoints. The crosspoint button is flashing.

Note
If an Aux Bus is set to Bus Follow (i.e., feeding a CDK-111, an Aspectizer, or an Ultimatte) or if it is assigned to an external DVE, you will not be able to change the crosspoints on the current remote Aux panel, regardless of the mode that the panel

Assignable Aux Panels

A single Assignable Aux Panel can be configured for any one of the 32 Aux Bus outputs. Each output can be placed in one of two modes, as follows:

- **Regular Mode** — The remote Aux panel has full access to all of the crosspoints and the remote user can assign any crosspoint to the Aux Bus. The bus can be selected and sources can be changed from both the remote Aux panel and the main control panel. The button is lit steadily.

- **Follow Mode** — The remote Aux panel will only display the currently selected crosspoint on the selected bus. The remote user can follow what crosspoints are being selected on each bus on the control panel, but cannot change the crosspoints. The crosspoint button is flashing.
Using a Dedicated Remote Aux Panel

Before attempting to use your Dedicated Remote Aux Panel, ensure that it is properly connected to the communication cabling chain that goes back to the main control panel. Also, ensure that the specific Aux Bus video output is connected to the input of the desired destination device.

Use the following procedure to operate a Dedicated Remote Aux Panel in Regular Mode:

1. Ensure the Aux Bus, that the Remote Aux Panel is controlling, is routed to the location or device you want it to. Refer to the section “Aux Bus Setup” of the Synergy Series Installation Guide for details on setting up the Remote Aux Panel.

   **Note** If the Remote Aux Panel is in Follow Mode, you will not be able to change the output assigned from the control panel.

2. Select the signal that you want to feed to the Aux Bus Output BNC by using one of the following options:
   - Press a Crosspoint button to route that crosspoint to the Aux Bus Output BNC.
   - Press DVE SEND to route the output of a DVE Send transition to the Aux Bus.
   - Press an MLE button to route the output from that MLE to the Aux Bus.
   - Press CLEAN FEED to route the Clean Feed output to the Aux Bus.
   - Press PGM to route the PGM output to the Aux Bus.

   **Note** If the panel is configured to use shifted crosspoints, hold down the SHIFT button on the remote panel, then press the desired crosspoint to select the shifted video source. Panels that are not configured to use shifted crosspoints assign the SHIFT button as the last of the regular crosspoints.

   The dedicated crosspoints, such as DVE SEND, the MLEs and CLEAN FEED, do not support the shifted function.

This completes the procedure to operate a Dedicated Remote Aux Panel in Regular Mode. The selected video signal will now be the output for the BNC assigned to the Dedicated Remote Aux Panel.

Using an Assignable Remote Aux Panel

Before attempting to use your Assignable Remote Aux Panel, ensure that it is properly connected to the communication cabling chain that goes back to the main control panel. Also, ensure that the specific Aux Bus video output is connected to the input of the desired destination device.

Use the following procedure to operate an Assignable Remote Aux Panel in Regular Mode:

1. Ensure the Aux Bus that the Remote Aux Panel is controlling is routed to the location or device you want it to. Refer to the section, “Aux Bus Setup” of the Synergy Series Installation Guide for details on setting up the Remote Aux Panel.

   **Note** If the Remote Aux Panel is in Follow Mode, you will not be able to change the output assigned from the control panel. You will be able to view different Aux Buses; however, you will not be able to alter the output.
2. Select the Aux Bus that you want to assign the output for as follows:

- **Synergy 2** — Press Assign 1 through 12 to assign the Remote Aux Panel to the corresponding Aux Bus. Refer to the following table to determine which Aux Bus as mapped to each button.

<table>
<thead>
<tr>
<th>Remote Aux Panel Assign Buttons</th>
<th>Aux Bus Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign 1</td>
<td>Bus 1</td>
</tr>
<tr>
<td>Assign 2</td>
<td>Bus 2</td>
</tr>
<tr>
<td>Assign 3</td>
<td>Bus 3</td>
</tr>
<tr>
<td>Assign 4</td>
<td>Bus 4</td>
</tr>
<tr>
<td>Assign 5</td>
<td>Bus 5</td>
</tr>
<tr>
<td>Assign 6</td>
<td>Bus 6</td>
</tr>
<tr>
<td>Assign 7</td>
<td>Bus 7</td>
</tr>
<tr>
<td>Assign 8</td>
<td>Bus 8</td>
</tr>
<tr>
<td>Assign 9</td>
<td>Bus 9</td>
</tr>
<tr>
<td>Assign 10</td>
<td>Bus 10</td>
</tr>
<tr>
<td>Assign 11</td>
<td>Bus 11</td>
</tr>
<tr>
<td>Assign 12</td>
<td>Bus 12</td>
</tr>
</tbody>
</table>

- **Synergy 3 and 4** — Toggle the Assign +4 or Assign +8 button On to access the high level Buses, and then press the desired Assign 1 through 4 button to assign the Remote Aux Panel to the corresponding Aux Bus. Refer to the table below to determine which Aux Bus is mapped to each button.

<table>
<thead>
<tr>
<th>Remote Aux Panel Assign Buttons</th>
<th>Aux Bus Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign 1</td>
<td>Bus 1</td>
</tr>
<tr>
<td>Assign 2</td>
<td>Bus 2</td>
</tr>
<tr>
<td>Assign 3</td>
<td>Bus 3</td>
</tr>
<tr>
<td>Assign 4</td>
<td>Bus 4</td>
</tr>
<tr>
<td>Assign +4 and Assign 1</td>
<td>Bus 5</td>
</tr>
<tr>
<td>Assign +4 and Assign 2</td>
<td>Bus 6</td>
</tr>
<tr>
<td>Assign +4 and Assign 3</td>
<td>Bus 7</td>
</tr>
<tr>
<td>Assign +4 and Assign 4</td>
<td>Bus 8</td>
</tr>
<tr>
<td>Assign +8 and Assign 1</td>
<td>Bus 9</td>
</tr>
<tr>
<td>Assign +8 and Assign 2</td>
<td>Bus 10</td>
</tr>
<tr>
<td>Assign +8 and Assign 3</td>
<td>Bus 11</td>
</tr>
<tr>
<td>Assign +8 and Assign 4</td>
<td>Bus 12</td>
</tr>
</tbody>
</table>
3. Select the signal that you want to feed to the Aux Bus Output BNC by using one of the following options:

- Press a **Crosspoint** button to route that crosspoint to the Aux Bus Output BNC.

**Note**

If the panel is configured to use shifted crosspoints, hold down the **SHIFT** button on the remote panel, then press the desired crosspoint to select the *shifted* video source. Panels that are *not* configured to use shifted crosspoints assign the **SHIFT** button as the last of the regular crosspoints.

- Press **DVE SEND** to route the output of a DVE Send transition to the Aux Bus.
- Press an **MLE** button to route the output from that MLE to the Aux Bus.
- Press **CLEAN FEED** to route the Clean Feed output to the Aux Bus.
- Press **PGM** to route the PGM output to the Aux Bus.

**Note**

The special crosspoints (such as **DVE SEND**, the **MLEs** and **CLEAN FEED**) do *not* support the shifted function.

This completes the procedure to operate an **Assignable Remote Aux Panel** in **Regular Mode**.

**Synergy Slots**

The Synergy control panel incorporates a special mode in which pseudo-random information is statistically measured on a cumulative basis. Use the following procedure to play the Synergy Slots:

1. Navigate to the **Fader Test Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Panel Diagnostics** ⇒ **Fader Test**.

2. Press the **F6** softkey to display the **Synergy Slots Menu**.

   ![Synergy Slots Menu](image)

   **Synergy Slots Menu**

   - **Credits**: 100
   - **Last win**: 0

   This action causes all button LEDs to turn off, with only the **F1** and **MORE** softkeys, and the **Fader** in the **Transition Area** of MLE 1 remaining active. The Fader serves as a “slot machine arm”.

3. Move the fader in the Transition Area of MLE 1 first to the upper limit and then to the lower limit.

   - This will cause the Synergy Slots to cycle for several seconds, and then settle on various pay line symbols.
   - When a winning combination of pay line symbols occurs, the panel reacts as follows:
the button LEDs on the lower area of the control panel flash randomly
~ the number of credits won flashes with the new total number of credits on the
Synergy Slots Menu

• Winning pay line symbol combinations award credits as per the payout table
entitled “Pay Line Payout Table”. The average payoff rate is approximately 239.4
percent.

You can also press MORE to display the Pay Line Payout Table.

Operating Tip
You can also press MORE to display the Pay Line Payout Table.

Pay Line Payout Table

<table>
<thead>
<tr>
<th>Pay Line Symbols</th>
<th>Credit Payout</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 Ross Logos</td>
<td>1000</td>
</tr>
<tr>
<td>3 Lucky 7s</td>
<td>250</td>
</tr>
<tr>
<td>3 Oranges</td>
<td>30</td>
</tr>
<tr>
<td>3 Lemons</td>
<td>25</td>
</tr>
<tr>
<td>3 Apples</td>
<td>20</td>
</tr>
<tr>
<td>3 Cherries</td>
<td>20</td>
</tr>
<tr>
<td>3 Bells</td>
<td>15</td>
</tr>
<tr>
<td>3 Bars</td>
<td>15</td>
</tr>
<tr>
<td>3 Stars</td>
<td>10</td>
</tr>
<tr>
<td>3 Diamonds</td>
<td>10</td>
</tr>
<tr>
<td>2 Ross Logos</td>
<td>10</td>
</tr>
<tr>
<td>1 Ross Logo</td>
<td>3</td>
</tr>
</tbody>
</table>

• The amount of credits won on any one pull of the arm will determine the number of
flashing buttons on the panel. There are three “levels” of a “win”. Refer to the
“LED Illumination Levels Table” for detailed information.

• The highest number of credits you can accumulate is 9999, and the lowest is 0.

LED Illumination Levels Table

<table>
<thead>
<tr>
<th>Level</th>
<th>% of LEDs Illuminated</th>
<th>Credits Won</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6.25%</td>
<td>&lt; 10</td>
</tr>
<tr>
<td>2</td>
<td>12.5%</td>
<td>10 to 100</td>
</tr>
<tr>
<td>3</td>
<td>25%</td>
<td>&gt; 100</td>
</tr>
</tbody>
</table>

4. Exit the Synergy Slots as follows:
   • Press HOME to display the Main Menu 1-2.
   OR
   • Press UP ONE to display the Fader Test Menu.

This concludes the procedure to play the Synergy Slots.

Pay Line Symbols

<table>
<thead>
<tr>
<th>Credit Payout</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
</tr>
<tr>
<td>250</td>
</tr>
<tr>
<td>30</td>
</tr>
<tr>
<td>25</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>10</td>
</tr>
</tbody>
</table>

LED Illumination Levels Table

<table>
<thead>
<tr>
<th>Credits Won</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 10</td>
</tr>
<tr>
<td>10 to 100</td>
</tr>
<tr>
<td>&gt; 100</td>
</tr>
</tbody>
</table>
DVE Send

In This Chapter

This chapter provides detailed instructions for the DVE Send feature of the Synergy switcher. The following topics are discussed:

- Understanding DVE Send Operation
- DVE Send Prerequisites
- Configuring a Primary DVE
- Multi-channel DVE Rules
- Performing a DVE Send Transition
- Valid DVE Transitions
- Using Clean Feed Alpha to Enhance DVE Send
- DVE Send Notes
- Recalling DVE Effects

Note

Refer to Chapter 13 “External DVEs” of the Synergy Series Installation Guide, for details on DVEs that interface properly (for DVE Send functionality) to the Synergy switcher and specific interface issues. Contact Ross Video Technical Support for additional DVE interface updates as they become available.
Understanding DVE Send Operation

The DVE Send mode allows you to perform fast and simple DVE transitions from the switcher panel — as easy as selecting a Dissolve or a Wipe. When you set up a DVE Send transition, you are electronically routing a specific set of signals from the selected MLE to the DVE for processing — and then back into the MLE for keying. On an MLE, the signals that you can send to the DVE are the various combinations of the three “next transition” buttons: BKGD, KEY 1, and KEY 2.

DVE Send Prerequisites

To use the DVE Send mode, ensure that the following important prerequisites have been met:

- The DVE Send and Remote Control option must be properly installed in the switcher.
- Your Primary DVE must be properly configured. Note that you can select Primary DVE as the actual device on the Communications Type Menu, as shown below.

```
Communications — Type Menu

<table>
<thead>
<tr>
<th>Type</th>
<th>Select</th>
<th>Con Settings</th>
<th>Con Type</th>
<th>Custom Devices</th>
<th>Extra Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVE 1</td>
<td>OFF</td>
<td>OFF 4DVE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVE 2</td>
<td>(RZ)</td>
<td>DVE 1 (DI)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This menu lets you setup what each of the com ports are used for.
```

In Chapter 13, “External DVEs” of the Synergy Series Installation Guide, refer to the “DVE Communications Setup” section for instructions.

**Note** It is recommended that you use the DVE 2 Connector on the rear chassis (labeled DVE 2).

- The Aux Buses that you have chosen to route video (and key) to the DVE have been properly associated with BNCs. In Chapter 10, “Completing Setup” of the Synergy Series Installation Guide, refer to the “Aux Bus Setup” section for details.

**Note** You may assign any Aux Bus to the DVE fill and alpha signals.

Configuring a Primary DVE

Your Primary DVE can be configured in one of two ways:

- A 1+0 DVE has a video connection only going from Synergy to the DVE. Both a key signal and a fill signal are connected from the DVE to Synergy.
- A 1+1 DVE has both a video (fill) and a key (alpha) connection going from Synergy to the DVE. Both a key signal and a fill signal are connected from the DVE to Synergy.

The method by which you configure your Primary DVE greatly affects the capabilities of the DVE itself, when used in conjunction with the DVE Send feature. The table below illustrates the differences and limitations between the two types of DVE connections.
Notes on Configuring a Primary DVE

Note the following important points:

- If you connect your Primary DVE in **1+0** fashion, the output of one Aux Bus (fill) is sent to the DVE. You will be able to fly the video channel, but you will **not** be able to fly an effect designed with video and key — such as flying a logo from a character generator.

- If you connect your Primary DVE in **1+1** fashion, the output of two Aux Buses (key and fill) are sent to the DVE. You will have **no restrictions** in terms of video-only, or video-plus-key effects.

Multi-channel DVE Rules

The DVE Send feature is primarily designed for single-channel DVEs; however, the following important rules also apply to multi-channel DVEs:

- For multi-channel DVEs that accept multiple key and fill **inputs**, you are free to assign additional Aux Buses to route key and fill signals to the DVE. Keep in mind, however, that the DVE Send function automatically routes **one key and one fill** — additional signals beyond these must be **manually** routed to the DVE.

- If the Primary (multi-channel) DVE returns a **combined** key signal to Synergy switcher, you can use DVE Send in conjunction with multi-channel effects such as two-sided “slabs.” However, if the multi-channel DVE returns separate key signals, you will not be able to key multi-channel effects.
In the separate key situation, **DVE Send** will not work — but you may be able to key the DVE manually (using two keyers) and then use a custom control button for your triggers.

---

**Operating Tip**

For maximum flexibility, it is recommended that you design each DVE effect (on the Primary DVE) with the **key channel enabled**. This setup allows you to perform video-only effects or video-plus-key effects without restriction, and without re-configuring the switcher. In addition, for the best visual results, the effect’s **keyframe 1** should be full screen, and the effect’s **last keyframe** should be fully off screen.

---

### Performing a DVE Send Transition

With all the prerequisites met (as listed in the preceding sections), use the following procedure to perform a **DVE Send** transition:

1. Ensure that the desired DVE effect is properly designed with both the video and key channels enabled.
2. Select the desired foreground and background sources on the MLE.
3. Press **DVE SEND** in the selected MLE’s **Transition Group**. This action assigns control of your primary DVE to the MLE in which the button is pressed, activates the assigned Aux Buses and routes their video to the DVE.

   Note that when **DVE SEND** is pressed in the MLE, the **DVE SEND** button automatically lights on all associated Aux Buses, indicating that a pre-keyed layer from the selected MLE is being routed to the DVE.

**Note**

When you press **DVE SEND** in an MLE **Transition Group**, the **DVE** button in the **Pattern Control Group** automatically lights — indicating that the pattern buttons (shot box) are now assigned to that MLE for effect selection. Because there is only one primary DVE, there is only one **DVE** button in the group.

- If the DVE effect direction is **forward** (chosen by pressing **NORM** in the **Pattern Control Group**), the video on the MLE’s **Program** bus will be routed to the DVE fill input.
- If the DVE effect direction is **reverse** (chosen by pressing **REV** in the **Pattern Control Group**), the video on the MLE’s **Preset** bus will be routed to the DVE fill input.
- If the DVE is configured as **1+1**, the fill video’s associated alpha signal will be routed to the DVE on the second Aux Bus.
  ~ If the effect includes a **Background** transition, full screen white is sent on the second Aux Bus.
  ~ If the effect is a **Key 1**-only or **Key 2**-only transition, the associated alpha signal is sent on the second Aux Bus.
- If the DVE is configured as **1+0**, no alpha signal is sent at all.
4. If additional video channels are involved in the effect (e.g., a multi-channel effect), route them manually using the appropriate Aux Buses. If you need to override the automatic Aux Bus selections, select your sources manually on the appropriate Aux Buses.
5. Select the DVE effect in one of two ways:
   - In the **Pattern Control Group**, press the “shot box” button for the desired DVE effect.
   - Enter a two-digit number on the **Global Memory System** group’s keypad and press **ENTER**.

Refer to section “Recalling DVE Effects” on page 11–11 for additional instructions on recalling DVE effects and Aux Bus crosspoints.

6. Choose the direction for the DVE effect using the three **direction** buttons in the **Pattern Control Group**:
   - Select **NORM** to run the effect forward. The video on the **Program** bus will transition off with the DVE effect, revealing the **Preset** bus underneath.
   - Select **REV** to run the effect in reverse. The video on **Preset** will transition on with a DVE effect, covering up the **Program** bus.
   - Select **FLIP FLOP** to run the effect forward with the first transition, then reverse with the next transition.

7. In the MLE’s **Transition Group**, use the three buttons in the **Next Transition** section to choose the combination of actions that you want to include in **DVE Send** effect.

   ![MLE Transition Group Diagram]

   **Important**
   Not all transition combinations are valid, depending on the type of DVE that is configured (1+0 or 1+1) and the actual buttons that are selected. Refer to the section “Valid DVE Transitions” on page 11–6 for details.

By selecting a combination of buttons in the **Next Transition** section, you are electronically routing those signals from the MLE — to the DVE for processing — and then back into the MLE where they are keyed over the MLE (using the MLE’s third **hidden** keyer — reserved exclusively for **DVE Send**)!

8. Press **AUTO TRANS** to initiate the transition. Synergy performs a match-frame cut to keyer 3, cues the DVE to the starting keyframe of the effect, and issues a “**Run Forward**” or “**Run Reverse**” command to the DVE as appropriate.

   ![DVE Switcher Diagram]

   **Note**
   DVEXtreme V2 protocol is now implemented for enhanced external DVEXtreme control. This protocol gives the Synergy switcher full fader and transition rate control of the DVE.

This completes the procedure to perform a **DVE Send** transition.
Valid DVE Transitions

The following table indicates which transitions are valid — when using a **1+0** or **1+1** DVE, and when choosing different combinations of the three *next transition* buttons (**BKGD, KEY 1**, and **KEY 2**). Use the following figure for reference:

<table>
<thead>
<tr>
<th>Transition Description</th>
<th>Button Combination</th>
<th><strong>1+0 DVE</strong></th>
<th><strong>1+1 DVE</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Background Only</strong> — the Background only flies. Key 1 and Key 2 are not affected if they are on screen.</td>
<td><img src="image" alt="Diagram" /></td>
<td>Valid</td>
<td>Valid</td>
</tr>
<tr>
<td>Background flies, revealing the preset bus underneath.</td>
<td><img src="image" alt="Diagram" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Background + Key 1</strong> — Key 1 is pre-keyed over the Background, and both are sent to the DVE as a full screen image. Key 2 is not affected if it is on screen.</td>
<td><img src="image" alt="Diagram" /></td>
<td>Valid</td>
<td>Valid</td>
</tr>
<tr>
<td>Background and Key 1 fly together, revealing the preset bus underneath.</td>
<td><img src="image" alt="Diagram" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Background + Key 2</strong> — Key 2 is pre-keyed over the Background, and both are sent to the DVE as a full screen image. Key 1 must be off.</td>
<td><img src="image" alt="Diagram" /></td>
<td>Valid</td>
<td>Valid</td>
</tr>
<tr>
<td>Background and Key 2 (and Key 1 if it is on) fly together, revealing the preset bus (and Key 1 if it is on) underneath.</td>
<td><img src="image" alt="Diagram" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Background + Key 1 + Key 2</strong> — Key 1 and Key 2 are pre-keyed over the Background, and all are sent to the DVE as a full screen image.</td>
<td><img src="image" alt="Diagram" /></td>
<td>Valid</td>
<td>Valid</td>
</tr>
</tbody>
</table>
### Valid DVE Transitions

<table>
<thead>
<tr>
<th>Transition Description</th>
<th>Button Combination</th>
<th>1+0 DVE</th>
<th>1+1 DVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background, Key 1 and Key 2 fly together, revealing the preset bus underneath.</td>
<td><img src="image1" alt="Diagram" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Key 1 Only</strong> — Key 1 fill and Key 1 Alpha are sent to the DVE. Background and Key 2 are not affected.</td>
<td><img src="image2" alt="Diagram" /></td>
<td>Not Valid</td>
<td>Valid *</td>
</tr>
<tr>
<td>Key 1 only flies. Background and Key 2 are not affected. Valid only on 1+1 DVEs.</td>
<td><img src="image3" alt="Diagram" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Key 2 Only</strong> — Key 2 fill and Key 2 Alpha are sent to the DVE. Background and Key 1 are not affected</td>
<td><img src="image4" alt="Diagram" /></td>
<td>Not Valid</td>
<td>Valid *</td>
</tr>
<tr>
<td>Key 2 only flies. Background and Key 1 are not affected. Valid only on 1+1 DVEs.</td>
<td><img src="image5" alt="Diagram" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Key 1 + Key 2</strong> — Not valid with any DVE configuration.</td>
<td><img src="image6" alt="Diagram" /></td>
<td>Not Valid</td>
<td>Not Valid</td>
</tr>
</tbody>
</table>

*Note: This transition type is valid for all key types flown or not. Other key modifiers not yet fully implemented.

In the table above, “valid” means that you will visually see the type of transition that you would expect on the monitor — when the different combinations of next transition buttons are selected.

Note that you can select an invalid transition — and it will send video to the DVE — but you will not visually achieve the results that you want. This occurs because Synergy pre-keys the selected video before routing.

- In a 1+0 DVE, there is no key signal to extract and thus the only valid functions are those that include the background. Key-only transitions can be selected and run, but the background will always be pre-keyed along with the selected key — and a full screen image will fly.
- In a 1+1 DVE, the Key 1 + Key 2 transition will not work, because Synergy can only route one alpha key signal to the DVE — not two.

**Important**
The KEY OVER button in an MLE’s Key 1 group changes the visual and electronic priority of Key 1 from “under” to “over” Key 2. If this button is enabled, all rules as listed in the table above remain valid, except that the meanings of Key 1 and Key 2 are reversed.
Using Clean Feed Alpha to Enhance DVE Send

In previous Synergy software versions, **DVE Send** had several limitations with regard to routing keys to a DVE. In particular, you could not route a **Squeeze & Tease Key**, a **Chroma Key**, or a modified **Auto Select** key to an external DVE without a background signal behind it.

Currently, these limitations remain in effect — unless you enable the **Clean Feed Alpha** function on the **Clean Feed Menu**.

Use the following procedure to enable the Clean Feed feature:

1. **Navigate to the Clean Feed Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Output ⇒ Clean Feed From.

2. Use the **MLE** knob to select the desired MLE.

3. Use the **Type** knob to select **DVE Alpha**.

With the feature enabled, the clean feed alpha signal is routed to the DVE, thus removing the DVE Send limitations with Squeeze & Tease, Chroma and Auto Select keys as described above.

**Note**

In this configuration, with the clean feed alpha signal routed to the external DVE, the Clean Feed output signal from the switcher (on the rear chassis) is lost.

**DVE Send Notes**

This section provides important **DVE Send** notes, arranged according to functional categories.

**DVE Send and Custom Controls**

Note the following:

- Do not use **Custom Control** macros that are designed for running the DVE in conjunction with a **DVE Send** effect.

**DVE Send and Keying**

Note the following:

- Using a **Key 1** only or **Key 2** only DVE Send effect in conjunction with a **Preset Pattern** (with **Fly Key** enabled) results in an invalid effect. The background will be pre-keyed along with the preset pattern, instead of the preset pattern alone. The functionality for sending the “Fly Key” preset pattern alone to the DVE is not implemented.
You can make any 1+1 DVE Send effect look like a 1+0 effect simply by pressing the BKGD button (in the Next Transition group).

If a Luma Key or an Auto Select key is already flown using Squeeze & Tease and you now want to route it through the DVE using DVE Send, please note that the order of processing is as follows:

A) Video and alpha signals are routed to the DVE.
B) The DVE processes the signals and returns them to the MLE.
C) Video and alpha signals are then processed by the Squeeze & Tease circuitry.

Note that the result, visually, is that the DVE transition occurs within the screen’s Squeeze & Tease region.

When using a chroma key in conjunction with Squeeze & Tease and DVE Send, the order of processing is as follows:

A) The blue screen background is routed to the DVE.
B) The DVE processes the signal and returns it to the MLE.
C) The signal is processed by the Squeeze & Tease circuitry.
D) The background is chroma keyed.

As with the previous example, visually, the DVE transition occurs within the screen’s Squeeze & Tease region.

**DVE Send Assignments**

Note the following:

- If you change the DVE Send assignment (by pressing DVE SEND in a different MLE), the system automatically selects DISS in the previous MLE.
- If you change the DVE Send assignment to another MLE, the selected DVE effect remains the same until you change it with the shot box buttons. You cannot have different DVE effects assigned to different MLEs on the switcher.
- If you perform a recall function that involves DVE Send, your Aux Bus assignments will change, but the selected DVE effect will not be recalled. If you want the effect recalled as well, ensure that the INCL DVE button is enabled when the recall function is performed.

**Protecting On Air DVEs and DVE Sends**

Note the following:

- If DVE Send is selected as the transition in an MLE, and a register is recalled from memory that includes a DVE Send transition in another MLE, then DVE Send cannot be enabled in the recalled MLE. Instead, a dissolve is set up and an on-air “glitch” is prevented. In this case, the MLE currently using DVE Send takes precedence.

The following are two examples:

~ DVE Send is selected in MLE 1. In MLE 2, you recall register 12 which has DVE Send selected as the transition type. After the recall, DVE Send is still enabled in MLE 1, and MLE 2’s transition is set to dissolve.

~ DVE Send is selected in MLE 1. From the Global Memory area, you recall register 12 for both MLE 1 and MLE 2. In this register, MLE 1 has a dissolve selected and
MLE 2 has DVE Send selected. After the recall, dissolve is enabled in MLE 1 and DVE Send is enabled in MLE 2 as requested. This occurs because MLE 1 was included in the recall, not excluded as in the previous example.

- Recalling a **DVE Send** transition (or simply selecting one) changes the Aux Bus assignments that are feeding the DVE. If the selected DVE was on-air (for example, in a keyer or on Program), changing the Aux Bus assignment would cause an on-air glitch. Therefore, if you have a primary DVE crosspoint selected on an MLE that is *not* part of the recall function, all DVE Sends in the recalled register will be set to dissolve.

For example:
- Before the recall, BNC 12 is selected on Aux 1 (with a fill signal), and BNC 14 is selected on Aux 2 (with an alpha signal). On MLE 1’s key bus, BNC 18 is selected (which is the crosspoint for the primary DVE).
- A recall function that includes DVE Send is performed on MLE 2. If DVE Send was allowed to remain on for the recall, the settings for Aux Buses 1 and 2 would be changed. Therefore, in this situation, MLE 2 is set to dissolve after the recall.

### Preventing Multiple DVE Sends

Note the following:

- Synergy allows you to store (in the same memory register), several MLEs — each of which has **DVE Send** enabled. This is only possible when the MLEs are stored individually. Recalling these registers simultaneously, however, would result in multiple MLE’s having DVE Send enabled — which is an illegal function.

  The rule, in this situation, is that the recalled MLE that is *closest* to the **Program/Preset Bus** wins. The other MLEs will be set to dissolve.

  For example:
  - On a Synergy 4, recall register 10 for MLE 2 and MLE 3 simultaneously. In this register, both MLE 2 and MLE 3 have DVE Send enabled. After the recall, MLE 2 will be set to dissolve and MLE 3’s transition will be set to DVE Send.

### DVE Send and Aux Buses

Note the following:

- When a *successful* recall function is performed that includes a DVE Send transition, the Aux Buses that are assigned to the primary DVE *change* to reflect the DVE Send.

### DVE Send and the INCL DVE Button

Note the following:

- If a **DVE Send** transition is enabled on MLE that is not being recalled, the **INCL DVE** function will be canceled. To do otherwise could cause an on air glitch.
Recalling DVE Effects

This section provides additional information about recalling DVE effects.

**DVE Shot Box**

With the primary DVE properly configured, the DVE button in the Pattern Control Group is active. Pressing DVE turns the 40 pattern buttons into a DVE shot box, with the ability to instantly recall the first 40 DVE effects on your primary DVE — at the touch of a button.

The DVE button will *not* light unless the primary DVE is properly configured — and properly connected.

The following important rules apply:

- The system remembers which DVE effect has been selected. For example, if you press DVE and select effect 10, then press WIPE PP1 and select pattern 37, when you press DVE again, effect 10 will be selected.
- If you manually recall an effect locally on the DVE itself, the buttons in the Pattern Control Group will *not* update.

**Recall DVE Menu**

Pressing the DVE button calls up the Recall DVE Menu in the small Global Memory System group display.

- On the Synergy 3 and Synergy 4 switchers, this is the *only* way to call up the menu.
- On the Synergy 2 switcher, you can also press the RECALL DVE button in the Global Memory System group (there is no RECALL DVE button on the Synergy 3 or 4).

When the Recall DVE menu is active, you can enter a two-digit number (between 00 and 99) on the Global Memory System group’s keypad and press ENTER to recall a DVE effect numerically.

If the selected effect number is between 00 and 39, the appropriate shot box button will light in the Pattern Control Group. Similarly, pressing a shot box button in the Pattern Control Group updates the small Global Memory display.

**Storing and Recalling DVE Registers**

When the DVE button is lit in the Pattern Control Group, the active shot box button (or the effect number shown in the Global Memory display) indicates the DVE effect that will be stored in a switcher memory register. If the DVE button is not lit, the system always stores the last DVE shot box button that was pressed. Thus, when you perform a memory recall operation, the system automatically recalls the stored DVE effect — provided that the following criteria are met:

- The DVE effect from your primary DVE must be stored in a register, and the DVE effect number (that you wish to store) must be recalled immediately prior to storing the full effect to memory.
- The INCL DVE button must be on.
For example:

- If the **INCL DVE** button is on and **MLE 2** is selected in the **Recall Column** (in the **Global Memory System** group), the DVE effect (plus the other contents of the memory register) will be recalled into **MLE 2**.

**Important**

If you have selected more than one MLE and the **INCL DVE** button is on, select a button in the **DVE Send** group to determine which specific MLE is assigned DVE control for the recalled effect.

**Recalling Aux Bus Crosspoints**

If all the *recall* criteria have been met (as indicated above), the Aux Bus crosspoints associated with the primary DVE will also be recalled when a memory recall operation is performed — effectively recalling the signals routed to the DVE. The association between an Aux Bus and a device (BNC) is performed during setup on the **Aux Bus External Device Assignment Menu**.

Navigate to the **Aux Bus – External Device Assignment Menu** as follows:

- Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **Aux Bus** ⇒ **Ext Device Assign**.

**Rules for Recalling Aux Bus Crosspoints**

The following important rules apply to Aux Buses, DVEs, and memory register operation:

- When we say that an Aux Bus is stored or recalled, in fact, it means that the *crosspoint* selected on an Aux Bus is stored in a memory register — or recalled from a register.

- Aux Buses that have no BNCs associated with them (as indicated by the label **NONE** on the **Aux Bus External Device Assignment Menu**) will not be stored or recalled under any circumstances.

- If an Aux Bus has an associated BNC (on the **Aux Bus External Device Assignment Menu**), it will always be stored when a memory storage operation is performed.

- If an Aux Bus has an associated BNC, and if all DVE *recall* criteria are met …
  - primary DVE selected
  - **INCL DVE** button on
  ... then the Aux Bus assignments will be recalled along with the DVE effect from a memory register. If both criteria are not met, Aux Bus crosspoints will not be recalled.
Ultimatte Insider

In This Chapter

This chapter provides an overview and instructions for operating the optional Ultimatte Insider chroma keyer function. The following topics are discussed:

- Ultimatte Insider Option Overview
- Ultimatte Insider Setup – Carrier Mode
- Ultimatte Insider Setup – Bus Mode
- Ultimatte Auto Select Key Setup
- Ultimatte Insider Operation
- Ultimatte Insider Operating Tips

Refer to the following sections, in Appendix C, “Hardware Options”, of the Synergy Series Installation Guide, for detailed Ultimatte Insider installation and setup instructions:

- Refer to the “Input Carrier Board Installation” section for instructions on physically installing the required Input Carrier Board(s).
- Refer to the “Ultimatte Insider Board Installation” for details on installing the Ultimatte board(s) in available slot(s) on the Input Carrier Board.
Ultimatte Insider Option Overview

Ultimatte Insider™ is a hardware option that adds true Ultimatte capability — directly inside the Synergy switcher. The option is comprised of hardware boards designed by Ultimatte (the Oscar-winning industry leader in composition technology), plus Ultimatte-specific menus for controlling the chroma key.

Please note the following important points:

- **Ultimatte Insider Boards** can be configured to operate in Carrier mode or in Bus mode.
  - In Carrier mode, users can apply the Ultimatte feature to any of the eight inputs associated with the host Input Carrier Board.
  - In Bus mode, users can apply the Ultimatte feature to any BNC input (crosspoint) on a selected MLE Key bus.
- Up to two Ultimatte Insider boards can be assigned to an MLE — one for each keyer. Each board creates one processed foreground and one processed key signal from a selected input video source. In total, on a Synergy 4, you can have eight Ultimatte keys running simultaneously — six on a Synergy 3, four on a Synergy 2.
- As a prerequisite, one or more Input Carrier Boards (p/n 4000A-005) must be installed in the Synergy switcher — replacing the standard Input Board for a selected set of eight BNC inputs. Please note:
  - Each Input Carrier Board is a full-length card (the standard Input Boards are half-length cards).
  - Each board provides four slots for hardware options — any of which can be assigned to the Ultimatte Insider.
  - Each board has eight inputs and 16 outputs. The 16 outputs are comprised of the eight original inputs, plus eight modified outputs that are generated from the installed option boards (two outputs per option board).
  - Each Ultimatte Insider board generates two signals — a processed fill and a processed alpha signal.

Ultimatte Carrier Mode Overview

In Carrier mode, by selecting Chroma Key as the key type and selecting one of the eight associated inputs as the source on the configured MLE’s Key Bus, the Ultimatte Insider Menu is automatically displayed. If you select any other input, a standard Synergy Chroma Key Setup Menu is displayed.

- An Aux Bus is not required for Carrier Mode.
- Additional cabling is not required for Carrier Mode.
- Carrier Mode is usually used when the number of inputs requiring Ultimatte keying is eight or less.
Ultimatte Bus Mode Overview

In **Bus** mode, selecting **Chroma Key** as the key type and selecting *any* of the inputs as the source on the selected MLE’s **Key Bus** automatically displays the **Ultimatte Insider Menu**. In other words, you can think of **Bus Mode** as being *horizontal* in nature.

To set up for **Bus** mode, the user assigns an **Ultimatte Insider** to one or both of the keyers on a specified MLE.

The **Ultimatte Insider Board** in **Bus** mode takes advantage of the **Bus Follow** capability in Synergy’s Aux Buses. When an MLE Key is assigned to an Aux Bus in **Bus Follow** mode, any BNC input crosspoint selected on the Key Bus for that keyer, with the Chroma Key button selected, is routed through the Aux Bus back to the Ultimatte Insider card for processing.

- One **Aux Bus** is required for each keyer on an MLE that has access to the Ultimatte option in **Bus Mode**.
- One BNC input is required, from the eight associated with the **Input Carrier Board**, on which the **Ultimatte Insider Board** is installed.
- Additional cabling is required to feed back each required **Aux Bus** into the **Input Carrier Board**.
- **Bus Mode** is usually used when BNC inputs along the *entire* key bus may require Ultimatte keying.
 Ultimatte Insider Setup – Carrier Mode

Once the Ultimatte Insider board is properly installed, you can use the Option Cards Menu to assign an MLE and keyer to the Ultimatte function. Although this step is typically performed during switcher setup, if desired, you can change the assignment via the menu — depending upon your production’s requirements.

Use the following steps to set up the Ultimatte in Carrier mode:

1. Ensure that the Ultimatte is properly installed and recognized by the system. In Appendix D of the Synergy Series Installation Guide, refer to the “Input Carrier Board Installation” and “Ultimatte Insider Board Installation” sections for instructions.

2. Navigate to the Option Cards Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Option Cards.

3. Press Ultimatte to display the Ultimatte Option Card Menu.

4. Use the Ultimatte Card knob to select the available host Input Carrier Board – Carr#1-8, and Socket number – Sock#1-4.

5. Use the Mode knob to select the mode you wish to make active – in this case Carrier. When selecting a mode, the MLE-Key knob title and selections become available.

6. Use the MLE-Key knob to select the MLE – 1-4 and the Key – 1-2 that you wish to associate with the Ultimatte.

In the above example, note that the Ultimatte is installed on Input Carrier Board #2, Socket #2 and that Key1 on MLE2 has been assigned to the Ultimatte in Carrier mode.
The association is between the MLE keyer and the host Input Carrier Board. Any of the eight BNC inputs for the specific Input Carrier Board (in this example BNC 9 – BNC 16) can be assigned as a chroma key source.

7. Repeat steps 2 through 5 for each Ultimatte Insider Board you wish to set up in Carrier mode.

This completes the procedure for setting up an Ultimatte key for use in Carrier mode.

**Important**

The source that you select on the Key Bus activates the Ultimatte menus and internally calls up the Ultimatte’s processed alpha and fill signals. The selected source’s panel button on the Program and Preset buses remains the original unprocessed video signal. To place the Ultimatte’s processed signals on the Program and Preset buses, refer to section “Ultimatte Auto Select Key Setup” on page 12–10.

---

**Note**

If you have previously associated an Ultimatte card with a specified MLE keyer, and you try to associate another Ultimatte card with the same MLE keyer, the following message is displayed:

“This Bus is in use by another Ultimatte”

If you exit the Ultimatte Option Cards Menu with the selected Ultimatte card associated with the selected MLE keyer, the previous settings are overwritten.

If you have previously associated an Aspectizer card with an MLE keyer, and you try to associate an Ultimatte card with the same MLE keyer, the following message is displayed:

“This Bus is in use by another Aspectizer”

If you exit the Ultimatte Option Cards Menu with an Aspectizer and an Ultimatte Insider set to the same MLE keyer, the switcher may generate invalid output from that MLE keyer.
Ultimatte Insider Setup – Bus Mode

Use the following steps to configure the Ultimatte Insider in Bus Mode for chroma key operation:

1. Ensure that the Ultimatte is properly installed and recognized by the system. In Appendix D of the Synergy Series Installation Guide, refer to the “Input Carrier Board Installation” and “Ultimatte Insider Board Installation” sections for instructions.

2. Navigate to the Option Cards Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Option Cards.

3. Press Ultimatte to display the Ultimatte Option Card Menu.

4. Use the Ultimatte Card knob to select the available host Input Carrier Board – Carr#1-8, and Socket number – Sock#1-4.

5. Use the Mode knob to choose the mode you wish to make active – in this case Bus.

6. When selecting a mode, the MLE-Key knob title and selections become available.

7. Use the MLE-Key knob to select the MLE – 1-4 and the Key – 1-2 that you wish to associate with the Ultimatte.

In the above example, note that the Ultimatte is installed on Input Carrier Board #2, Socket #2 and that Key2 on MLE2 has been assigned to the Ultimatte in Bus mode.
At this point, we have completed a partial Bus Mode setup. Any of the 8 inputs associated with the specific Input Carrier Board (in this example BNC 9 – BNC 16) are available to be routed through an Aux Bus.

One untimed Aux Bus is required for each Ultimatte card running in Bus Mode operation. The Aux Bus must be “fed back” into any one of the BNC inputs associated with the Input Carrier Board on which the Ultimatte is installed. In turn, this Aux Bus becomes unavailable for any other use. Continue with the procedure below to connect an Aux Bus to the Ultimatte.

On the rear of the Synergy frame, use industry standard coaxial cable to connect an untimed Aux Bus BNC to one of the BNC inputs available to the Input Carrier Board with the Ultimatte Insider Board on it. The following diagram indicates the cabling connections used in this procedure.

If you have previously associated an Ultimatte card with a specified MLE keyer, and you try to associate another Ultimatte card with the same MLE keyer, the following message is displayed:

“This Bus is in use by another Ultimatte”

If you exit the Ultimatte Option Cards Menu with the selected Ultimatte card associated with the selected MLE keyer, the previous settings are overwritten.

If you have previously associated an Aspectizer card with an MLE keyer, and you try to associate an Ultimatte card with the same MLE keyer, the following message is displayed:

“This Bus is in use by another Aspectizer”

If you exit the Ultimatte Option Cards Menu with an Aspectizer and an Ultimatte Insider set to the same MLE keyer, the switcher may generate invalid output from that MLE keyer.
You must now tell the system which Aux Bus feeds back into the switcher. This is accomplished in the Aux Bus Menu 1-2. For a comprehensive explanation of Aux Bus Setup parameters and options, refer to Chapter 9, “Additional Installation Setups” in the Synergy Series Installation Guide.

Use the following procedure to assign specific switching parameters or “rights” to the Aux Bus:

1. Navigate to the Aux Bus Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus.
2. Press Local Panel to display the Local Panel Menu.

3. Use the Aux Bus knob to select the Aux Bus output you have connected (fed back) to the Input Carrier Board.
4. Use the Mode knob to select Bus Follow. The Bus Follow mode directs the Aux Bus to follow the user’s selections on a specified MLE and bus.

   **Note** In Bus Follow mode, the user is “locked out” of the designated Aux Bus and cannot make selections on the Aux Bus panel itself.

Next you must tell the Synergy switcher which bus, on which MLE, you want the Aux Bus to follow.

1. Press the Bus Follow Assign softkey.
2. Press the Bus Assign to display the Bus Follow Bus Assign Menu.

3. Use the Aux Bus knob to choose the Aux Bus you connected to the Input Carrier Board.
4. Use the **MLE** knob to select the MLE you assigned to the **Ultimatte Board**.

5. Use the **Bus** knob to select the **Key # (not a Key # Alpha)** you assigned with the MLE.

The final step in configuring your **Ultimatte in Bus Mode** involves assigning or routing the **Aux Bus** back into the appropriate **BNC** input.

1. Press **BNC Assign** to display the **Bus Follow BNC Assign Menu**.

<table>
<thead>
<tr>
<th>Bus Follow</th>
<th>Aux Bus</th>
<th>Bus</th>
<th>BNC</th>
<th>BNC Assign</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Aux 1 (A0)</td>
<td>BNC 10</td>
<td>BNC 11</td>
<td>BNC 12 (12)</td>
</tr>
</tbody>
</table>

**Bus Follow – BNC Assign Menu**

2. Use the **Aux Bus** knob to choose the Aux Bus you connected to the **Input Carrier Board**.

3. Use the **BNC** knob to assign the **Input Carrier Board** BNC you connected to the Aux Bus.

This completes the procedure for setting up an Ultimatte key for use in **Bus mode**. Repeat the **Ultimatte Insider Setup – Bus Mode** procedures for each **Ultimatte Insider** board you wish to set up in **Bus** mode.
Ultimatte Auto Select Key Setup

Each Ultimatte Insider board automatically produces processed alpha and fill signals. These signals are used internally to produce the Ultimatte key in the associated MLE, but they can also be placed elsewhere on the Synergy panel for use as Auto Select sources — in the normal way.

In practice, this means that if you have an Ultimatte key enabled on MLE 1, and you have properly set up the Ultimatte’s alpha and fill signals as Auto Select sources, you can utilize the Ultimatte signals elsewhere on the switcher — even though there is only one Ultimatte Board-to-MLE Keyer association permitted. If you change the base Ultimatte key source, or change its clip parameters, each associated Auto Select key will change accordingly.

**Important** Although this step is typically performed during switcher setup, for Ultimatte operation it is helpful to know which crosspoints have been assigned as Ultimatte “Auto Select” keys — and how that process is accomplished.

Use the following procedure to set up the Ultimatte’s alpha and fill signals as Auto Select sources:

1. Ensure that each Ultimatte Insider board is properly associated to an MLE and a keyer.
2. Navigate to the Panel Setup Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC ⇒ Panel.

3. Use the Crosspoint knob to select the button on which you want to associate the Ultimatte’s processed fill (video) signal.
4. Use the BNC knob to scroll the selection down past input 64. Note that the label BNC changes to OPT — indicating that this region of the menu is reserved for internally generated signals from the optional boards on the Input Carrier Board.
5. Select the desired internal Ultimatte video signal (e.g., Ultm13 v). Note that the suffix “v” indicates video (fill). In the Status Box, the system identifies the internal source (Ultimatte Video), the type (Other), the location of the optional board (e.g., carrier 1, socket 3), and the native aspect ratio (4x3). Additionally, the internal Ultimatte alpha signal (e.g., Ultm13 a) is automatically associated with the video as the Auto Key alpha. Note that the suffix “a” indicates alpha.
6. Repeat for each Ultimatte processed video signal that you want to place on the panel.
7. When all buttons are programmed as desired, press HOME to exit the installation menus, and press Confirm to confirm your changes.

This completes the procedure for setting up a panel button to use as an Ultimatte Auto Select key. Refer to the section “Ultimatte Insider Operating Tips” on page 12–19 for additional information.
Ultimatte Insider Operation

Use the following procedure to operate the Ultimatte Insider option:

1. Ensure that each Ultimatte Insider board is properly associated to an MLE and a keyer.

2. On the associated MLE, select the desired background source.

3. Select a key source on the Key Bus:
   - In Carrier Mode, select one key source that is included within the group of eight BNC inputs on the host Input Carrier Board. For more information, refer to the section, “Ultimatte Insider Carrier Mode Setup” of the Synergy Series Installation Guide.
   - In Bus Mode, select any key source on the key bus. For more information, refer to the section “Ultimatte Insider Bus Mode Setup” of the Synergy Series Installation Guide.

4. In the associated keyer, press Chroma Key. This choice automatically selects the output of the Ultimatte board, and displays Ultimatte Insider Menu 1-2.

5. Press Primary to display the Ultimatte Primary Menu.

6. Press Auto Chroma Key to obtain the best automatic chroma key for the selected color. If the Preview Overlay option is installed in the switcher, the Color Pick/Grab Color button feature will be activated.

7. Press Color Pick. A set of cross hairs will appear on the preview monitor and the button designation will change to Grab Color. Move the crosshairs using the top and middle knobs or the Positioner joystick to the color desired for the Chroma Key transition, then press Grab Color. The selected color will now be the fill for the Chroma Key.

8. Press Matte Out Gain to display the Ultimatte Matte Out Gain Menu.
The **Matte Gain** control is a gain adjustment that affects only the processed matte output signal. This control does not have any effect on the matte signal used internally in the **Ultimatte Insider**.

- Use the **Matte Gain** knob to adjust the gain of the matte output signal from the white end. The control can lower the matte output gain to 0%, or push it into the legal ceiling.

9. Press **Primary** to display the **Ultimatte Primary Menu**.

The **Ultimatte Primary Menu** allows you to choose a primary chroma key color, adjust the matte density, and adjust black glossy reflections. The main area indicates the MLE and Keyer, and provides a detailed listing of the Ultimatte parameters.

- Use the **Color** knob to choose the color on which you want to key.
- Use the **Matte Density** knob to control the density (opacity) of the matte. This important step determines the level of separation that corresponds to the point at which the foreground is opaque. The default setting is one in which neutral colored foreground objects are opaque, but any color that is a shade of the backing color is partially transparent. Increasing the **Matte Density** level permits foreground objects that are the same shade as the backing color to be made opaque in the composite image.

For best results, lower the control until some portion of the foreground subject starts to become gray in the matte signal. Then increase the control until any area that should be opaque, has just become black in the matte signal. Do not advance the control too far, as it can cause hard, dark edges around your foreground subjects.

- Use the **Black Gloss** knob to control black glossy foreground objects or surfaces that may be reflecting color from the backing. The control introduces a negative offset which helps interpret the object as a foreground object. Adjust the **Black Gloss** control while viewing the matte signal on the monitor. Increase the level only enough to make the black glossy area of the foreground subject appear solid black in the matte signal.

Note that using the **Black Gloss** control may permit the **Matte Density** control to be lowered. Readjust **Matte Density** after adjusting **Black Gloss** control to ensure that both controls are set as low as possible, without permitting print-through in the foreground. Do not advance the control too far, as it can cause hard, dark edges around your foreground subjects.

10. Press **Shadow Noise** to display the **Ultimatte Shadow Noise Menu**.

<table>
<thead>
<tr>
<th>Ultimate Shadow Noise Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto</strong></td>
</tr>
<tr>
<td><strong>Primary</strong></td>
</tr>
<tr>
<td>Key Fill:</td>
</tr>
<tr>
<td>Matte Density:</td>
</tr>
<tr>
<td>Black Gloss:</td>
</tr>
<tr>
<td>Matte Gain:</td>
</tr>
</tbody>
</table>

- The top **Shadow Noise** control helps reduce noise in the shadow areas of the backing — noise that is noticeable in the composite image. The control also minimizes the effect of glare on the floor, in situations where the backing extends to cover the floor.
The control is a manual override for an automated function that substitutes the quieter blue foreground signal (for blue backing) for the matte signal — whenever the blue is lower than the matte signal.

Typically, the Shadow Noise control is left at its default setting. However, the following adjustments can be made:

- Turning the control counter-clockwise can improve the noise reduction — while simultaneously increasing the density of the shadows cast by foreground objects.
- Turning the control clockwise can lighten the density of shadows cast by foreground objects. However, if there is noise in the shadow area, it will be more apparent in the composite image when the control is turned in this direction.

11. Press Matte Size/Posn to display the Ultimatte Matte Size and Position Menu.

<table>
<thead>
<tr>
<th>Key Fill:</th>
<th>BNC 3 (BNC HE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color:</td>
<td>Green</td>
</tr>
<tr>
<td>Matte Density:</td>
<td>100.0%</td>
</tr>
<tr>
<td>Matte X-Size:</td>
<td>100.0%</td>
</tr>
<tr>
<td>Matte Y-Size:</td>
<td>100.0%</td>
</tr>
<tr>
<td>Black Gloss:</td>
<td>100.0%</td>
</tr>
<tr>
<td>Matte Gain:</td>
<td>100.0%</td>
</tr>
</tbody>
</table>

Ultimatte Matte Size and Position Menu

This menu is typically used to remove undesired edges from the foreground subject caused by camera-generated edges (when “detail” is enabled on the camera) or by lens aberrations.

By decreasing the size of the matte or changing its position, edges can be cleaned up. Note, however, that loss of detail on the foreground subject may result.

- Use the X-Size knob to adjust the size of the matte horizontally, in sub-pixel increments (up to 3 pixels).
- Use the Y-Size knob to adjust the size of the matte vertically, in sub-pixel increments (up to 3 pixels).
- Use the X-Position knob to adjust the horizontal placement of the matte signal. This control adjusts the position (timing) of the Matte signal with respect to the foreground, in sub-pixel increments (up to 3 pixels).

12. Press MORE to display Ultimatte Insider Menu 2-2.

13. Press Color Density to display the Ultimatte Color Density Menu.

Ultimatte Color Density Menu
The controls on the **Ultimatte Color Density Menu** allow you to “fine tune” the edges of the foreground image. The controls depend on the selected primary color:

- If **Green** is the primary color, controls are provided for **Red Density** and **Blue Density**.
- If **Blue** is the primary color, controls are provided for **Red Density** and **Green Density**.
- If **Red** is the primary color, controls are provided for **Green Density** and **Blue Density**.

Using the **Density** controls, it may be possible to improve the appearance of all edges in the composite. For example, reducing **Green Density** and **Red Density** settings improves the edges of green and red objects respectively, without compromising the edges of neutral colored objects (which are set by the **Matte Density** control).

Note that the **Density** controls may interact with the **Matte Density** control, depending on the colors present in foreground objects. In some cases, readjusting **Matte Density** may be required. Use care when reducing a **Density** control to avoid print-through in the foreground objects.

14. Press **Flare Balance** to display the **Ultimatte Flare Balance Menu**.

The **Ultimatte Flare Balance Menu** includes three controls that affect the overall flare suppression: **White Balance**, **Gray Balance**, and **Black Balance**. Each control influences certain parts of the foreground image, as indicated by the control name itself.

- Use the **White Balance** knob to control the overall flare suppression from the “white” end. This control allows, for example, white foreground colors to have equal amounts of red, green and blue, or to be slightly warmer or cooler.

  Adjusting the **White Balance** control makes light foreground colors warmer or cooler with minimal effect on darker colors. For example, when using a blue backing, the flare suppression logic can cause blond hair to look white around the edges. Adjusting **White Balance** can restore a warmer more natural color to the hair — without significantly affecting other colors.

- Use the **Gray Balance** knob to make mid-range foreground colors warmer or cooler with minimal effects on lighter and darker colors. In addition to controlling flare suppression at mid-level values, the **Gray Balance** control also provides you with an added degree of flexibility in suppressing flare and contamination from the backing onto the foreground subject.

- Use the **Black Balance** knob to control the overall flare suppression from the “black” end. This control allows, for example, black foreground colors to have equal amounts of red, green and blue, or to be slightly warmer or cooler.

  Adjusting the **Black Balance** control makes dark foreground colors warmer with minimal effects on lighter colors. For example, adjusting **Black Balance** can eliminate
flares from most hair colors (blacks, browns and some blondes) with minimal effects on lighter colors.

Note that flare suppression may alter certain foreground colors. In most cases, this adjustment makes the foreground appear as if it is placed in front of a neutral (black) backing and not a colored one, and overall, makes the composite more realistic (free of any influence from the backing color).

15. Press **Flare Gate** to display the **Ultimatte Flare Gate Menu**.

![Ultimatte Flare Gate Menu](image)

The **Ultimatte Flare Gate Menu** provides three selective color gates: a combined **Gate 1/3** (Gate 1 or Gate 3) and **Gate 2**. Because alteration of foreground colors may not be acceptable via flare suppression, the “**Gate**” adjustments let you override the suppression so that “problem” colors can be used in the foreground. Problematic colors can be reproduced (with addition of some flare on certain colors), while maintaining full suppression on the rest. Refer to the section “**Color Gates**” on page 12–16 for information on the benefits and trade-offs for each Gate adjustment.

16. Press **Veil Master** to display the **Ultimatte Veil Master Menu**.

![Ultimatte Veil Master Menu](image)

The term “**Veiling**” describes the discoloration of the background scene in a composite image, which is caused by traces of the backing color in the processed foreground.

If the backing color is consistent, and if RGB ratios track from the backing’s bright to dark areas, the **Ultimatte Insider** automatically removes all traces of the backing color in the foreground. The **Veil** controls override this automatic function in order to compensate for slight inconsistencies in the backing color.

- Use the **Veil Master** knob to override the entire automated circuit, and manually increase or decrease the **Red**, **Green**, and **Blue Veil** levels equally. If one color has been adjusted independently, the **Veil Master** control maintains the same relationships with the other two.
17. Press **Veil Colors** to display the **Ultimatte Veil Colors Menu**.

**Ultimatte Veil Colors Menu**

In order to compensate for inconsistencies in the backing color, the **Ultimatte Veil Colors Menu** provides individual RGB veil adjustments. *Increasing* levels can cause discoloration in the background scene. *Decreasing* levels can compensate for variations in the backing color, but may cause dark edges on the foreground.

- Use the **Red Veil** knob to manually override the red component of the automated circuit that suppresses the backing color of the composite image.
- Use the **Green Veil** knob to manually override the green component of the automated circuit.
- Use the **Blue Veil** knob to manually override the Blue component of the automated circuit.

18. Press **MatteOutTie On/OFF** to tie the Matte Out to the intensity of the **Veil Colors**.

**Ultimatte Matte Out Tie ON/OFF Menu**

This completes the procedure to operate the **Ultimatte Insider** option.

**Color Gates**

The **Ultimatte Flare Gate Menu** provides three selective color gates: a combined **Gate 1/3** (Gate 1 or Gate 3) and **Gate 2**. The effects of the Gate controls vary depending on the backing color. The tables in this section illustrate the benefits and trade-offs of each Gate adjustment. Columns 1 and 2 list the two Gate controls, and the varying degree of adjustment.
**Backing Color: Blue**

The following table illustrates the benefits and and trade-offs when using a Blue Backing Color.

<table>
<thead>
<tr>
<th>Gate 1/3</th>
<th>Gate 2</th>
<th>Benefits</th>
<th>Trade-Offs</th>
</tr>
</thead>
</table>
| 0%      | 0%     | - Removes Blue Spill while permitting some shades of blue to be reproduced in the foreground.  
          |        | - Allows BLUE to exceed GREEN by the amount GREEN exceeds RED. | - Unable to reproduce Magenta in foreground (or any shade of pink in which the Blue should exceed Green.) Magenta will be reproduced as Red.  
          |        |          | - Unable to remove blue spill from green foreground objects. |
| 100%    | 0%     | - Removes Blue Spill from Green foreground objects as well as all other foreground colors.  
          |        | - Limits BLUE to the LOWER of RED or GREEN. | - Unable to reproduce Cyan or Magenta in foreground.  
          |        |          | - Cyan will be reproduced as Green.  
          |        |          | - Magenta will be reproduced as Red. |
| 0%      | 100%   | - Permits reproduction of Magenta in the foreground (and any shade of Pink in which Blue exceeds Green).  
          |        | - Allows BLUE to exceed GREEN by the amount RED exceeds GREEN (or by the amount GREEN exceeds RED when RED is lower than GREEN. | - Will not remove Blue Spill from shades of Red in the foreground.  
          |        |          | - Will not completely remove Blue Spill from shades of Green in the foreground. |
| 100%    | 100%   | - Removes Blue Spill from shades of Green in the foreground.  
          |        | - Permits reproduction of Magenta in foreground.  
          |        | - BLUE is limited to the level of RED regardless of the level of GREEN. | - Cannot reproduce shades of Blue in the foreground.  
          |        |          | - Cyan will become Green.  
          |        |          | - Cannot remove Blue Spill from Red or Yellow. (Blue spill will desaturate Yellows.) |

**Backing Color: Green**

The following table illustrates the benefits and and trade-offs when using a Green Backing Color.

<table>
<thead>
<tr>
<th>Gate 1/3</th>
<th>Gate 2</th>
<th>Benefits</th>
<th>Trade-Offs</th>
</tr>
</thead>
</table>
| 0%      | 0%     | - Removes Green Spill while permitting some shades of Green to be reproduced in the foreground.  
          |        | - Allows GREEN to exceed BLUE by the amount BLUE exceeds RED. | - Unable to reproduce Yellow in foreground (or any shade of Brown in which the Green should exceed Blue). Yellow will be reproduced as Red.  
          |        |          | - Unable to remove Green Spill from Blue foreground objects. |
| 100%    | 0%     | - Removes Green Spill from Blue foreground objects as well as all other foreground colors.  
          |        | - Limits GREEN to the LOWER of RED or BLUE. | - Unable to reproduce Cyan or Yellow in foreground.  
          |        |          | - Cyan will be reproduced as Blue.  
          |        |          | - Yellow will be reproduced as Red. |
The following table illustrates the benefits and and trade-offs when using a Red Backing Color.

<table>
<thead>
<tr>
<th>Gate 1/3</th>
<th>Gate 2</th>
<th>Benefits</th>
<th>Trade-Offs</th>
</tr>
</thead>
</table>
| 0%       | 100%   | • Permits reproduction of Yellow in foreground (and any shade of Brown which Green exceeds Blue).  
|          |        | • Allows GREEN to exceed BLUE by the amount RED exceeds BLUE (or by the amount BLUE exceeds RED when RED is lower than BLUE). | • Will not remove Green Spill from shades of Red in the foreground.  
|          |        | • Will not completely remove Green Spill from shades of Purple in the foreground. |
| 100%     | 100%   | • Removes Green Spill from shades of Blue in the foreground.  
|          |        | • Permits reproduction of Yellow in foreground.  
|          |        | • GREEN is limited to the level of RED regardless of the level of BLUE. | • Cannot reproduce shades of Green in the foreground.  
|          |        | • Cyan will become Blue.  
|          |        | • Cannot remove Green Spill from Magenta or Red. (Green Spill will desaturate Magentas.) |

**Backing Color: Red**

The following table illustrates the benefits and and trade-offs when using a Red Backing Color.

<table>
<thead>
<tr>
<th>Gate 1/3</th>
<th>Gate 2</th>
<th>Benefits</th>
<th>Trade-Offs</th>
</tr>
</thead>
</table>
| 0%       | 0%     | • Removes Red Spill while permitting some shades of Red to be reproduced in the foreground.  
|          |        | • Allows RED to exceed GREEN by the amount GREEN exceeds BLUE. | • Unable to reproduce Magenta in foreground (or any shade of pink in which the Red should exceed Green.) Magenta will be reproduced as Blue.  
|          |        | • Unable to remove Red spill from Green foreground objects. |
| 100%     | 0%     | • Removes Red Spill from Green foreground objects as well as all other foreground colors.  
|          |        | • Limits RED to the LOWER of BLUE or GREEN. | • Unable to reproduce Magenta or Yellow in foreground.  
|          |        | • Magenta will be reproduced as Blue.  
|          |        | • Yellow will be reproduced as Green. |
| 0%       | 100%   | • Permits reproduction of Magenta in foreground (and any shade of Pink in which Red exceeds Green).  
|          |        | • Allows RED to exceed GREEN by the amount BLUE exceeds GREEN (or by the amount GREEN exceeds BLUE when BLUE is lower than GREEN). | • Will not remove Red Spill from shades of Blue in the foreground.  
|          |        | • Will not completely remove Red Spill from shades of Green in the foreground. |
| 100%     | 100%   | • Removes Red Spill from shades of Green in the foreground.  
|          |        | • Permits reproduction of Magenta in foreground.  
|          |        | • RED is limited to the level of BLUE regardless of the level of GREEN. | • Cannot reproduce shades of Red in the foreground.  
|          |        | • Yellow will become Green.  
|          |        | • Cannot remove Red Spill from Blue or Cyan. (Red Spill will desaturate Cyan.) |
Ultimatte Insider Operating Tips

Please note the following important points regarding the operation of the Ultimatte Insider option:

- When setting up the Ultimatte key, note that the Synergy’s CLIP and GAIN knobs are disabled when using the “Shaped Key”. Key adjustments are made through the Ultimatte menu options.

- In Input mode, up to eight (8) key sources can be associated with the group of physical inputs on the host Input Carrier Board. In this situation, when Chroma Key is pressed, the Ultimatte is automatically selected. If any other key source is selected and Chroma Key is pressed, Synergy’s standard Chroma Key Menu will appear.

- If you copy an Ultimatte keyer to a destination keyer that does not have an Ultimatte board associated with it, the system copies the key but sets up an Auto Select key (using the Ultimatte’s processed alpha and fill signals). In this situation, if you have not performed a panel button association with the Ultimatte output (as detailed in the section “Ultimatte Auto Select Key Setup” on page 12–10), the system fills the key with black.

- If you copy an Ultimatte keyer to a destination that does have an Ultimatte board association, and that destination keyer is also associated with the same group of physical inputs on the host Input Carrier Board as the copy source, the key copy operation is performed precisely to the new Ultimatte.

- If you copy a regular (non-Ultimatte) Chroma Key to a keyer with an Ultimatte installed, the result is a standard Chroma Key. Note that this is the only way to perform a standard Chroma Key on an Ultimatte keyer. To switch the keyer back to Ultimatte mode, select a different “Ultimatte” key source, or press Self Key and then press Chroma Key again. However, pressing the same source or pressing Chroma Key first will not change the mode — these are safe buttons.

Note
Remember that because the host Input Carrier Board has four slots for options, it is possible to associate more than one Ultimatte with the same group of inputs.
Dual Aspectizer

In This Chapter

This chapter provides instructions for operating the optional Dual Aspectizer, or simply, the Aspectizer. The following topics are discussed:

- Dual Aspectizer Option and Overview
- Dual Aspectizer Mode Descriptions
- Dual Aspectizer Mode Comparisons
- Dual Aspectizer Setup
- Input Mode Setup
- Input Mode Menus
- Input Mode Operation
- Bus Mode Setup
- Bus Mode Menus
- Bus Mode Operation
- Downstream Mode Setup
- Downstream Mode Menus

Refer to the following sections in Appendix C “Hardware Options” of the Synergy Series Installation Guide, for detailed Dual Aspectizer installation and setup instructions:

- “Dual Aspectizer Board Installation” section for instructions on physically installing the Aspectizer board on the Input Carrier Board.
- “Input Carrier Board Installation” section for instructions on physically installing the required Input Carrier Board.

Note: If you wish to upgrade your switcher to include this option, please contact Ross Video Technical Support for ordering information.
Dual Aspectizer Option and Overview

The **Dual Aspectizer** hardware option allows the user to perform live dual aspect ratio DTV production from a Synergy 1 panel. The **Aspectizer**, as it is more commonly referred to, dynamically converts the aspect ratio of a video signal in real time, *within* the switcher itself. Conversions can occur from 4:3 to 16:9 and vice-versa.

The **Dual Aspectizer Board** is a two-channel board capable of aspectizing either two independent BNC inputs or a “bus-pair” (for example, BKGD and PST bus) on the MLE.

Dual Aspect Production Overview

Now that DTV has become a reality, we have begun the transition from the traditional 4:3 world of production to the innovative 16:9 wide-screen world. Television can now take its rightful place beside motion picture film as an equal visual partner.

What is the best path to follow during the transition? Is it merely a question of continuing to produce with a 4:3 mindset and simply converting the picture to a 16:9 format or should we look at this as an opportunity to rethink our production concepts in general and explore how to best take advantage of the additional visual real estate?

Ultimately this is a production issue, not just a conversion issue. It will be management and the production people, from network executives, to station managers, to news directors, to senior producers who will decide how this new 16:9 “look” will be handled. As always has been the case in the past, the station engineers and technical personnel will be assigned the task of getting it to air.

If we chart the transition from one aspect ratio to the other, starting in today’s predominantly 4:3 production world and finishing several years from now as a predominantly 16:9 production world, the graph would look something like this:

![Graph of Aspect Ratio Production - Transition](image)

In the next few years, market and legislative pressures will drive the transition and compel the facilities to accelerate the change. Most places will phase in 16:9 production over a few years by first introducing a few 16:9 inputs into the production mix and converting them to 4:3. Then in a year or so, having the benefit of some experience with dual aspect ratio production, they will make a major change over to the 16:9 world.

However, some facilities will no doubt make the change all at once, changing from a 4:3 to a 16:9 production capability in one fell swoop. Some will offer dual aspect ratio outputs to feed separate transmitters, some will not. It will depend upon many factors, but however your facility decides to effect the change, we do know that the next few years of transition will be as exciting as they are challenging.
In order to make the transition as smooth as possible, each facility should begin the process by having a clearly defined vision of where they want to go in terms of the 16:9 world. Defining that vision has to start with the most important question of all:

**Question**

**What are your production goals?**

You have to have a strong, clear understanding of where you want to end up, so that you can develop a well thought out plan to get there. As part of defining your overall production goals, you’ll have to answer questions like:

- What are the expectations management?
- How do they want you to operate?
- What do you want your “look” to be?
- Are you an affiliate?
- Do you have to fit into the style of a network?
- How long do you have to make the transition?
- Will you be feeding one transmitter or two?

And once some of these big picture questions have been asked, you will need to get into the more subtle technical questions like:

- How many inputs are there with a different aspect ratio?
- Do you want to do memory recalls that involve aspect ratio manipulation?
- Should I operate in Input Mode or Bus Mode or Downstream Mode?

The answers to these and a host of other questions will provide you with a framework to plan a cost effective and orderly transition into a new era of production.
Dual Aspectizer Mode Descriptions

Each facility has its own unique set of parameters that will dictate its method of operation in the dual aspect ratio world. Although there are as many different ways to operate with dual aspect ratios as there are facilities, for the sake of this discussion, we have grouped them into four main categories:

1. Single Output Production – Input Mode
2. Single Output Production – Bus Mode
3. Dual Output Production – Downstream Mode
4. Dual Output Production – With Extra Content

The following examples use a Synergy 4 to illustrate the different configurations, however, each of the setups described can be applied to any one of the Synergy family of switchers. As well, the words *primary* and *secondary* are used to describe the two outputs when a dual output situation is illustrated. These words are for description purposes only and are not meant to represent a priority of one over the other. Likewise, whenever an aspect ratio is defined, it is used as an example to illustrate one situation. The example would be just as appropriate if the aspect ratios were reversed.

Finally, the term **Aspectizer look** or simply **look** is used to describe the different visual possibilities available when 4:3 video is converted to 16:9 or vise versa (for example, Letterbox, Pillarbox, etc.). A full description of the different **looks** follow later in the chapter.

If your situation does not fit exactly into one of our examples and you have questions about how you would like your facility to operate, please call your Ross Video service representative for assistance.

**Single Output Production – Input Mode**

This method of operation is characterized by a single PGM output, which is the same aspect ratio as the MLEs and most of the inputs. However, one or two of the inputs have a different aspect ratio from the rest. These are sent to the **Aspectizer**, converted to the aspect ratio of the output, given an aspectized **look** and then typically, but not always, remain unchanged during the course of the production.

In the above configuration, the **Aspectizer** would be setup in **Input Mode**.

A complete description of how to setup and operate your switcher in **Input Mode** is discussed later on in this chapter.
Single Output Production – Bus Mode

This method of operation is characterized by a single PGM output, which is the same aspect ratio as the MLEs. However, in this example, a number of inputs have aspect ratios that are different than the MLEs. In this case, each bus-pair (usually the BKGD and PST bus) on each MLE is sent to an Aspectizer in what is called Bus Mode. Then whenever a crosspoint is selected on any MLE, a comparison of the aspect ratio of the input and the MLE is done and if they are the same, the signal is passed through the Aspectizer without any change. Subsequently, if the aspect ratios are different, the Aspectizer becomes active and the signal is aspectized as per the predetermined look selected.

A complete description of how to setup and operate your switcher in Bus Mode is discussed later on in this chapter.

Dual Output Production – Downstream Mode

This method of operation is characterized by dual outputs – the primary (4:3) from the PGM out and the secondary (16:9) from an Aux Bus out. However, like the first example, the MLEs and the inputs have the same aspect ratios for the most part, with the exception of one or two inputs which are different. These are sent to the Aspectizer, converted to the aspect ratio of the primary output, given an aspectized look and then typically, but not always, remain unchanged during the course of the production.

The secondary output (16:9) on the other hand, is simply an aspectized version of the primary. This is accomplished by using the second PGM output from the bottom MLE of your switcher, feeding it back in via an input BNC, which in turn is directed to an Aspectizer in Downstream Mode. The output of this Aspectizer is subsequently selected on an Aux Bus, which is then used as a 16:9 PGM output. In effect, it could be thought of as aspectizing the primary PGM output downstream.

One of the main advantages of this mode is that the TD has complete internal control over the aspectized look of the output, since like the other modes, all of the aspectizing is being done inside the switcher.
A complete description of how to setup and operate your switcher in **Downstream Mode** is discussed later on in this chapter.

**Dual Output Production – With Extra Content**

This method of operation is also characterized by dual outputs. In this case, we have defined **MLE3** out as the primary (4:3) and the **MLE4 out (PGM)** as the secondary (16:9). **MLEs1, 2 and 3** would use either **Input** or **Bus Mode** to aspectize the inputs, depending upon the number that required aspectization. **MLE4** is then aspectized in **Bus Mode** and the **Aspectizer look** is set to **Pillarbox**. The remainder of the frame, the two side panels, are filled with additional information such as weather reports, or station ID, or sports scores, or advertisements, or some other extra content. In this configuration, the **Aspectizer** for **MLE4** would be set and not changed during production. The program would be switched on **MLE3**, which would then be selected as a re-entry on **MLE4**. The additional content would be added as a downstream key and fed from a computer or some other similar device.

A complete description of how to setup and operate your switcher in **Bus Mode** is discussed later on in this chapter.
Dual Aspectizer Mode Comparisons

As part of the planning process for dual aspect ratio production, there are several other questions that need to be addressed in order to decide whether your facility should operate in Input Mode, Bus Mode or Downstream Mode. The right choice will ultimately depend upon your particular set of circumstances.

The following points will not make the choice for you but will outline some of the considerations that should be taken into account as you go through the decision making process.

Input Mode

- Each input that is assigned to an Aspectizer is aspectized on each bus of each MLE – in other words, vertically.
- Used for both single and dual aspect ratio output production.
- Each Aspectizer will aspectize two inputs independently, on two separate channels.
- Each aspectized input retains its own unique characteristics.
- Since the Aspectizer settings in Input Mode are stored in Personalities, individual Aspectizer settings do not follow in Memory Recalls.
- The inputs that are assigned to the Aspectizer in Input Mode must come from one of the eight BNC inputs associated with the Input Carrier Board on which that particular Aspectizer is installed.
- Aux Buses are not required for Input Mode.
- Additional cabling is not required for Input Mode.
- Input Mode is usually used when the number of inputs requiring aspectization is less than 2 times the number of MLEs on your switcher. In other words, Input Mode is usually used when there are less than 4 inputs requiring aspectization for a Synergy 2, less that 6 inputs for a Synergy 3 and less than 8 inputs for a Synergy 4.
Bus Mode

- Each input on a bus-pair that is assigned to an Aspectizer is aspectized along one MLE – in other words, horizontally.
- Used for both single and dual aspect ratio output production.
- **Bus Mode** links two buses together on an MLE to create a bus-pair.
- Each bus-pair shares the same Aspectizer characteristics.
- Since the Aspectizer settings are stored to Memories in **Bus Mode**, the setups can be used in Memory Recalls.
- Any bus-pair on any MLE can be assigned to an Aspectizer in **Bus Mode**.
- Two **Aux Buses** are required for each MLE that is aspectized in **Bus Mode**.
- Two inputs are required from the eight associated with the Input Carrier Board on which the Aspectizer is installed.
- Additional cabling is required to feed back the **Aux Buses** into the Input Carrier Board.
- **Bus Mode** is usually used when the number of inputs requiring aspectization is greater than two times the number of MLEs on your switcher. In other words, **Bus Mode** is usually used when there are more than 4 inputs requiring aspectization for a Synergy 2, more than 6 inputs for a Synergy 3 and more than 8 inputs for a Synergy 4.
Downstream Mode

- Only used for dual aspect ratio output configurations.
- Can be used in conjunction with either Input or Bus Mode.
- In effect, aspectizes a PGM output downstream.
- Has no effect on any input or any MLE during the production process.
- One Aux Bus and one input BNC is required.
- Additional cabling is required to feed back the bottom MLE PGM output into a BNC input.

Conclusion

The rest of this chapter deals with the operation of your Aspectizer. However, before you continue, do yourself a favor and make sure that everyone in your production facility truly understands the benefits that can be gained with a well thought out transition plan. Take the time to think about tomorrow’s requirements. Make an informed decision as to which of the output production formats will best serve your operational requirements in the years to come, because if you are not sure today where you are going, you’ll never know when you get there.
Dual Aspectizer Setup

Before the Dual Aspectizer option will function properly, the following steps must be completed. Refer to Chapter 4, “Preliminary Video Installation” and Chapter 6, “BNC Configuration and Check” of the Synergy Series Installation Guide for detailed instructions on how to:

1. **Connecting and Verifying Inputs** – a complete explanation of how to connect the physical switcher inputs, including reference, video and alpha.
2. **Set up BNC Types** – a complete explanation of how to associate each physical BNC connector with an input type.
3. **Set Up Panel Buttons** — a complete explanation of how to map each BNC connector to a physical button on the control panel.
4. **Set Up Aspect Ratios** – a complete explanation of how to setup the native aspect ratios of a BNC input and an MLE output.

Configuring the Aspectizer for Operation

After the switcher inputs and outputs have been configured as described above, you must define the following:

- Where the Aspectizer Board is physically located
- What mode it is in
- Which BNCs or buses to aspectize

There are two softkeys on the Option Cards Menu:

- The **Ultimatte** softkey will take you into the Ultimatte Setup Menus.
- The **Upgrade Aspectizer** softkey is used for upgrading the Aspectizer to version 2.0 firmware. Refer to the section, “Upgrading Dual Aspectizer Boards” of the Synergy Series Installation Guide, for details.

Use the following procedure to configure each Aspectizer for operation:

1. Ensure that the Aspectizer is properly installed, and properly recognized by the system.
2. Navigate to the Option Cards Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Option Cards.
3. Press Aspectizer to display the Option Cards – Aspectizer Menu.
4. Use the **Aspectizer Channel** knob to select the BNC or bus to be aspectized.

5. Use the **Mode** knob to select one of four operational modes for the **Aspectizer** – **Input, Bus, Downstream** or **Not In Use**.

   ~ Use the **Not In Use** mode to *turn off* a specific **Aspectizer**.

This completes the procedure to configure each **Aspectizer** for operation.
Input Mode Setup

In **Input Mode**, the user assigns two input BNCs to the dual channel **Aspectizer**. The BNCs are treated independently throughout the switcher. When either input is selected on any bus of any MLE, its aspect ratio is compared to that of the MLE, and if different, is sent through the **Aspectizer**. In other words, in **Input Mode** an input is aspectized *vertically* through all buses.

All information and values associated with an **Aspectizer** in **Input Mode** are stored in the **Personality Registers** of the switcher.

**Input Mode Setup**

Use the following procedure to configure the **Aspectizer** in **Input Mode**:

1. Enter the **Aspectizer Setup Menu**, as described in the previous section.

```
Option Cards  Aspectizer Channel:  Carr#  Sock#A  Sock#B
This menu lets you decide how your Aspectizer will work.  Mode:  Not In Use
Input  Bus
BNC:  BNC 7  (7)  BNC 8  (8)

Ultimatte Aspectizer
Upgrade Aspectizers
```

2. Use the **Aspectizer Channel** knob to select the **Aspectizer Board** that you want to define. Each channel of the **Aspectizer Board** is defined by its host **Input Carrier Board** number – Carr# and Socket number – Sock#A and Sock#B.

3. Use the **Mode** knob to select **Input**. Selecting **Input** will change the bottom knob to **BNC**.

4. Use the **BNC** knob to assign a BNC to the channel selected in Step 2. Note that only the BNC inputs associated with that particular **Input Carrier Board** will be available for selection.

5. Repeat steps 2 through 4 for the second channel (Sock#B) of the **Aspectizer**. If you are installing more than one **Aspectizer** in **Input Mode**, repeat steps 1 through 4 for each board.

In the previous example, note that the **Aspectizer** is installed on **Input Carrier Board** #3, **Socket** #2 and that **Film** (BNC 17), has been assigned to channel **A**.

This completes the **Aspectizer** setup procedure for **Input Mode**.
Input Mode Menus

Dealing with inputs having different aspect ratios adds a new dimension to the TDs already hectic life. This is especially true when an input is being fed from a router or some other device that can send signals with different aspect ratios. The Aspectizer option provides the flexibility and ease of operation that is critical to the success of your production.

**Input Mode** is most often used when the aspect ratio of your inputs and your MLEs are largely the same, but with a few exceptions. These different inputs are sent to the Aspectizer, setup with an aspectized look and typically, but not always, neither the look nor the aspect ratio are changed during the course of the production. However, there is provision for an easy change of aspect ratio when the situation arises using the **Input Ratio 16:9/4:3** toggle. This will be discussed later in the chapter.

Use the following procedure to navigate through the Aspectizer Menus:

1. Navigate to the Select Aspectizer Menu as follows:
   - Press **HOME** ⇒ **Effects** ⇒ **Aspectizer**.

2. Use the knob to highlight the input that you wish to select

3. Press **Modify**. Note that only the inputs that have previously been configured for an Aspectizer will be displayed.

4. One of the two following menus will display depending upon the relationship of the input and the MLE aspect ratios.
   - If the aspect ratios of the input and the MLE are the same, the **Same Aspect Ratios Menu** is displayed.

**Operating Tip**

*Double press* the input that you wish to select. However, if the Aspectizer Menu is displayed a *single press* will change the display. To change the default speed of the double press function, refer to the Synergy Series Installation Guide.
The menu indicates that the Aspectizer is in Input Mode.

~ The main body of the menu displays two boxes. The box on the left represents the input. The name of the input is beneath the box with its aspect ratio displayed inside the box.

~ An arrow joins the boxes with the word OFF above the line, indicating that the Aspectizer is not active.

~ The MLE number that the input is selected on is displayed to the right. The aspect ratio of the MLE is displayed inside the box.

• If the aspect ratios of the input and the MLE are different, the Different Aspect Ratios Menu is displayed.

<table>
<thead>
<tr>
<th>Aspectizer in Input Mode</th>
<th>Letterbox</th>
</tr>
</thead>
<tbody>
<tr>
<td>16:9  ON 4:3 MLE3</td>
<td>L:9</td>
</tr>
</tbody>
</table>

~ The menu indicates that the Aspectizer is in Input Mode.

~ The main body of the menu will display two boxes. The box on the left represents the input. The input’s name is beneath the box and its aspect ratio is displayed inside the box.

~ Next to the input box is an arrow pointing from left to right. Since the aspect ratios of the input and the MLE are not the same, the arrow is animated (moving from left to right) with the word ON above the line. This indicates that the Aspectizer is active on that MLE and the input video is being processed.

~ To the right of the arrow is a box that displays the aspect ratio of the MLE that the input is selected on. The MLE number is beside the box.

~ Inside the large box is a graphical representation of the Aspectizer look that is presently selected and being applied to the input.

5. Change the define aspect ratio of the input as follows:

• Toggle Input Ratio between 16:9 and 4:3 toggle.

• The aspect ratio of the selected input is highlighted in reverse lettering. Pressing this softkey toggles or changes the defined aspect ratio of the input. This in turn will change all of the input/MLE relationships and change the display.

6. Press the Aspectizer Look softkey to display the different looks available in each aspect ratio configuration. The looks are displayed in the scroll area of the menu.
Aspectizer Looks

- In all, there are seven looks to choose from, depending on the combination of input and output aspect ratios. They are selectable by rotating the top knob.

- Six of these looks can be repositioned on screen, either vertically or horizontally depending on the look. These movable looks are Letterbox, Pillarbox, the two Pan and Scan looks, and the two 14:9 looks (one each for 16:9 to 4:3 aspect ratio, and one each for 4:3 to 16:9 aspect ratio).

- Use the Position knob to move the aspectized output, as desired.

- Use the top knob to select a look as follows:
  ~ Full Screen — Select this option to have the input passed through the Aspectizer without making any change to the video.

  Selecting Full Screen when the input and MLE aspect ratios are different will produce a distorted picture.

  4:3 and 16:9 Full Screen

  ~ Letterbox — This is the default look for a 16:9 input signal that is selected on a 4:3 MLE.

  4:3 Letterbox

  ~ Pillarbox — This is the default look for a 4:3 input signal that is selected on a 16:9 MLE.

  16:9 Pillarbox
~ **Pan and Scan** — This look can be applied to either a 16:9 signal that is selected on a 4:3 MLE, or a 4:3 input that is selected on a 16:9 MLE.

![Pan and Scan Diagram]

~ **14:9** — This look can be applied to either a 16:9 signal that is selected on a 4:3 MLE, or a 4:3 input that is selected on a 16:9 MLE. The **14:9 look** is a compromise between a Letterbox or Pillarbox and a Pan and Scan.

![14:9 Diagram]

~ **14:9 Wide** — This look can be applied to a 4:3 input that is selected on a 16:9 MLE. The **14:9 Wide look** displays the same image as **14:9**, but eliminates the black pillars at the left and right by expanding the image horizontally so it fills the screen.

![14:9 Wide Diagram]

~ **14:9 Tall** — This look can be applied to a 16:9 input that is selected on a 4:3 MLE. The **14:9 Tall look** displays the same image as **14:9**, but eliminates the black panels at the top and bottom by expanding the image vertically so it fills the screen.

![14:9 Tall Diagram]

7. Toggle **Superblack** between **On** and **Off** as follows:
   - Some of the Aspectizer looks have portions of the screen that are not filled with video from either signal, such as the Letterbox and Pillarbox options. You have the option of filling these areas with Superblack or any color.
   - The default is black.
   - Toggling the **Superblack On/Off** to **Off** adds the Bkgd Color softkey.
8. Adjust the Aspectizer Background Color as follows:

- Press **Bkgd Color** to display the **Color Selection Menu**.

- Notice that there is a menu sub-title that defines the menu as the **Aspectizer Background Color**.

- The color can be adjusted in either RGB or HSL space by pressing the corresponding softkey and rotating the knobs on the right.

9. Toggle **Asp Pass cap** between **On** and **Off** as follows:

- The **Asp pass cap** softkey is a toggle button for use when passing video with closed captioning through a **Dual Aspectizer Board** as follows:
  - **On** — When **Asp pass cap** is set to **On**, the video signal passes through the **Dual Aspectizer** while the line of closed captioning is routed around it. This path prevents distortion of the closed captioning. This is the default setting.
  - **Off** — When **Asp pass cap** is set to **Off**, the video signal is passed through the Aspectizer in the normal manner. This setting should be used when the video signal that you are “aspectizing” does not have a line of closed captioning inserted.

For information on the **Dual Aspectizer** option, refer to Appendix C, “**Hardware Options**” of the **Synergy Series Installation Guide**.

**Notes on Aspectizer Looks**

Please note the following important points regarding **Aspectizer looks**:

- If the **MENU** button in the **Positioner Group** is lit, the **joystick** can be used to control the vertical and horizontal movement of the image.

- Pressing the **CENTER** button in the **Positioner Group** will restore a repositioned image to its default position.
**Input Mode Operation**

When operating in **Input Mode**, the most important thing to remember is that each input that is being sent to the **Aspectizer** is aspectized on each bus, of each MLE. In other words, you can think of **Input Mode** as being *vertical* in nature.

Whenever a designated input is selected on any bus, a comparison of the aspect ratio of the input and the MLE takes place. When they are the same, the input’s signal is passed through the **Aspectizer** without any change. When the aspect ratios are different, the **Aspectizer** becomes *active* and the operator is given the opportunity to change various characteristics of the image.

Keeping track of what is on air, on which MLE, with which *look*, can be challenging to even the most experienced TD. To help you keep track of all the possibilities, **warnings** have been built into the menus, thus reducing the potential for on air mistakes.

**Warnings – General Rules**

**Rule 1**

A **warning** will display when the selected input is on air anywhere in the switcher.

**Rule 2**

A **warning** will specify the MLE(s) that the input is actually selected upon.

There are two different kinds of warnings:

1. A **warning** will be displayed whenever any change to the **Aspectizer’s** characteristics (look, BKGD color, or Superblack) will affect an on air MLE, and/or
2. A **warning** will be displayed whenever a change to an input’s aspect ratio will affect an on air MLE.

Since the configuration of a switcher at any one time can be so diverse, the best way to explain **Input Mode** operation is to look at a few examples.
Single Output Production – Input Mode

The assumptions for the examples that follow are:

- The switcher is a Synergy 4.
- All inputs are defined as having a 4:3 aspect ratio, with the exception of Film and Router.
- Film (BNC 17) is defined as having a 16:9 aspect ratio.
- Router (BNC 20) can be a 4:3 or a 16:9 aspect ratio, depending upon its source.
- Film has been assigned to channel A of the Aspectizer in Input Mode.
- Router has been assigned to channel B of the Aspectizer in Input Mode.
- All MLEs are defined as having a 4:3 aspect ratio.
- MLE 3 is defined as always on air.

Example 1.1

In this first example, Film (BNC 17) is selected on the BKGD bus of MLE1. Remember that a single press of the crosspoint selects the input on the switcher but the Aspectizer menu is not already up, it will only be displayed when you double press the input or follow the path to the Aspectizer through the menu tree.

The menu displays the fact that the Aspectizer is in Input Mode and is active, since the aspect ratios of Film and MLE1 are different. This is noted by the animated arrow between the 16:9 box of Film.
and the 4:3 box of MLE1. As well, the word ON is displayed above the line. The Aspectizer look is Pan and Scan and is applied to a 16:9 signal that is selected on a 4:3 MLE.

There are no warnings in this case because Film is not selected on any on air MLE. However, consider this:

With Film still selected on the BKGD bus of MLE1, and if MLE1 is then selected as a re-entry on the PGM bus of MLE4, thus taking it to air, the following warning message is displayed:

The warning message indicates that Film is presently selected on MLE 3, which is on air, and any change to the Aspectizer, such as input aspect ratio, look or BKGD color, will affect the on air image.

**Example 1.2**

In this second example, Router is selected on the PST bus of MLE2 in order to preview the video.

**Note**

The menu in Input Mode does *not* indicate whether an input is selected on the BKGD or PST bus.
The menu displays the fact that the Aspectizer is in Input Mode. This time the Aspectizer is not active, since the aspect ratios of the input (Router) and the MLE are the same.

However, imagine that upon viewing the preview it is discovered that the Router input is now sending a 16:9 signal. Toggling or changing the aspect ratio to 16:9 will produce the following menu.

Press the Aspectizer Look softkey, and change the look to Pan and Scan by rotating the top knob on the right. The menu will change to the following example:
There are no warnings because **Router** has not been selected directly or indirectly through re-entry on MLE3, the on-air MLE.

But continuing with our example:

Now that **Router** has been previewed and set up, if it is taken to air directly on the **PGM** bus of MLE4, the following menu is displayed:

The **warning message** indicates that the **Router** is selected on MLE4, and any change to the **Aspectizer**, such as input aspect ratio, look or BKGD color, will happen on air.
If **Router** is selected on the **BKGD** bus of MLE2 and this time taken to air as a re-entry instead of directly on the **PGM** bus of MLE4, the following menu is displayed:

**Input Mode Example 1.2D – Setup**

The **warning message** indicates that the **Router** is selected on MLE2, and any change to the **Aspectizer**, such as aspect ratio, look or BKGD color, will happen on air.

**Input Mode Example 1.2D – Operation**
Bus Mode Setup

In **Bus Mode**, the user assigns a bus-pair on a specified MLE to the **Aspectizer**. Each bus of the pair feeds an **Aspectizer** channel. Usually it is the **BKGD** and **PST** buses (the **PGM** and **PST** buses on the bottom MLE). However, the respective fill and alpha channels of **Key1** or **Key2** also constitute a bus-pair and can be assigned as the two inputs.

All information and values associated with an **Aspectizer** in **Bus Mode** are stored in the switcher’s **Memory Registers**, with the exception of the **16:9/4:3 toggle** information, which is stored in the **Personality Registers**.

**Bus Mode Setup**

The **Aspectizer Setup Options Menu** allows you to configure your **Aspectizer** and defines:

- Where the **Aspectizer Board** is physically located;
- What mode it is in; and
- Which buses you wish to aspectize.

Use the following procedure to configure the **Aspectizer** in **Bus Mode**.

1. Ensure that the **Aspectizer** is properly installed and recognized by the system.
2. Navigate to the **Aspectizer Setup Options Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **MORE** ⇒ **Option Cards** ⇒ **Aspectizer**.
3. Use the **Aspectizer Channel** knob to select the channel that you want to define. Each channel of the **Aspectizer** is defined by its host **Input Carrier Board** number – **Carr#**, and **Socket** number – **Sock#A** and **Sock#B**.
4. Use the **Mode** knob to select **Bus**. Selecting **Bus** will change the bottom knob to **Bus**.
5. Use the **BUS** knob to select the **MLE** and the bus-pair that you wish to aspectize. Note that for each MLE there are three bus-pairs as setup choices for channel A and B of the **Aspectizer**:
   - **BKGD+PST** buses (**PGM+PST** on the bottom MLE)
   - **Key1**, which includes both the fill and alpha channels, and
   - **Key2**, which includes both the fill and alpha channels.
6. Repeat for each **Aspectizer** installed in **Bus Mode**.
In the above example, note that the Aspectizer is installed on Input Carrier Board #8, Socket #4 and that the BKGD and PST buses on MLE1 have been assigned to channel A and B.

**Note**

At this point, we have completed a partial Bus Mode setup. The 8 inputs associated with the Input Carrier Board (in this example BNC 57 – BNC 64) are being routed through the Aspectizer and when selected on either the BKGD or PST buses of MLE1 will be aspectized. However, it is more common to continue on and complete the Bus Mode setup as follows.

Two Aux Buses are required for Bus Mode operation. These Aux Buses must be “fed back” into any two of the BNC inputs associated with the Input Carrier Board on which the Aspectizer is installed. In turn, these Aux Buses become unavailable for any other use. As an example, the following figure illustrates the connection.

On the rear of the Synergy frame, connect two untimed Aux Bus outputs to the two BNC inputs using industry standard coaxial cable.

You must now tell the system which Aux Buses feed back into the switcher. This is accomplished in the Aux Bus Menu. For a comprehensive explanation of Aux Bus Setup parameters and options, refer to Chapter 9, “Additional Installation Setups” in the Synergy Series Installation Guide.

Use the following procedure to select which Aux Buses feed back into the switcher:

1. Navigate to the Aux Bus Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus.
2. Press Local Panel to define the mode for the Aux Buses.

This menu allows you to assign specific switching parameters or “rights” for each of the 12 Aux Buses that are accessible in the Aux Bus Assign Group. Each Aux Bus can be set up individually.
3. Use the **Aux Bus** knob to select the **Aux Bus** number that you wish to assign.

4. Use the **Mode** knob to select **Bus Follow**. The **Bus Follow** mode directs the **Aux Bus** to follow the user’s selections on a specified MLE and bus.

**Note**

In **Bus Follow** mode, the user is “locked out” of the designated **Aux Bus** and cannot make selections on the **Aux Bus** panel itself.

5. Repeat steps 3 and 4 for the second **Aux Bus** that you wish to assign.

This completes the procedure to select which **Aux Buses** feed back into the switcher. In the next step, you must tell the switcher which bus, on which MLE, you want the **Aux Bus** to follow.

Use the following procedure to select which bus you want the Aux Bus to follow:

1. Press the **Bus Follow Assign** button in the **Aux Bus Menu 1-2** to display the **Bus Follow Menu**.

2. Press **Bus Assign** to display the **Aux Bus Assign Menu**. The aux buses that have previously been designated as being in **Bus Follow** mode. In keeping with our example, we have assigned **Aux Bus #2** and **Aux Bus #6** to **Bus Follow**.

3. Use the **Aux Bus** knob to select the **Aux Bus** number that you wish to assign to an MLE.

4. Use the **MLE** knob to select the MLE. Only the MLE numbers associated with your particular switcher will be displayed.

5. Use the **Bus** knob to select the actual **Bus** that you want the **Aux Bus** to follow.

6. Repeat for the second **Aux Bus** number.

This completes the procedure to select which bus you want the Aux Bus to follow. The final step in configuring your **Aspectizer** in **Bus Mode** involves assigning or routing the **Aux Bus** back into the appropriate **BNC** input.
Use the following procedure to assign the Aux Bus to a BNC input:

1. Press **BNC Assign** to display the **BNC Assign Menu**.

   ![Bus Follow – BNC Assign Menu](image)

   **Bus Follow – BNC Assign Menu**

   2. Use the **Aux Bus** knob to select the **Aux Bus** that you wish to route back into an input. Only the previously assigned **Aux Buses** will be available for selection.

3. Use the **BNC** knob to select the **BNC** input that will accept the **Aux Bus** as its source. In the case of our example, we chose **Aux Bus #2** to feed back into **BNC 63** and **Aux Bus #6** to feed back into **BNC 64**.

4. Repeat for the other **Aux Bus**.

This completes the **Aspectizer** setup procedures for **Bus Mode**.
Bus Mode Menus

**Bus Mode** typically is used when you have a number of inputs with aspect ratios different from that of the PGM out and you want to have those inputs aspectized with a common look and then forget about them. In this case, once the switcher is configured properly, the TD will not have to worry about aspectization and can devote time to the task at hand.

In **Bus Mode**, the bus-pairs are setup initially with an aspectized look and normally, would not be changed during the course of the production. However, there is provision for an easy change of an input’s aspect ratio when the situation arises using the 16:9/4:3 toggle. This will be discussed later in the chapter.

Use the following procedure to enter the operational **Aspectizer Menu**:

1. Navigate to the Select Aspectizer Menu as follows:
   - Press HOME ⇒ Effects ⇒ Aspectizer.

   ![Select Aspectizer Menu](image)

   **Select Aspectizer Menu**

   - You can also double press the input that you wish to select on one of the buses on the aspectized bus-pair. However, if the Aspectizer Menu is already up, a single press will change the display. If you would like to change the default speed of the double press function, refer to the Synergy Series Installation Guide.

   - Use the top knob to highlight the bus-pair that you wish to select, and
   - Press **Modify**. Note, only the bus-pairs and/or inputs that have previously been configured for an Aspectizer will be displayed.

2. One of the two following menus will be displayed, depending upon the relationship of the input and the MLE aspect ratios:
   - If the aspect ratios of the input and the MLE are the same, the Same Aspect Ratios Menu is be displayed:
The menu indicates that the Aspectizer is in Bus Mode.

Underneath the title, the MLE number and the bus that the input is selected upon is displayed.

The main body of the menu will display two boxes. The box on the left represents the input. The input’s name is beneath the box and its aspect ratio is displayed inside the box.

An arrow joins the boxes with the word OFF above the line, indicating that the Aspectizer is not active.

The MLE number that the input is selected on is displayed to the right. The aspect ratio of the MLE is displayed inside the box.

If the aspect ratios of the input and the MLE are different, the Different Aspect Ratios Menu is displayed:

The menu indicates that the Aspectizer is in Bus Mode.

Underneath the title, the MLE number and the bus that the input is selected upon is displayed.

The main body of the menu has expanded to include some additional information. The box on the left represents the input. The input’s name is beneath the box and its aspect ratio is displayed inside the box.

The MLE number and the bus the input is selected on is displayed in front of the box.

Next to the input box is an arrow pointing from left to right. Since the aspect ratios of the input and the MLE are not the same, the arrow is animated (moving from left to right) with the word ON above the line. This indicates that the Aspectizer is active on that MLE and the input video is being processed.

To the right of the arrow is a box that displays the aspect ratio of the MLE that the input is selected on. The MLE number is beside the box.
Inside the large box is a graphical representation of the Aspectizer look that is presently selected and being applied to the input.

3. Change the defined aspect ratio of the input as follows:
   - Toggle Input Ratio between 16:9 and 4:3.
   - The aspect ratio of the selected input is highlighted in reverse lettering. Pressing this softkey toggles or changes the defined aspect ratio of the input. This in turn will change all of the input/MLE relationships and change the display.

4. Press the Aspectizer Look softkey to display the different looks available in either aspect ratio configuration. The looks are displayed on the right hand side of the menu.

- In all, there are seven looks to choose from, depending upon the particular combination of input and output aspect ratios. They are selectable by rotating the top knob. Six of these looks can be repositioned on screen, either vertically or horizontally depending on the look. These movable looks are Letterbox, Pillarbox, the two Pan and Scan looks, and the two 14:9 looks (one each for 16:9 to 4:3 aspect ratio, and one each for 4:3 to 16:9 aspect ratio). Use the bottom Position knob to move the aspectized output, as desired.

- Select a look as follows:
  - **Full Screen** — Select this option to have the input passed through the Aspectizer without making any change to the video.

  ![4:3 and 16:9 Full Screen](Note: Selecting Full Screen when the input and MLE aspect ratios are different will produce a distorted picture.)

  - **Letterbox** — This is the default look for a 16:9 input signal that is selected on a 4:3 MLE.
~ Pillarbox — This is the default look for a 4:3 input signal that is selected on a 16:9 MLE.

~ Pan and Scan — This look can be applied to either a 16:9 signal that is selected on a 4:3 MLE, or a 4:3 input that is selected on a 16:9 MLE.

~ 14:9 — This look can be applied to either a 16:9 signal that is selected on a 4:3 MLE, or a 4:3 input that is selected on a 16:9 MLE. The 14:9 look is a compromise between a Letterbox or Pillarbox and a Pan and Scan.

~ 14:9 Wide — This look can be applied to a 4:3 input that is selected on a 16:9 MLE. The 14:9 Wide look displays the same image as 14:9, but eliminates the black pillars at the left and right by expanding the image horizontally so it fills the screen.

~ 14:9 Tall — This look can be applied to a 16:9 input that is selected on a 4:3 MLE. The 14:9 Tall look displays the same image as 14:9, but eliminates the black panels at the top and bottom by expanding the image vertically so it fills the screen.
5. Toggle Superblack between On and Off as follows:
   • Some of the Aspectizer looks, such as Letterbox, and Pillarbox, have portions of the screen that are not filled with video from either signal. You have the option of filling these areas with Superblack or any color.
   • The default is black.
   • Toggling Superblack On/Off to Off adds the Bkgd Color softkey as follows:

   ![Superblack On/Off Menu]

6. Adjust the Aspectizer Background Color as follows:
   • Press Bkgd Color displays the Color Selection Menu.

   ![Aspectizer Background Color — Color Selection Menu RGB]

   • Notice that there is a menu sub-title that defines the menu as the Aspectizer Background Color.
   • The color can be adjusted in either RGB or HSL space by pressing the corresponding softkey and rotating the knobs on the right.

This completes the procedure to enter the operational Aspectizer Menu.

**Notes on Aspectizer Looks**

Please note the following important points regarding Aspectizer looks:

• If the MENU button in the Positioner Group is lit, the joystick can be used to control the vertical and horizontal movement of the image.
• Pressing the CENTER button in the Positioner Group will restore a repositioned image to its default position.
• In Bus mode, repositioned Aspectizer looks can be saved as memories, and recalled using the Effects Dissolve feature.
• In Bus mode, repositioned Aspectizer looks can be saved to a storage device.
**Bus Mode Operation**

When operating in full **Bus Mode**, the most important thing to remember is that every crosspoint on the designated bus-pair is being sent to the Aspectizer. (When operating in modified **Bus Mode**, only the eight inputs associated with the specific Input Carrier Board are available for aspectization). In other words, you can think of **Bus Mode** as being horizontal in nature.

Whenever an input is selected on an MLE that is configured in **Bus Mode**, a comparison of the aspect ratio of the input and the MLE takes place. When they are the same, the input’s signal is passed through the Aspectizer without any change. When the aspect rates are different, the Aspectizer becomes active and the operator is given the opportunity to change various characteristics of the image.

Keeping track of what is on air, on which MLE, with which look, can be challenging to even the most experienced TD. To help you keep track of all the possibilities, **warnings** have been built into the menus, thus reducing the potential for on air mistakes.

**Warnings – General Rules**

**Rule 1**

The following **warning** will be displayed if the selected input is contributing to on air:

Toggling the input’s aspect ratio will affect On Air MLE”X”.

**Rule 1**

The following **warning** will be displayed if the Aspectizer is contributing to on air:

Aspectizer changes will affect On Air MLE”X”.

Since the configuration of a switcher at any one time can be so diverse, the best way to explain **Bus Mode** operation is to look at a few examples.
Single Output Production – Bus Mode

The assumptions for the examples that follow are:

- The switcher is a Synergy 4.
- Each BKGD (PGM) and PST bus on each MLE has been assigned to an Aspectizer in Bus Mode.
- All inputs are defined as having a 4:3 aspect ratio, with the exception of Cam 3 (BNC 4), VTR Red (BNC 5), Server 1 (BNC 13), Line (BNC 14), Film (BNC 17), Router (BNC 20), ISO Red (BNC 24) and Network (BNC 31) which are 16:9.
- All MLEs are defined as having a 4:3 aspect ratio.
- MLE3 is defined as always on air.

Example 1.1

In this example, VTR Red (BNC 5) is selected on the BKGD bus of MLE1. Remember that a single press of the crosspoint selects the input on the switcher but if the Aspectizer menu is not already up, the menu will only be displayed when you double press the input or follow the path to the Aspectizer through the menu tree.

Bus Mode Example 1.1 – Switcher Setup

Bus Mode Example 1.1 – Operation
The menu displays the fact that **VTR Red** is selected on the **BKGD** bus of **MLE1**. In addition, the **Aspectizer** is in **Bus Mode** and is **active**, since the aspect ratios of **VTR Red** and **MLE1** are different. This is noted by the animated arrow between the 16:9 box of **VTR Red** and the 4:3 box of **MLE1**. As well, the word **ON** is displayed above the line. The **Aspectizer look** is **Letterbox** and black is filling the horizontal bars above and below the video.

There are no warnings in this case because **MLE1** is not selected on air.

However, if we now select **MLE1** as a re-entry on the **PGM** bus of **MLE4**, thus taking it to air,

![Bus Mode Example 1.1A – Switcher Setup](image)

...the following warnings are displayed:

<table>
<thead>
<tr>
<th>Warning 1</th>
<th>Warning 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>The first warning indicates that <strong>VTR Red</strong> is selected on <strong>MLE1</strong>, and any change to the <strong>Aspectizer</strong>, such as look, BKGD color or Superblack, will happen on air.</td>
<td>The second warning cautions you that if you toggle the aspect ratio of <strong>VTR Red</strong>, the change will happen on air.</td>
</tr>
</tbody>
</table>

**Example 1.2**

In this second example, **Server 1** is selected on the **PST** bus of **MLE1** in order to preview the video, while **VTR Red** is selected on the **BKGD** bus of **MLE1**.
The menu displays the fact that **Server 1** is selected on the **PST** bus of **MLE1**. In addition, the **Aspectizer** is in **Bus Mode** and is **active**, since the aspect ratios of **Server 1** and **MLE1** are different. This is noted by the animated arrow between the 16:9 box of **Server 1** and the 4:3 box of **MLE1**. As well, the word **ON** is displayed above the line. The **Aspectizer look** is **Letterbox** and black is filling the horizontal bars above and below the video.

Even though **Server 1** is selected on the **PST** bus, a **warning** is displayed to notify you that **MLE1** is on air (**VTR Red** is on air via a re-entry on **MLE4**). Remember that the **BKGD** and **PST** buses are linked together in **Bus Mode** and share the same **Aspectizer** characteristics. Therefore, if any of the characteristics were changed for **Server 1**, with the exception of its aspect ratio, the same change would happen on air to **VTR Red**.
Downstream Mode Setup

**Downstream Mode** is only used when you require two PGM outputs with different aspect ratios. It is the easiest and most economical way to have dual aspect ratio outputs.

**Downstream Mode Setup**

Use the following procedure to setup the Aspectizer in **Downstream Mode:**

1. Locate the MLE PGM output from the bottom MLE of your switcher on the rear of the Synergy frame.

2. Connect a cable from the bottom MLE PGM output to a BNC input that is one of the eight inputs on the Input Carrier Board on which the Aspectizer is installed.

   The following diagram illustrates the cable connections:

   ![Downstream Mode Cabling Diagram](image)

   **Downstream Mode Cabling**

The Aspectizer Setup Options Menu allows you to configure your Aspectizer and defines the following:

- where the Aspectizer Board is physically located;
- what mode it is in; and
- which buses you wish to aspectize.

Use the following procedure to configure the Aspectizer board:

1. Ensure that the Aspectizer is properly installed and recognized by the system.

2. Navigate to the Aspectizer Setup Options Menu as follows:

   - Press HOME ⇔ MORE ⇔ Setup ⇔ Installation ⇔ MORE ⇔ Option Cards ⇔ Aspectizer.
3. Use the Aspectizer Channel knob to select the Channel that you want to define. Each channel of the Aspectizer is defined by its host Input Carrier Board number – Carr#, and Socket number – Sock#A and Sock#B.

4. Use the Mode knob to select the mode you wish to make active – in this case Downstream. Selecting Downstream will change the bottom knob to BNC.

5. Use the BNC knob to assign a BNC to the channel selected in Step 4. Note that only the BNC inputs associated with the particular Input Carrier Board that the Aspectizer is installed on will be available for selection.

**Note**

Only one channel, either A or B of the Aspectizer is required for Downstream Mode. The other channel is available for use with an input in Input Mode.

When working in Downstream Mode, the possibility exists to double aspectize an input(s) on the Downstream Aux Bus output. This situation will occur if an input has already been aspectized somewhere else in the switcher and on air.

Use the following procedure to assign the output of the Aspectizer to a panel crosspoint:

1. Navigate to the BNC Menu 1-2 as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **BNC**.
2. Press **Panel** to display the Panel Button Setup Menu.

3. Use the Crosspoint knob to select the button number that you wish to assign.

4. Use the BNC knob to scroll the selection down past input 64. Note that the label BNC changes to OPT – indicating that this region of the menu is reserved for internally generated signals from any installed option boards on the Input Carrier Board.

5. Select the desired internal Aspectizer signal – in this case Aspt84 A. Note that in the Status Box, the system identifies the internal source (Aspectizer Video A), the Type
(Other), the Auto Key (Black), the location of the optional Aspectizer board (i.e. carrier 8, socket 4) and its aspect ratio (4:3).

6. When you have completed this stage, press HOME to exit the installation menus and press Confirm to confirm your changes.

In Downstream Mode, the Aspectizer uses the aspect ratio of the bottom MLE PGM to determine which way to do the conversion.

Use the following procedure to set the output aspect ratio of the MLE:

1. Navigate to the MLE Aspect Ratio Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Output ⇒ MLE Aspect Ratio.

2. Use the MLE knob to select the bottom MLE number of your switcher.

3. Use the Aspect knob to the appropriate aspect ratio – either 4:3 or 16:9. The Aspectizer will use this aspect ratio to set itself to the opposite one.

4. You must now assign the output of the Aspectizer to the Aux Bus:
   - Select the Aux Bus number on the panel
   - Press the previously assigned crosspoint – in this case, DOWNSTRM (BNC 58).

This completes the Aspectizer setup procedure for Downstream Mode.
Downstream Mode Menus

**Downstream Mode** is only used when dual aspect ratio outputs are required. Usually this requirement would be associated with feeding two transmitters – one in 4:3 and the other in 16:9, although other applications could be possible.

**Downstream Mode** can be combined with either **Input Mode** or **Bus Mode** for complete flexibility.

Once **Downstream Mode** has been chosen as the operational mode for dual aspect ratio outputs, it would be unusual to change the *look* during the course of the production but there is provision to do so if required.

You can select a look using the **Aspectizer Menu**. In all, there are seven *looks* to choose from, depending upon the particular combination of input and output aspect ratios. Six of these *looks* can be repositioned on screen, either vertically or horizontally depending on the *look*. These movable looks are **Letterbox**, **Pillarbox**, the two **Pan and Scan** looks, and the two **14:9** looks (one each for 16:9 to 4:3 aspect ratio, and one each for 4:3 to 16:9 aspect ratio).

Use the following procedure to enter the **Aspectizer Menu**:

1. Navigate to the **Select Aspectizer Menu** as follows:
   - Press **HOME ➔ Effects ➔ Aspectizer.**

![Select Aspectizer Menu](image)
2. Select an input to modify as follows:
   - Use the top knob to highlight the input that you wish to select.
   - Press Modify to display the Aspectizer in Downstream Mode Menu. Note, only the inputs and/or bus-pairs that have previously been configured for an Aspectizer will be displayed.

   You can also double press the input that you wish to select on the Aux Bus. If the Aspectizer Menu is already up, a single press will change the display. If you would like to change the default speed of the double press function, refer to the Synergy Series Installation Guide.

   The menu indicates that the Aspectizer is in Downstream Mode.

   The main body of the menu has expanded to include some additional information. The box on the left depicts the aspect ratio of the bottom MLE PGM output and names it.

   - The Aspectizer is always active in Downstream Mode and, therefore, the arrow between the boxes is moving and ON is displayed above the line.

   - The box on the right displays the output aspect ratio of the Aspectizer, which is being fed to the Aux Bus.

   A warning below the boxes displays which Aux Bus the Aspectizer is feeding.

   Inside the large box is a graphical representation of the Aspectizer look that is presently selected and being sent to the Aux Bus.

   The output aspect ratio of the Aspectizer in Downstream Mode is automatically set to the opposite aspect ratio of the MLE PGM and can not be changed, except through the Installation Menu.

3. Select an Aspectizer look as follows:
   - Press the Aspectizer Look to displays the different looks available in either aspect ratio configuration. The looks are displayed on the right hand side of the menu.
   - Use the top knob to select a look. You can choose from the following:
     - Full Screen — Select this option to have the input pass through the Aspectizer without making any change to the video.
~ **Letterbox** — This is the default look for a 16:9 input signal that is selected on a 4:3 MLE.

~ **Pillarbox** — This is the default look for a 4:3 input signal that is selected on a 16:9 MLE.

~ **Pan and Scan** — This look can be applied to either a 16:9 signal that is selected on a 4:3 MLE, or a 4:3 input that is selected on a 16:9 MLE. The **14:9** look is a compromise between a **Letterbox** or **Pillarbox** and a **Pan and Scan**.

~ **14:9** — This look can be applied to either a 16:9 signal that is selected on a 4:3 MLE, or a 4:3 input that is selected on a 16:9 MLE. The **14:9** **look** is a compromise between a **Letterbox** or **Pillarbox** and a **Pan and Scan**.

~ **14:9 Wide** — This look can be applied to a 4:3 input that is selected on a 16:9 MLE. The **14:9 Wide look** displays the same image as **14:9**, but eliminates the black pillars at the left and right by expanding the image horizontally so it fills the screen.
14:9 Tall — This look can be applied to a 16:9 input that is selected on a 4:3 MLE. The 14:9 Tall look displays the same image as 14:9, but eliminates the black panels at the top and bottom by expanding the image vertically so it fills the screen.

4. Toggle Superblack between On and Off as follows:
   - Some of the Aspectizer looks have portions of the screen that are not filled with video from either signal, such as Letterbox and Pillarbox.
   - You have the option of filling these areas with Superblack or any color.
   - The default is black.
   - Toggling the Superblack On/Off to Off adds the Bkgd Color softkey to the menu as follows:

5. Select an Aspectizer Background Color as follows:
   - Press Bkgd Color to display the Color Selection Menu.
Notice that there is a menu sub-title that defines the menu as the **Aspectizer Background Color**.

The color can be adjusted in either RGB or HSL space by pressing the corresponding softkey and rotating the knobs on the right.

6. Use the **Asp pass cap** softkey when passing video with closed captioning through a **Dual Aspectizer Board**. You can choose between the following:

   ~ **On** — When **Asp pass cap** is set to **On**, the video signal passes through the **Dual Aspectizer** while the line of closed captioning is routed around it. This path prevents distortion of the closed captioning. This is the default setting.

   ~ **Off** — When **Asp pass cap** is set to **Off**, the video signal is passed through the Aspectizer in the normal manner. This setting should be used when the video signal that you are “aspectizing” does not have a line of closed captioning inserted.

For information on the **Dual Aspectizer** option, refer to Appendix C, “**Hardware Options**” of the **Synergy Series Installation Guide**.

### Notes on Aspectizer Looks

Please note the following important points regarding **Aspectizer** looks:

- If the **MENU** button in the **Positioner Group** is lit, the **joystick** can be used to control the vertical and horizontal movement of the image.

- Pressing the **CENTER** button in the **Positioner Group** will restore a repositioned image to its default position.
Clip Control

In This Chapter

This chapter provides instructions for programming and running VTR, Video Server and Audio Server clips. The following topics are discussed:

- Clip Control Overview
- Communications Setup
- Programming Custom Control Buttons
- Programming VTR Clips
- Programming Video Server Clips
- Grabbing a Timecode
- Previewing Audio Server Clips
- Running VTR and Video Server Clips
- Application Notes

Note

If you are using the Leitch ASC series of Video Servers, review the section “Application Notes” on page 14–27 for important information regarding Clip performance.
Clip Control Overview

The overall VTR Clip Control function allows you to set up, recall and run clips from the following categories of serially controlled devices: VTRs, Video Servers, and Audio Servers. Each device must be connected to Synergy using RS-422 communications and properly be set up using a series of installation setup menus.

Note

An MLE is considered On Air if its tally is set to Always from the Output Menu. This setting will tally the selected MLE regardless of what is selected on the Program/Preset Bus of the switcher. The Red ON LED of that MLE will always be lit, and all the sources selected on the MLE will tally accordingly. Refer to the section “MLE Tally” for instructions on how to select the desired tally functions for an MLE.

Note

The Synergy switcher enables you to control multiple channels from a VDCP device through a single remote port on the Synergy control panel and then assign a channel to the BNC input. Refer to the section “Setting up Video Server BNCs” in the Synergy Series Installation Guide for more information.

Clip Control Overview

There are two methods to recall VTR Clips using the keypad in the Global Memory System of the Synergy switcher:

• VTR Clip Number — The VTR Clip Number is a two digit number that is created using the Synergy VTR Clips Menu. Refer to the section “Programming Clips” on page 14–8 for more information. When selecting a crosspoint associated with any VTR device, the keypad in the Global Memory System will be set to VTR Clip Number mode.
• **VTR Clip ID** — The VTR Clip ID is a 6 digit number that is established on the external device. Leading zeros cannot be specified when entering VTR Clip ID. For example, entering 12 on the Global Memory System keypad will load Clip 12 from the device and not Clip 000012.

~ All VTR devices that support the VTR Clip ID mode can toggle back to the VTR Clip Number mode by pressing the VTR Clip button.

~ All devices using VDCP protocol, except for the EVS maXS, support the VTR Clip ID feature.

~ The Accom APR/ClipStore supports the VTR Clip ID feature if the Clip ID on the device is numeric.

Use the following procedure to access a VTR Clip from an external device using the Synergy Global Memory System:

1. Toggle the VTR Clip button in the Global Memory System to display the VTR Clip ID screen.

2. Enter the VTR Clip ID using the keypad in the Global Memory System.

3. Press Enter in the Global Memory System.

This completes the procedure to access a VTR Clip from an external device using the Synergy Global Memory System.

**Setting Up and Playing Clips Overview**

Four procedures are used to properly set up and play clips from a VTR, Audio Server or Video Server:

- **Communications Setup**
  
  This step involves setting up the BNC name, communications, protocol, and preroll interval for your device.

- **Programming Custom Control Buttons**
  
  This step allows you to assign dedicated custom control buttons to specific transport control (and clip) functions. The step is recommended for Audio Servers, but optional for VTRs and Video Servers.

- **Programming Clips**
  
  A VTR Clip typically consists of two pieces of information: a physical device connected to the system and a timecode register. Additional data is also included for Video Servers. Using the VTR Clips Menu, you can select a serial controlled device, and then program, name, preview, and store clips in one of 100 clip registers.
• **Running VTR and Video Server Clips**

Once clip data is stored, you can press **VTR CLIP** in the **Global Memory System** group, enter a clip register, cue the device (that is associated with the clip), and bring the clip to air.

If you have a VTR device connected to the Synergy switcher, toggling the **VTR CLIP** button enables you to enter the Clip ID using the keypad in the **Global Memory System**.

Different methods can then be used to prepare clips to be taken on air:

~ Clips can be run (played) manually, using either a **Custom Control** button or the dedicated transport control softkeys in the **Remote Control Menu**.

~ Using the **ROLL VTR** button in Play mode, clips can be brought to air manually by the operator.

~ Using the **ROLL VTR** button in Arm mode, clips can be brought to air automatically using the transition area buttons.

Each procedure is outlined in the following sections.

**Important**

Clips for VTRs and Video Servers are saved in memory only upon exit of the **VTR Clips Menu**, but you can *also* store **VTR Clip Registers** to a storage device. Note also that in a power failure situation, all clip registers are protected.
Communications Setup

This section provides a general overview for setting up communications between a VTR, Video Server, or Audio Server and the Synergy switcher. Refer to the Synergy Series Installation Guide for specific setup information.

Communications Setup

Use the following procedure to ensure proper communications for VTRs:

1. Ensure that each serially controlled device is physically connected to the desired Synergy remote control port.
2. Ensure that all desired remote control options are properly installed.
3. Ensure that the remote port on the Synergy control panel that the serial controlled device is connected to, is set up to communicate with the device you have connected.
4. Ensure that each serial controlled device that you want to use for clip control is properly assigned as a VTR and to a BNC input on the BNC Setup Menu.

Note Refer to Chapter 18, “Video Servers (VDCP)” in the Synergy Series Installation Guide for information on setting up your switcher for multiple video channel control. For information on setting up Audio Servers, refer to Chapter 17 “Audio Servers” in the Synergy Series Installation Guide.

5. Use the BNC Names Menu to properly identify each BNC. When using the setup menus and especially the Preview Overlay, these names will help you to visually identify actual sources, rather than displaying BNC numbers. For example, by naming a BNC Server2 instead of BNC-24, both setup and on-air operation will be easier.

This completes the procedure to ensure proper communications setup for VTRs. Refer to the Synergy Series Installation Guide for setup information for your device.
Programming Custom Control Buttons

The following topics are discussed in this section:

- Programming VTR and Video Server Custom Controls
- Programming Audio Server Custom Controls

Programming VTR and Video Server Custom Controls

When you set up your VTR and Video Server clips using the VTR Clips Menu, transport control commands (such as PLAY and STOP) are located on the menu as standard. In addition, when you recall VTR and Video Server clips from memory for use during on-air production, transport control commands are also present on the individual Remote Control menus. Refer to the appropriate chapter for your device in the Synergy Series Installation Guide, for detailed instructions on programming custom control buttons.

With these facts in mind, you may (or may not) want to program these standard commands on individual custom control buttons for VTRs and Video Servers. Remember that custom control buttons do give you the ability to string groups of commands together (including transport controls and the ability to cue specific clips repeatedly).

Note the following when programming custom controls for VTRs and Video Servers:

- For automatic device control during transitions, remember that the ROLL VTR button (in Arm mode) in the MLE’s Transition Group automatically rolls the device that is selected on any bus in the MLE.

- If you do choose to program Custom Control buttons, at the minimum, you should program four functions: PLAY, STOP, FF and REV. These will allow you to control the selected device from the switcher panel, once the clip has been cued.

- If you choose to program Custom Control buttons with a RECORD function for a VDCP device you can program a STOP function in one of three ways:
  ~ Program a STOP macro for the same Custom Control button.
  ~ Program a STOP macro for a separate Custom Control button.
  ~ Assign a Record Time in the Communications — Extra Options Menu that is applied to all Custom Controls for the selected device. Refer to the Synergy Series Installation Guide for more information.

- If you play a Custom Control button programmed with a RECORD function for a Video Server, a pop-up message is displayed. The Clip ID, a number automatically generated by the switcher, is also displayed on the popup message for your reference.

Note: You may encounter a slight delay after pressing the Custom Control button and the beginning of the recording. This time enables the video server to initialize the record command.
Programming Audio Server Custom Controls

A custom control button can be programmed with the transport functions that are located on the Insert Audio Server Menu. This allows for quick access to these functions, or you can string a number of these functions together in a single custom control. You must have the Audio Servers Control option installed in order to control an Audio Server from the Synergy switcher. Refer to the Synergy Series Installation Guide for information on setting up an Audio Server. Programming a group of Custom Control buttons is recommended for Audio Servers which do not have a Remote Control Menu.

The Insert Audio Server Menu identifies the Audio Server Clip you are using, and the specific Audio Server you are controlling by the Remote Port that it is connected to. Below the title are three rows: Cut ID, Cut Name, and Cut Time.

- **Cut ID** — This row displays the current Drive, Directory, and Cut that has been selected. These fields are as follows 00(Drive).00(Directory)00(Cut)
- **Cut Name** — This row displays the name of the cut on the Audio Server.
- **Cut Time** — This row displays the time, or length, of the cut on the Audio Server.

The Insert Audio Server Menu enables you to select the Drive, Directory and Cut on the Audio Server and associate specific transport functions:

- **Go to Cut** — Select this command to have the Audio Server cue to a selected cut or track.
- **Play** — Select this command to have the Audio Server go into play mode.
- **Pause** — Select this command to have the Audio Server go into pause mode.
- **Stop** — Select this command to have the Audio Server stop.

**Note**

If you have a Sony MiniDisc, the rows will be labeled as Track ID, Track Name, and Track Time.
Programming Clips

The next step in VTR clip operations is to program VTR and Video Server clips using the **VTR Clips Menu**. The menu is a *programming* menu, rather than a live menu — designed to set up clips for later use on-air.

The **VTR Clips Menu** allows you to perform the following functions:

- Select a serial controlled device and a clip number.
- Grab or enter a timecode (and other device-specific data), name the clip, and store it in a clip register. Up to 100 clips can be stored (using registers **00** to **99**).
- Cue and preview each clip.
- For Video Servers, trim the clip’s inpoint and outpoint.

Procedures are provided below for programming VTR clips and Video Server clips. The steps vary slightly for each device, because the **VTR Clips Menu** changes depending upon the selected device.

### Programming VTR Clips

In order to easily recall clips on the VTR from the Synergy switcher, you will have to store the clips you want to use to **Clip Registers** on the switcher. These Clip Registers store the location, or timecode, on the VTR for the clip, and the name of the clip.

Use the following procedure to program VTR clips:

1. Ensure that all previous setup steps have been performed. Refer to the section “**Communications Setup**” on page 14–5 for instructions.

2. Navigate to the **Clip Type Menu** as follows:
   - Press **HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips ⇒ Clip Type**.

3. Select the Clip Register you want to store a VTR Clip to as follows:
   - Use the **Clip** knob to select the Clip Register that you want to program (**00-99**).
   - Use the **Device** knob to select the remote port for the VTR you want to store the clip information for.
   - Use the **Enable/Disable** knob to select if you want the clip to be displayed in the **Remote Control Menu** (for on-air use), or to be disabled for use later.

   **Note**
   
   If a clip is set to **Clip Disabled**, it will not be displayed on the **Remote Control Menu**, but you can still enter all required clip parameters. This can also be used to enable a clip that is already programmed.
4. Press **Name Clip** to display the **Clip Name Menu**.

The **VTR Clip** name is the one that is displayed for the Clip Register on the display in the **Global Memory System Group** and on the **Remote Control Menu**.

<table>
<thead>
<tr>
<th>Clip Name</th>
<th>Horizontal</th>
</tr>
</thead>
<tbody>
<tr>
<td>a b c d e f g h i j k l m n o p q r s t u v w x y z</td>
<td>Vertical</td>
</tr>
<tr>
<td>A B C D E F G H I J K L M N O P Q R S T U V W X Y Z</td>
<td></td>
</tr>
</tbody>
</table>

**Current Name:** VTR Clip1 **New Name:** VTR Clip1

**Clip Name Menu**

- Use the **Horizontal** and **Vertical** knobs (in conjunction with the editing softkeys) to enter the desired clip name.
- A standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs. Refer to the section “**Using a Keyboard**” for details.

**Important**

Do not enter a space as the first or last character of a clip name.

- Press **Accept New Name** to complete the naming procedure and return to **VTR Clips Menu 1-2**. The new name is now shown in the status area and as one of the options for the **Clip** knob.

5. Select the **Timecode** to be stored in the **Clip Register** as follows:

**Note**

If you do not know the timecode for the clip you want to store to the Clip Register, you can manually preview the VTR video using the command on the **VTR Clips Menu 2-2** and grab the timecode. Refer to the section “**Grabbing a Timecode**” on page 14–10 for information on grabbing a timecode.

- Press **Hours Minutes** to display the **Hours Minutes Menu**.

**Operating Tip**

As you adjust the Hours, Minutes, Seconds and Frames values, the corresponding fields of the timecode are updated. These timecode fields are as follows: *(hours):(minutes):(seconds):(frames)*.
• Use the **Hours** knob to adjust the value in the hours field of the **Timecode**.

• Use the **Minutes** knob to adjust the value in the minutes field of the **Timecode**.

• Press **Seconds Frames** to display the **Seconds Frames Menu**.

<table>
<thead>
<tr>
<th>VTR Clips 1-2</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip: 00</td>
<td>Clip Name: &quot;0-Bars &amp;&quot;</td>
</tr>
<tr>
<td>Device: BNC 4 (R3)</td>
<td></td>
</tr>
<tr>
<td>Timecode: 00:00:00:00</td>
<td></td>
</tr>
</tbody>
</table>

• Use the **Seconds** knob to adjust the value in the seconds field of the **Timecode**.

• Use the **Frames** knob to adjust the value in the frames field of the **Timecode**.

![Operating Tip]

You can preview the Timecode location by selecting the VTR on the PST Bus and pressing **Cue to Timecode**.

• Press **Grab Timecode** to use the new timecode value for the Clip Register.

6. Press **HOME** to store your settings.

This completes the procedure for programming VTR clips.

**Grabbing a Timecode**

If you do not know the timecode for the clip you want to store, you can manually scan the VTR video using the commands on the **VTR Clips Menu 2-2** and grab the timecode.

Use the following procedure to grab a timecode:

1. Navigate to the **VTR Clips Menu** as follows:
   • Press **HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips**.

2. Select the Clip Register and VTR that you want to store. Refer to the section “Programming VTR Clips” on page 14–8 for more information on programming VTR Clips.

3. Grab a timecode as follows:
   • Press **MORE** to display **VTR Clips Menu 2-2**.

   ![VTR Clips Menu 2-2](image)

   • Cue the VTR to the desired clip location using the transport controls.
If desired, press **Pause** to hold the VTR at the desired timecode.

Press **MORE** to display the **VTR Clips Menu 1-2**.

* Press **Pause** to hold the VTR at the desired timecode.
* Press **MORE** to display the **VTR Clips Menu 1-2**.

4. Press **HOME** to store your settings.

This completes the procedure for grabbing a VTR timecode.

**Note**

VTR clips are saved in memory *only* upon exit of the **VTR Clips Menu**, but you can also save them to a storage device.

### Programming Video Server Clips

In order to easily recall clips on the Video Server from the Synergy switcher, you will have to store the clips you want to use to **Clip Registers** on the switcher. These Clip Registers store the location, inpoint and outpoint overrides, and the name of the clip.

Use the following procedure to program Video Server clips:

1. Ensure that all previous setup steps have been performed. If not, refer to the section “**Communications Setup**” on page 14–5 for instructions.

2. Navigate to the **Clip Type Menu** as follows:
   * Press **HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips ⇒ Clip Type**.

3. Select the Clip Register you want to store a Video Server Clip to as follows:
   * Use the **Clip** knob to select the Clip Register that you want to program (00-99).
   * Use the **Device** knob to select the remote port for the VTR you want to store the clip information for.
• Use the **Enable/Disable** knob to select if you want the clip to be displayed in the **Remote Control Menu** (for on-air use), or to be disabled for use later.

**Note**

If a clip is set to **Clip Disabled**, it will not be displayed on the **Remote Control Menu**, but you can still enter all required clip parameters. This can also be used to enable a clip that is already programmed.

4. Press **Name Clip** to display the **Clip Name Menu**.

The **Video Server Clip** name is the one that is displayed for the Clip Register on the display in the **Global Memory System Group** and on the **Remote Control Menu**.

5. Select a clip on the VTR as follows:

   • Press **Choose ID** to display the **Choose ID Menu**.
   
   • If you know the name of the clip, press **Enter ID** and you can enter the name of the clip directly from the **Enter Clip ID Menu**.

**Note**

If you want to refresh the list of clips returned by the Video Server, press **Refresh & Choose ID** to poll the Video Server for a current list of clips. The total number of clips returned is indicated under the **Showing**.
6. Modify the Inpoint and Output of the Clip as follows:

- **Press Inpoint/Outpoint** to display the **Inpoint/Outpoint Menu**.

**Note**

If you select different start and end frames to use on air, the original inpoint and outpoint for the clip remain unchanged on the Video Server. This allows you to create sub-clips from a long master Video Server clip directly on the switcher.

- **Toggle the Enable softkey** to enable Inpoint/Outpoint Overrides:
  - **No** — Select this option to use the default inpoint and outpoint of the clip on the Video Server. If you have made changes to the inpoint or outpoint of the clip, these values are saved, but not applied to clip until you select **Yes**.
  - **Yes** — Select this option to override the inpoint and outpoint of the clip on the Video Server. When you select **Yes**, the **Inpoint/Outpoint Menu** changes to allow you to modify the start and stop positions of the clip.
• Toggle the **Edit** softkey to **In** or **Out** to select either the Inpoint or Outpoint for editing.
  
  ~ **In** — Select this option to modify the inpoint, or start position, of the clip.
  
  ~ **Out** — Select this option to modify the outpoint, or stop position, of the clip.

  **Note**
  If you do not know the timecode for the Inpoint or Outpoint you want to store to the Clip Register, you can manually preview the Video Server video using the command on the VTR Clips Menu 2-2 and grab the timecode. Refer to the section section “**Grabbing a Timecode**” on page 14–15 for information on grabbing a timecode.

• Press **Hours Minutes** to display the **Hours Minutes Menu**.

<table>
<thead>
<tr>
<th>Inpoint / Outpoint</th>
<th>(0) Hours</th>
<th>(0) Minutes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip: 00 Clip Name: &quot;BG-Blue&quot;</td>
<td>Start</td>
<td>End</td>
</tr>
<tr>
<td>Device: <em>N</em> 3 (R2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID: &quot;BG-Blue Circle&quot;</td>
<td>Duration: 00:00:30:00</td>
<td></td>
</tr>
<tr>
<td>Inpoint: 00:00:00:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outpoint: 00:00:30:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Embled Editt Hours Minutes Seconds Frames Grab Cue to</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No</td>
<td>In</td>
<td>Out</td>
</tr>
</tbody>
</table>

**Inpoint/Outpoint Menu — Hours Minutes Menu**

**Operating Tip**
As you adjust the Hours, Minutes, Seconds and Frames values, the corresponding fields of the Inpoint or Outpoint are updated. These timecode fields are as follows: **(hours):(minutes):(seconds):(frames)**.

• Use the **Hours** knob to adjust the value in the hours field of the Inpoint or Outpoint.

• Use the **Minutes** knob to adjust the value in the minutes field of the Inpoint or Outpoint.

• Press **Seconds Frames** to display the **Seconds Frames Menu**.

<table>
<thead>
<tr>
<th>Inpoint / Outpoint</th>
<th>(30) Seconds</th>
<th>(0) Frames</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip: 00 Clip Name: &quot;BG-Blue&quot;</td>
<td>Start</td>
<td>End</td>
</tr>
<tr>
<td>Device: <em>N</em> 3 (R2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID: &quot;BG-Blue Circle&quot;</td>
<td>Duration: 00:00:30:00</td>
<td></td>
</tr>
<tr>
<td>Inpoint: 00:00:00:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outpoint: 00:00:30:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Embled Editt Hours Minutes Seconds Frames Grab Cue to</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No</td>
<td>In</td>
<td>Out</td>
</tr>
</tbody>
</table>

**Inpoint/Outpoint Menu — Seconds Frames Menu**

• Use the **Seconds** knob to adjust the value in the seconds field of the Inpoint or Outpoint.

• Use the **Frames** knob to adjust the value in the frames field of the Inpoint or Outpoint.

• Preview the Timecode location by selecting the Video Server on the PST Bus and pressing **Cue to Timecode**.

• Press **Grab Timecode** to use the new timecode value for the Inpoint or Outpoint.
7. Press **HOME** to store your settings.

This completes the procedure for programming Video Server clips.

---

**Note**

Video Server clips are saved in memory *only* upon exit of the VTR Clips Menu, but you can also save them to a storage device.

---

**Grabbing a Timecode**

If you do not know the timecode for the inpoint or outpoint, you can manually scan the Video Server video using the commands on the VTR Clips Menu 2-2 and grab the timecode.

Use the following procedure to grab a timecode:

1. Navigate to the VTR Clips Menu as follows:
   
   - Press **HOME** ⇒ **MORE** ⇒ **Clips** ⇒ **VTR Clips**.

2. Select the Clip Register and Video Server that you want to store. Refer to the section “Programming Video Server Clips” on page 14–11 for more information on programming Video Server Clips.

3. Grab a timecode as follows:
   
   - Press **MORE** to display VTR Clips Menu 2-2.

   **VTR Clips Menu 2-2**

   - **VTR Transport Controls**
     
     - Cue the Video Server to the desired clip location using the transport controls.
     
     - If desired, press **Pause** to hold the VTR at the desired timecode.
     
     - Press **MORE** to display the VTR Clips Menu 1-2.

   **VTR Clips Menu 1-2**

   - **VTR Clips Menu 1-2**

     - Press **Grab Timecode** to grab the current timecode and display it in the *Timecode* field.

4. Press **HOME** to store your settings.

This completes the procedure for grabbing a Video Server timecode.
The **Audio Server Clip Menu** allows you to preview your audio clips. You can verify any changes made on the device before creating Custom Controls or Clip Registers on the Synergy switcher. Note that this is a preview function only, and you must create Custom Controls or Clip Registers in order to recall Audio Server clips for use during on-air production. Refer to the section “**Programming Audio Server Custom Controls**” in the *Synergy Series Installation Guide* for information on Custom Controls for your Audio Server.

The **Audio Server Clip Menu** identifies the Audio Server clip and the specific Audio Server you are controlling by the Remote Port that it is connected to. Below the title are three rows: **Cut ID**, **Cut Name**, and **Cut Time**.

- **Cut ID** — This row displays the current Drive, Directory, and Cut that has been selected. These fields are as follows *00(Drive)*.*00(Directory)*.00(Cut). If you have a Sony MiniDisc, the row will be labelled as **Track ID**.
- **Cut Name** — This row displays the name of the cut on the VTR. If you have a Sony MiniDisc, the row will be labelled as **Track Name**.
- **Cut Time** — This row displays the time, or length, of the cut on the Audio Server. If you have a Sony MiniDisc, the rows will be labelled as **Track Time**.

**Previewing Audio Server Clips**

Use the following procedure to preview an Audio Server clip:

1. Navigate to the **Audio Server Clip Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Clips ⇒ Audio Clips.
2. Select the device you want to preview as follows:
   - Press **Device** to display the **Device Menu**.

   ![Device Menu](image)

3. Select the clip you want to preview as follows:
   - Press **Cut ID** to display the **Cut ID Menu**.

   ![Cut ID Menu](image)
Use the Drive knob to select the drive location on the Audio Server. Note that this knob is labelled as Disc when using a Sony MiniDisc.

Use the Directory knob to select the directory.

Use the Cut knob to select the clip number you want to preview. Note that this knob is labelled as Track when using a Sony MiniDisc.

4. Preview the selected audio clip as follows:

- Press Play to play the Audio Server clip from the selected device.
- Press Pause to pause the clip.
- Press Stop to stop the clip playout.

This completes the procedure to preview an Audio Server clip.
Programming Audio Server Clips

To easily recall clips on the Audio Server from the Synergy switcher, you can store the clips you want to use to Clip Registers on the switcher. These Clip Registers store the location, or cut, on the Audio Server for the clip, and the name of the clip.

Note

You must have the Audio Server Control option installed in order to control an Audio Server from the Synergy switcher. Refer to the section “Setting up the Audio Server” in the Synergy Series Installation Guide for information on setting up an Audio Server.

Programming Audio Server Clips

Use the following procedure to program Audio Server clips:

1. Navigate to the VTR Clips Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips.

2. Press Clip Type to display the Clip Type Menu.

3. Select the Clip Register you want to store a Audio Server Clip to as follows:
   - Use the Clip knob to select the Clip Register that you want to program.
   - Use the Device knob to select the remote port for the Audio Server you want to store the clip information for.
   - Use the Enable/Disable knob to select if you want the clip to be displayed in the Remote Control Menu (for on air use), or to be disabled for use later.

Note

If a clip is set to Clip Disabled, it will not be displayed on the Remote Control Menu, but you can still enter all required clip parameters. This can also be used to enable a clip that is already programmed.

4. Press Name Clip to display the Clip Name Menu.

The Audio Server Clip name is the one that is displayed for the Clip Register on the display in the Global Memory System Group and on the Remote Control Menu.
• Use the **Horizontal** and **Vertical** knobs, in conjunction with the editing softkeys, to enter the desired clip name.

• A standard PS/2 keyboard can also be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs. Refer to the section “**Using a Keyboard**” for details for details.

**Important**

Do not enter a space as the first or last character of a clip name.

• Press **Accept New Name** to complete the naming procedure and return to the **VTR Clips Menu**. The new name is now displayed in the status area and as one of the options for the **Clip** knob.

5. Select a cut on the Audio Server as follows:

• Press **Cut Index** to display the **Cut Index Menu**.

**Cut Index Menu**

• Use the **Drive** knob to select the drive on the Audio Server that the cut is stored on.

• Use the **Directory** knob to select the directory on the Audio Server that the cut is stored on.

• Use the **Cut** knob to select the specific cut on the Audio Server that you want to store in the Clip Register.

6. Press **HOME** to store your settings.

This completes the procedure for programming an Audio Server clip.

**Note**

Audio Server clips are saved in memory only upon exit of the **VTR Clips Menu**, but you can also save them to a storage device, such as a floppy disk or USB key.
**Digicart Audio Sound Effects**

For your convenience, the following table is a list of default Digicart audio sound effects and Squeeze & Tease wipes with time durations that are typically configured for presentation functionality.

*Note*

The Bank buttons are the leftmost 8 buttons. (1, 2, 3, 4, 17, 18, 19, 20)

<table>
<thead>
<tr>
<th>BANK</th>
<th>BUTTON</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 (Button 17)</td>
<td>This group is for combining sound effects with S&amp;T wipes. The macros consist of the following keystroke sequence: recall clip, auto rate, S&amp;T wipe transition, wipe #, normal/reverse, auto trans. This applies to the program/preset.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Clip 10 (cannon/cut 34), 11 frames, wipe 12R</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Clip 11 (pistol shot/cut 35), 4 frames, wipe 9R</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Clip 12 (bull whip/cut 40), 10 frames, wipe 28R</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Clip 13 (crash/cut 41), 20 frames, wipe 34R</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Clip 14 (boing/cut 55), 29 frames, wipe 18R</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Clip 15 (zap/cut 66), 17 frames, wipe 27R</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Clip 16 (splat/cut 70), 15 frames, wipe 31R</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Clip 17 (pistol cock/cut 32), 10 frames, wipe 4N</td>
<td></td>
</tr>
</tbody>
</table>
Running VTR and Video Server Clips

Once all VTRs and Video Server clip registers have been programmed, the final step is to use the VTR CLIP button to recall your clips and run them.

**Note**
You can cue and run more than one VTR Clip at the same time. For example, if you have the Roll VTR button armed and take a shot to air that has more than one VTR clip, all clips will roll.

Using the Remote Control Menu

The Remote Control Menu will display options based on the type of serial device you are attempting to cue clips from.

**VTR Clips**

The Remote Control Menu for VTRs displays three columns of information plus transport control softkeys as follows:

- **Column 1** (on the left) displays the selected clip name, its starting timecode value plus its current timecode location.
- **Column 2** displays information for the clip that is selected with the middle scroll knob from the list in Column 3. The clip name plus its starting timecode value is displayed.
- **Column 3** displays the list of enabled VTR clips, as selected on VTR Clips Menu 1-2.

The following figure illustrates a sample Remote Control Menu for VTR clips.

**Video Server Clips**

The Remote Control Menu for Video Servers displays three columns of information: the timeline of the clip, plus transport control softkeys as follows:

- **Column 1** (on the left) displays the selected clip name, its ID, the clip duration plus the selected inpoint and outpoint. The In/Out Field is only displayed if the Inpoint/Outpoint Menu was left enabled as the clip was programmed.
- **Column 2** displays information for the clip that is selected with the middle scroll knob — from the list in Column 3. The clip name, ID and duration are shown. Like column 1, the In/Out Field is only displayed if the Inpoint/Outpoint Menu was left enabled — otherwise, the label None Set is displayed.
- **Column 3** displays the list of filtered (enabled) clips. The last recalled clip, as selected on the Global Memory System by toggling the VTR Clip button, is labeled as (ID).
The following figure illustrates a sample Remote Control Menu for Video Server clips.

Running Clips

Use the following procedure to use VTR and Video Server clips on air:

1. Ensure that the clips you want to use are properly set up on the VTR Clips Menu 1-2, and that all desired VTR and Video Server clips are “enabled.” Only the enabled VTR and Video Server clips will be displayed on the Remote Control Menu.

2. Ensure that you can monitor the VTR or Video Server’s timecode on the Preview monitor:
   - Select the VTR or Video Server on the Preset Bus of the Program/Preset MLE.
   - In the Preview Overlay Group, press VTR TC to toggle the VTR Timecode Overlay.

3. Select the VTR or Video Server that you want to cue on any bus.

4. Select the MLE’s preview output on the Preview Bus to view the VTR or Video Server.

5. Ensure that your “next transition” includes BKGD.

6. Toggle the VTR CLIP button in the Global Memory System Group.

7. Enter the clip number using the keypad in the Global Memory System Group.

   **Note**
   For most devices using the VDCP or Betacam protocol, toggling the VTR Clip button enables you to enter the Clip ID using the keypad in the Global Memory System Group. Refer to the section “Clip Control Overview” on page 14–2 for more information.

   **Note**
   You cannot access a clip from the EVS maXS video server using the keypad in the Global Memory System Group because its Clip IDs are not numeric. Refer to the section “Programming Video Server Clips” on page 14–11 for more information on using the Synergy VTR Clip Menu.

The display shows the clip register and the clip name (as entered on the VTR Clips Menu), and the Remote Control Menu for VTRs or Video Server clips is automatically displayed.
8. To play or preview the clip manually from the menu, use the available transport control commands as required: **Rewind, Play, Pause, and Fast Forward.**

**Note**
If you are using a BitCentral Précis, you can only choose between the **Play, Stop, and Fast Forward (FFwd)** commands. The **Fast Forward** command advances the VTR to the next clip in the BitCentral Précis rundown.

9. If your Video Server supports the looping clip command, you can toggle the option on or off from the **Remote Control Menu**. When Loop is **On**, the clip will start playing at the beginning again when it reaches the end.

10. To run a VTR Clip in **slow motion**, refer to the section “**VTR Play Speed Control – Slow Motion**” on page 14–24.

11. To cue the current clip, or to cue another clip for playback:
   - Use the middle knob to select a clip from the list. The list is filtered based on the clips that were enabled on **VTR Clips Menu 1-2**.
   - Press **Cue Clip**.

12. To roll the VTR or Video Server **manually** from the Synergy control panel:
   - Set the **Roll VTR Mode** to **Play** as follows:
     ~ Navigate to the **Roll VTR Mode Menu** as follows:
     -- Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Personality** ⇒ **Roll VTR Mode**.
     ~ Use the **Roll VTR Mode** knob to select **Play**. In this mode, the ROLL VTR button’s action is **momentary**.
   - Ensure that the VTR or Server is selected on the PST bus.
   - Press **ROLL VTR**. This action immediately plays the device. The transition that brings on the device must be initiated manually with the **Fader** or automatically using **CUT** or **AUTO TRANS**.

13. To roll the VTR or Video Server **automatically** from the Synergy control panel using a transition:
   - Set the **Roll VTR Mode** to **Arm** as follows:
     ~ Navigate to the **Roll VTR Mode Menu** as follows:
     -- Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Personality** ⇒ **Roll VTR Mode**.
     ~ Use the **Roll VTR Mode** knob to select **Arm**. Here, the ROLL VTR button is **latching**, and it remains latched until toggled off manually.

**Note**
If the MLE’s output is not used for on-air transitions (except in the Keyer area), do not roll the VTRs or apply the pre-roll. Arm mode is intended for MLEs that are part of the on-air composition.

   - Press the **ROLL VTR** button to arm the Synergy switcher.
   - Select, as desired, a VTR associated crosspoint for one or more of the two Keys and the PST bus, including MLE re-entries. Each bus can only deal with one VTR or Video Server, so at most three devices can be rolled at the same time.
   - When you press **CUT** or **AUTO TRANS** in the transition area of the MLE, the VTRs or Video Server will roll. The Synergy switcher will then start the transition at the end of the largest pre-roll of all the devices.
This completes the procedure to use VTR and Video Server clips on air.

**Notes on Using VTR and Video Server Clips**

Note the following important points regarding the use of clips on air:

- The **ROLL VTR** button is not included in memory recall functions.
- The **ROLL VTR** button can be used to roll VTRs and Video Servers selected on *any* bus on the MLE. Re-entry selections that include a VTR or Video Server are also allowed.
- If you set the **ROLL VTR** to *Arm* or *Armed Always Mode* and then select a VTR or Video Server directly on the PGM bus, the VTR or Video Server immediately rolls. Once the preroll is complete, the source will be taken to air. In this case, selecting the VTR or Video Server *once* activates preroll, but pressing the source *twice* bypasses the preroll wait and takes the device to air immediately. The hot-punch **ROLL VTR** in Arm mode works only if the MLE is already on air.
- If you take a VTR or Video Server to air using the **ROLL VTR** button in *Arm* or *Armed Always Mode*, the device continues to roll until the pause or the stop button is pressed. If you do not stop the VTR or Video Server, and you take another source on PGM, and then retake the rolling VTR or Video Server, it will come to air only after the preroll time has elapsed again.

**Important**

When an OverDrive production controller is connected to the Synergy switcher, activating the **Editor** button turns on all the **Roll VTR** buttons and sets the Roll VTR Mode to *Arm*, overriding the Roll VTR Mode selection in the **Personality Menu**. Attempting to disable the Roll VTR function by pressing a lit **Roll VTR** button will display a warning on the Synergy menu.

- If the **ROLL VTR** button is armed and the fader is used to start the transition, the preroll interval is ignored.
- You can also navigate to the **Remote Control Menu** as follows:
  ~ Press **HOME** ➔ **Effects** ➔ **MORE** ➔ **Remote Control Select**.
  ~ Use the **BNC** knob to select the desired device.
  ~ Press **GO!!** to display the **Remote Control Menu**.

**VTR Play Speed Control – Slow Motion**

When running VTR Clips, press **Play Speed** to control the playing speed of the VTR Clip, either forward or reverse in slow motion.

Use the following procedure to modify the play speed control for a VTR Clip:

1. Navigate to the **Remote Control Select Menu** as follows:
   ~ Press **HOME** ➔ **Effects** ➔ **MORE** ➔ **Remote Control Select**.
2. Use the **BNC** knob to select the BNC for the VTR.
3. Press **GO!!** to display the **Remote Control Select Menu**.
4. Press **Play Speed** to display the **Slow Motion Menu**.
5. Use the bottom knob to select the VTR Clip whose play speed and direction you wish to adjust.

6. Use the Speed knob to set the direction and rate at which the clip will play. You can select from the following:

- **200%** — Use this option to set a play rate speed of 2x.
- **100%** — Use this option to set a normal play speed.
- **0%** — Use this option to set a tape pause.
- **-100%** — Use this option to set a normal play speed in reverse.
- **-200%** — Use this option to set a fast play speed in reverse.

This completes the procedure to modify the play speed control for a VTR Clip.

**Looping a Clip**

Looping allows for the seamless repetition of a video clip and is useful for moving backgrounds, spinning logos, or any where that repetitive video is required.

Use the following procedure to enable looping playback for a video clip:

1. Navigate to the Video Server Remote Control Menu 2-2 as follows:
   - Select the crosspoint on any bus that is mapped to the Video Server you wish to control.
   - Press MORE to display the Video Server Remote Control Menu 2-2.
2. Press **Loop** to toggle clip-looping on and off. You can select between the following:
   - **On** — Clips will loop indefinitely when played (until playback is stopped). A looping icon appears next to the clip time code display on the **Remote Control** and **VTR Clips** menus.
   - **Off** — Clips will play once and then stop.

   ![Note]
   
   If you turn looping **Off** while a clip is playing, the clip will finish playing the current iteration and then stop.

3. Cue and play any video clips as needed.

This completes the procedure for enabling looping playback for a video clip.

Your device may require time to re-cue the clip in order to give seamless looping playback. There is a VDCP Extra Option that allows you to configure how much lead time your video server needs to ensure smooth looping. Refer to the section, “Setting up the Switcher”, in the chapter, “Video Servers (VDCP)”, of the Synergy SD Installation Guide for more information.
Application Notes

The following technical discussion applies to the Leitch ASC series of Video Servers only. The discussion is accurate as of the printing of the version of the Synergy Series Operation’s Guide (March, 2000).

Using Clips and Subclips on the Leitch ASC

A bug exists on the Leitch VR series of servers, and it is displayed in Leitch software versions 2.70 and earlier. Regarding inpoints and outpoints, the Leitch ASC uses the wrong “zero timecode” to cue clips that are requested from the Synergy switcher. Specifically:

- Assuming a master clip named “CLIP”, the Leitch ASC allows the user to construct a subclip of CLIP, with a working name of SUBCLIP. This function is performed on the Leitch itself.

- For this example, SUBCLIP has a starting mark that occurs 5 seconds into CLIP.

- When SUBCLIP is cued from Synergy, and no inpoint or outpoint is marked on Synergy’s Inpoint/Outpoint Menu, there is no problem with cueing.

- However, when Synergy attempts to cue SUBCLIP with an inpoint of 12 seconds, the clip actually cues with an inpoint of 7 seconds — 12 seconds from the inpoint of the parent clip (CLIP), rather than from the inpoint of SUBCLIP.

- There are several work-arounds:
  ~ If you use subclips that have been entered on the Leitch ASC, do not use inpoint/outpoint marking from Synergy.
  ~ Do not use subclips at all (as programmed on the Leitch ASC). Instead, only use the parent clips, and program subclips using Synergy’s inpoint/outpoint marking.
  ~ If you must use subclips from the Leitch ASC, make allowances for the error as described above. Look at the starting mark of the subclip (e.g., 5 seconds), and add that value to Synergy’s inpoint or outpoint mark.

- As a recommendation, please check your Leitch ASC software version, and verify if the problem as described above occurs. If so, use one of the work-arounds listed in this section.
External DSK 3/4 (CDK-111A-M)

In This Chapter

This chapter provides instructions for operating the optional external DSK (CDK-111A-M). The following topics are discussed:

- Overview
- External Downstream Keyer (CDK-111A-M) Setup
- Operation

In the *Synergy Series Installation Guide*, refer to the following sections for detailed external DSK installation and setup instructions:

- Chapter 3, “Preliminary Cabling and Check”, for instructions on installing the CDK-111A-M card(s) in Synergy switchers.
- Chapter 7, “Basic Communications Setup”, for instructions on setting up communications between the switcher and the CDK-111A-M(s).
- Chapter 9, “Additional Installation Setups”, for details on configuring the CDK-111A-Ms as downstream keyers.
- Appendix D, “Frame Modification”, for the field modifications required on the Synergy Frame Processor Module (4000A-003) for boards prior to Issue 2C.
Overview

The external DSK (CDK-111A-M) is the most advanced single card component digital keyer and keyer/mixer available on the market today. The CDK-111A-M suits a multitude of situations where high quality digital video keying and mixing is performed. With its built-in fade-to-black and fail-safe relay design, the CDK-111A-M is the perfect DSK for your critical program stream applications.

All video signals are referenced to the BKGD 1 input and have full frame synchronization capability with infinite timing adjustment. This makes it easy to install and eliminates many system timing issues.

The CDK-111A-M can be configured with a true look-ahead preview output, which is ideal for live productions, providing confidence in the quality and accuracy of the next scene to go to air.

The CDK-111A-M can be configured “on the fly” to key either an external or internally generated key source, or both. The internal key source can be a full-frame still or linear key, one of many stored linear key logos, or an animated logo. The key source can either be custom designed to your requirements by Ross Video, or from your own resources in “Targa” PC file format. This makes the insertion of trouble slides, content rating bugs, logos, and animated logos simple and affordable.


Control over the DSK is available via a RS-422 unbalanced full duplex RS-485, or a 0-12V RS-232 compatible interface. Configurable on-air tally outputs are also available.

The cards are fully compatible with Ross Video’s DFR-8110A-C (2 RU) and DFR-8104A-C (1 RU) frames, as well as the Leitch™ FR-6800 series frames.
External Downstream Keyer (CDK-111A-M) Setup

This section provides instructions for setting up your external downstream keyer(s) (CDK-111A-M). If you have not yet installed your CDK-111A-M cards, please refer to Chapters 3 and 7 of the Synergy Series Installation Guide.

Note: If the CDK-111A-M has not been properly configured as a downstream keyer in the Communications Menus, an error message is displayed.

Use the following procedure to set up your external DSKs:

1. Navigate to the DSK 3/4 Setup Menu 1-2 as follows:


2. Press Key Setup to display the Key Setup Menu.

3. Select a key and crosspoint type as follows:
   - Use the Key Type knob to select either a Self Key or an Auto Select key.
   - Use the Xpt type knob to select either Switcher xpt or CDK111 xpt.
     - Switcher xpt — When you select this option, the bottom knob label changes to Swh Inp (Switcher Input) and displays a list of input BNCs, from which you can select any of the sources that you have connected to your switcher.
     - Accomplish the same thing by pressing and holding the desired DSK SELECT button and selecting a crosspoint on the key bus. This will automatically change the Xpt type to Switcher xpt, but will not select the key type.
   - CDK111 xpt — When you select this option, a list of the images stored in the external downstream keyer’s internal Still Store RAM is displayed. Contact Ross Video Technical Support for details and the interface software.

   Note: Ensure that the Aux Buses are correctly installed and configured. Otherwise, there will not be any switcher crosspoints available to you.
4. Adjust the clip and gain values of the key as follows:
   • Press **Clip Gain** to display the **Clip Gain Menu**.
   • Use the **Clip** knob to adjust clip level.
   • Use the **Gain** knob to adjust gain (softness).

5. Toggle **Key Invert** between **On** and **Off** to invert the polarity of the selected key signal.
   For example, if a Self Key source (such as a title camera) has white letters on a black background, the white letters normally cut the hole. When **Key Invert** is **On**, the signal’s polarity is reversed and the **black background** cuts the hole. This function is often used to key black text that is printed on a white background. Note that both key types can be inverted.

6. Toggle **Matte Fill** between **On** and **Off** to fill the selected key hole with a matte color — **instead** of the key foreground video from the **Key Bus**.
   • Both key types can be filled with matte color.
   • If you have the matte fill turned on, you will need to press **Matte Color** to display the **Color Selection Menu**.
   • Use the knobs on the display (or the joystick, if you prefer) to choose the matte’s hue, luminance, and saturation. Refer to the the section “**Matte Group**” for matte fill and color wash instructions.

7. Press **Make Key Linear** to return the clip and gain values to the default settings.

8. Press **MORE** to display the **External DSK Setup Menu 2-2**.
9. Mask out areas of the key as follows:
   • Toggle **Mask** to **Off**.
   • Press **Mask Location** to display the **Mask Setup Menu**.

   ![Mask Setup Menu](image)

   **External DSK Setup Menu - Mask Setup**

   • Press **Posn/Size** to adjust the mask’s position on the screen.
     ~ Use the top, middle, and bottom knobs to adjust the key’s horizontal and vertical position and size (zoom) on the screen.
     ~ You can also use the Positioner on the Synergy control panel.
   • Press **Top/Left** to adjust the position of the mask’s top and left edges.
     ~ Use the top knob to adjust the left edge.
     ~ Use the middle knob to adjust the position of the top edge.
   • Press **Bottom/Right** to adjust the position of the mask’s bottom and right edges.
     ~ Use the top knob to adjust the right edge.
     ~ Use the middle knob to adjust the position of the bottom edge.

10. Set the Auto Trans Rate for the external DSK as follows:
    • Press **Trans Rate**.
    • Use the top knob to select a rate from 0 (cut) to 999 frames.

    **Note** If the Synergy frame has, for any reason, lost communications with the CDK-111A-M, a warning message is displayed on the screen.

This completes the procedure to set up your external DSKs. When both external DSKs are configured, pressing the DSK3 SELECT or DSK4 SELECT button displays the **External DSK Setup Menu** for either external downstream keyers.
Operation

When your external downstream keyer(s) (CDK-111A-M) option is configured, two of the Synergy switcher’s internal downstream keyer buttons will have changed their functionality. To accommodate this, a **Key Caps Kit** is included with your option package. For new customers who purchase a new Synergy switcher with an external downstream keyer options package, the appropriate key caps are installed in the panel before shipping. For information on standard downstream keying procedures, refer to the section “Using Downstream Keys”.

**Note**
If the user is displaying a key, and a USB image transfer is initiated, the key will disappear from the display. When the transfer is complete, the user must redisplay the key in order to see it.

Downstream Key Groups

The following figures illustrates the **Downstream Key** groups.

**Synergy 2 Control Panel**

The following figure illustrates the **Downstream Keyers** group for the Synergy 2 panel with the highlighted key caps installed in place of the KEY PV and SOURCE 8 keys:

![Downstream Keyers Group – Synergy 2](image-url)
Synergy 3 and 4 Control Panels

The following figure illustrates the DOWNSTREAM KEYER 1 group of buttons for the Synergy 3 and 4 panels with the highlighted CDK-111A-M key caps installed in place of the KEY PV and SOURCE 8 keys. The DOWNSTREAM KEYER 2 button group is identical in layout:

![Diagram of DOWNSTREAM KEYER 1 Group – Synergy 3, 4]

Refer to Chapter 4, “Preliminary Video Installation” the Synergy Series Installation Guide, for instructions on key cap installation and replacement.

Key Functions

Pressing DSK3 SELECT or DSK4 SELECT will bring up the appropriate External DSK Menu. External DSK (CDK-111A-M) setup with this menu can proceed as described in the previous section - Setup.

To operate the external downstream keyer:

- The DSK3 ON and/or DSK4 ON buttons will light when the appropriate external DSK is active on the program output.

- Pressing DSK3 ON or DSK4 ON will initiate an Auto Transition on those keyers. This transition is independent of the internal DSKs. The rate of this transition is set up in the External DSK Menu.

If the external DSK is included in the next transition, the DSK will only fade or cut, not wipe.

Note

The Key Preview function that was programmed into the KEY PV button, now designated as DSK3 ON (and DSK4 ON for Downstream Keyer 2) for Synergy 2, 3 or 4 switchers is now enabled by holding down the appropriate SOURCE (1 – 7) key for three to five seconds.

- Two transitions can be “tied” together by holding down any combination of the next transition buttons (BKGD, DSK1 and/or DSK2) for the downstream keyer while pressing DSK3 SELECT or DSK4 SELECT. The transition type automatically changes to dissolve.

Any subsequent transitions in the main transition area initiated with CUT, AUTO TRANS or the fader will include the external DSKs. The DSK3 SELECT and /or the DSK4 SELECT buttons will flash while in this mode.
To “untie” the transition and exit this mode, press any of the BKGD, DSK1 or DSK2 next transition buttons by itself.

- To initiate an external DSK cut, hold down the DSK3 SELECT or DSK4 SELECT button and press CUT or AUTO TRANS in the Downstream Keyer area.

The AUTO TRANS will use the transition rate set in the External DSK Menu.
Appendix A. Menu Trees

In This Appendix

For your reference, this appendix lists the various menu trees that are used within the Synergy switcher. The following topics are discussed:

- BNC Configuration Menu Tree
- Installation Setup Menu Tree
- Communications Menu Tree
- Custom Control Menu Tree
- Custom Control Banks Menu Tree
- Disk Menu Tree
- Recall Factory Menu Tree
BNC Configuration Menu Tree

The following figure illustrates the portion of the menu tree that is used to configure BNC connectors — specifically, the path used to reach the **BNC Setup Menu** and other associated setup menus.
Installation Setup Menu Tree

The following figure illustrates the *portion* of the menu tree that is used for additional installation setup procedures.
Communications Menu Tree

The following figure illustrates the portion of the Synergy menu tree that is used for communications setup procedures.
Custom Control Menu Tree

The following figure illustrates the portion of the Synergy menu tree that is used for programming custom control buttons.

*Edit* only shows up as a soft key if the custom control button currently selected in the System Control Group has already been programmed with a macro.
Custom Control Banks Menu Tree

The following figure illustrates the portion of the Synergy menu tree that is used for setting up Custom Control banks.
Disk Menu Tree

The following figure illustrates the *portion* of the menu tree that is used for saving and recalling switcher setups.
Recall Factory Menu Tree

The following figure illustrates the portion of the menu tree that is used for recalling factory default settings.
Appendix B. How Do I…

In This Appendix

This appendix provides a series of tutorials to familiarize you with using a Synergy switcher. You may choose to work through the entire series of tutorials in order or to only complete certain tutorials which are of interest to you. Note, however, that some tutorials are organized into a series where later tutorials rely on techniques learned in previous tutorials. These series should be completed in order to get the most benefit from them.

The tutorials in this appendix are:

- How do I…
  - Smoothly Move a Key
  - Create a 3D Over-the-Shoulder Box and Save it for Reuse
  - Move a 3D Over-the-Shoulder Box
  - Make an Effect Repeat Indefinitely
  - Connect Serial Devices Via the Remote Port Expander
  - Set Up Communications for the Remote Port Expander
  - Connect Devices to the Panel through the Remote Port Expander
  - Create a Six-Box Effect and Save it for Reuse
  - Build Sequences for a Six-Box Effect
  - Build Custom Controls to run a Six-Box Effect
  - Run a 6-Box Effect
Saving switcher states in memory registers allows you to quickly recall settings that would take too long to recreate on the fly during a live production. But, when you recall a memory register, the switcher instantly jumps to the saved-state. An abrupt change like this is often not what you want. How can you get the switcher to smoothly move from one memory register to another? You use Effects Dissolve.

This tutorial shows you how to save two memory registers and then use Effects Dissolve to smoothly move between them.

**Before you begin:** You need a Synergy switcher with at least one free MLE, two free memory registers, and three video sources: one for the background and one each for the front and side of the object (we will be using today’s and tomorrow’s weather forecasts but you can use whatever you want). The free MLE must be correctly set up so you can view your work on-screen.
1. We'll be using a blank background in this tutorial to more clearly show the movement of the key, but you can use any background you wish. So, on the BKGD bus of the MLE that you are working on, press the source button that has your desired background.

2. Use Key 1 to create a key. We'll use a weather forecast graphic as a source. Assign the Key bus to Key 1 by pressing Key 1 in the MLE Transition Group. Then, press the crosspoint button on the Key bus that has the graphic for the forecast. This graphic typically comes from a character generator or a still store.

To move it around the screen, you must fly the key. Press PST PATT and notice how the FLY KEY button automatically activates. Your key is now flying. Also notice how the S&T Position/Crop Menu 1-2 is displayed.
3  Press **Position** and then use the Positioner (or rotate the X, Y, and Z knobs) to position the key to look something like the image to the right. You’ll have to move the object to the right and up (X, Y) as well as away from you (Z) to get it to appear smaller.

![Object Moved to Top Right](image)

Notice how the menu display reflects the object’s on-screen position.

![Menu Mirrors Object Position](image)
Store this set-up in a free memory location by using the **Global Memory System Group**. Press the **ALL** button in the **Store** column of the **Global Memory System Group**.

**Synergy 1** users, press the **Store** button in the **Global Memory System Group**.

We will use memory registers 90 and 91 for this tutorial, but you can use any two free registers on your switcher.

Press and hold **Bank** and then press 9 to select **Bank 9**. Release the **Bank** button and press 0 to select **Register 1** within the bank. Finally, press **Enter** to store the set-up.

---

**Object Position 1**

<table>
<thead>
<tr>
<th>Change Memory Name</th>
<th>Horizontal</th>
<th>Vertical</th>
</tr>
</thead>
<tbody>
<tr>
<td>a b c d e f g h i j k l m n o p q r s t u v w x y z</td>
<td>(9B) Memory</td>
<td></td>
</tr>
<tr>
<td>A B C D E F G H I J K L M N O P Q R S T U V W X Y Z</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0 1 2 3 4 5 6 7 8 9 + - _ &amp; * ( ) / . ? ' &quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Current Name:** Memory90

**New Name:** Memory91

---

Press **FLY KEY 1** in the **Positioner Control Area** to return to the **S&T Position/Crop Menu 1-2**.

---

Notice the default name given to the memory register. You can change this name to something more meaningful if you wish. See the gray box at the beginning of this tutorial for reference information.
6 Press **Position** and move the object down to the bottom left of the screen.

6

7 Store the object’s position and rotation in another memory register. Repeat the process from **step 4** but make sure you choose a different memory register (it is convenient to store the two object positions in sequential memory registers).

7

8 Now that you have stored the two positions of your key, you can quickly cut between them by recalling the two memory registers.

8

Recall the first memory register using the **Global Memory System Group**. Press the **ALL** button (Synergy 1 users, press the **RECALL** button) in the **Global Memory System Group**.

Press and hold **Bank** and then **9** to select Bank 9. Release the **Bank** button and press **0**. Your stored set-up is recalled.
Now, recall the second memory register. Since our second memory register is in the same bank as the first one, we don’t need to press the BANK button. Just press 1 (Bank 9, Register 1) to instantly recall the second memory register.

Notice how the on-screen image cuts between memory settings. We want the key to gracefully slide between positions and that’s where an Effects Dissolve comes in.

Press EFF DISS in the Global Memory System Group and recall each of the two memory registers as you did in the two previous steps.

Notice how your object smoothly slews between the positions that were saved in each memory register. An Effects Dissolve smoothly transitions between two states rather than cutting between them.

This tutorial showed you how you can smoothly move a key by using memory registers and Effects Dissolve. You are not limited to just moving keys around, however. Any analog effect (border color, clip levels, position and rotations, etc.) can slew between a current setting and a newly recalled setting so you can produce some complex effects. Non-analog values (key priorities, crosspoints, next transition data, etc.) do not slew smoothly so keep that in mind when designing your effects.
Television shows, especially news broadcasts, often need to show additional information that supports the material being presented by the talent. Take a weather forecast, for example. You could have the weather forecaster in the background with an over-the-shoulder box showing the forecast. You could go one step further and make the box 3D. The box will show today’s forecast for 5 seconds, then rotate to show tomorrow’s forecast for 5 seconds. Then, it will rotate back to today’s forecast for 5 seconds and so on…

The next three tutorials will demonstrate the fundamental techniques for producing this effect and you will then be able to tailor these techniques to your own use. These tutorials can get a bit complex for a beginner, so take a few moments between each one to review what you just learned before moving on to the next. Let’s get started…

**How do I… Create a 3D Over-the-Shoulder Box and Save it for Reuse**

Creating an Object and Storing Configurations in a Memory Register

---

**Need more Information on…**

- **Flying Keys**, see Synergy Operation Guide, Ch. 7
- **Objects**, see Squeeze & Tease 3D / WARP Owner’s Guide, Ch. 10
- **Memory Registers**, see Synergy Operation Guide, Ch. 8
- **Effects Dissolve**, see Synergy Operation Guide, Ch. 8

---

Have you ever noticed how two flying keys move independently? Rotating one key does not rotate the other. How about a two-channel key? Each channel moves independently of the other. What if you wanted a two-channel key where each channel could be independently positioned and then locked so that as you moved and rotated the key, both channels moved and rotated in unison? You need an object.

An object is made of one or two channels that are controlled in unison and retain their relative position to each other. This tutorial introduces you to objects. You will learn how to create an object and how to position it in 3D space. You will also learn how you can use memory registers to store the object and recall it for later re-use.

---

**Before you begin:** You need a Synergy switcher with at least one free MLE, two free memory registers, and three video sources: one for the background and one each for the front and side of the object (we will be using today’s and tomorrow’s weather forecasts but you can use whatever you want). The free MLE must be correctly set up so you can view your work on-screen. Your switcher must also be equipped with the **Squeeze & Tease 3D / WARP** option for the MLE you will be working with.
First, we need some background video. Since we are creating a weather forecast box, some video of a meteorologist is ideal. So, on the BKGD bus of the MLE that you are working on, press the source button that has the shot of the meteorologist (probably a camera).
Use **Key 1** to create a key with today’s weather forecast as the source.
Assign the Key bus to **Key 1** by pressing **Key 1** in the **MLE Transition Group**.
Then, press the crosspoint button on the Key bus that has the graphic for today’s forecast. This graphic typically comes from a character generator or a still-store.

To build an object, you must fly the key. Press **PST PATT** and notice how the **FLY KEY** button automatically activates. Your key is now flying. Also notice how the **S&T Position/Crop Menu 1-2** is displayed.
You’re ready to start creating an object. Navigate to the S&T Object Builder Menu by pressing UP ONE to display the Squeeze & Tease WARP Main Menu 1-2. If you see the Squeeze & Tease WARP Main Menu 2-2, press MORE to get to the Squeeze & Tease WARP Main Menu 1-2.

Now, press Object Builder to display the S&T Object Builder Menu.

The Object Builder Menu contains a number of solid shape presets that you can use for your object. One of the presets is the front and left side of a 3D box. Just what we need!

Use the middle Object Builder knob to select Front & Left.
5 Press **Create Preset Object** and your object is created.

Notice how the menu displays the left-side face as active (it should be flashing). Go ahead and assign tomorrow’s forecast to the left-side face by pressing the crosspoint button for tomorrow’s forecast on the Key bus.

Since you are building two sides of a box with video on each side, you need two channels to build your object. When you created the object, the front face of the box was automatically assigned to channel 1. The switcher also automatically selects channel 2 and the left face for you.

---

6 With both video sources assigned to your new object, you’re ready to build it. Press **Build**.

You won’t see any changes on-screen because creating an object does not actually make your object appear on-screen. The object is created from a system-sense but you must still build the object to be able to see and control it. You’ll do that in the next step.

---

Notice how the menu displays the channel that you are working with. In this case, **O1** (Object 1) is highlighted. Also note that Channels 1 and 2 are black indicating that they are active.

You still won’t see any difference on-screen because your newly built object has no rotation applied. You’re looking straight at the front face. But, now you can move the object around and reveal both faces.
Press **Position** and then use the Positioner (or the X, Y, and Z knobs) to position the cube to look something like the image to the right. You’ll have to move the object to the right and up (X, Y) as well as away from you (Z) to get it to appear smaller.

![Image of object moved to correct location]

**Object Moved to Correct Location**

Notice how the menu display reflects the object’s on-screen position.

![Menu showing mirrored object position]

**Menu Mirrors Object Position**

Press **Rotation** and then use the Positioner to rotate the object until you get your first glimpse at the 3D nature of your object.

![Image of first glimpse at 3D object]

**Your First Glimpse at the 3D Object**
Now, let’s put this object to work. We want to start with an unrotated object, so rotate it back to show only the front face. The X co-ordinate should be .000.

Since we’re setting this object up for use in later tutorials, press KEY 1 in the MLE Transition Group for the MLE you are working with. Only the KEY 1 button should be lit.

Selecting KEY 1 in the MLE Transition Group ensures that only Key 1 will be set to air when you recall this memory register. This allows you to transition your object over any background that is currently on-air.

Store this set-up in a free memory location by using the Global Memory System Group. Press the ALL button in the Store column of the Global Memory System Group. Synergy 1 users, press the Store button in the Global Memory System Group.

We will use memory registers 90 and 91 for this tutorial, but you can use any two free registers on your switcher.

Press and hold Bank and then press 9 to select Bank 9. Release the Bank button and press 0 to select Register 0 within the bank. Finally, press Enter to store the set-up.

Notice the default name given to the memory register. You can change this name to something more meaningful if you wish. See the gray box at the beginning of this tutorial for reference information.
11 Press **FLY KEY 1** in the Positioner Control Area to return to the S&T Position/Crop Menu 1-2.

![Synergy 3 Positioner Control Area](image)

12 Swing tomorrow’s forecast into view by rotating the object to display the left face. Press **Rotation** (if it’s not currently selected) and then rotate your object until you are looking squarely at tomorrow’s forecast.

![Tomorrow’s Forecast Rotated into View](image)

13 Store the object’s position and rotation in another memory register. Repeat the process from **step 10** but make sure you choose a different memory register (it is convenient to store the two object positions in sequential memory registers).
Now that you have stored the two views of your object, you can quickly cut between them by recalling the two memory registers.

Recall the first memory register (the one that shows today’s forecast) using the **Global Memory System Group**. Press the **ALL** button (Synergy 1 users, press the **RECALL** button) in the Global Memory System Group.

Press and hold **Bank** and then **9** to select **Bank 9**. Release the **Bank** button and press **0**. Your stored set-up is recalled.

Now, recall the second memory register. Since our second memory register is in the same bank as the first one, we don’t need to press the **BANK** button. Just press **1** (**Bank 9, Register 1**) to instantly recall the second memory register.

Notice how the on-screen image cuts between memory settings. That’s not really the effect we’re after, however. We want the box to pause briefly, rotate, pause again, and rotate back. And, we want this to happen automatically so we don’t have to constantly recall memory registers when it’s time to rotate the box. What we need is a sequence and that’s what you will create in the next tutorial.
This tutorial introduced you to the concept of objects and how you use them to combine multiple channels so they act in unison. You learned how to store configurations in memory registers and recall them for re-use. Finally, you saw how recalling memory registers instantly cuts between saved-states.

The next tutorial shows you how to smoothly transition between multiple states automatically, by using a sequence. When you’re ready, go on to the next page…
The previous tutorial showed you how to build an object, store it in a memory register and recall it for re-use. The next step in our weather forecast example is to have our object smoothly rotate between today and tomorrow’s forecast and to pause a set amount of time between each rotation. But, how do you guarantee the pauses will be consistent and the rotations will be initiated at exactly the right time? You use a sequence.

A sequence is a series of events that can be created, saved, and run from the switcher. You can use any 3D function to manipulate the keys and objects in a sequence. You create a sequence by specifying a series of keyframes that define the state and location of an object or key in 3D space. The system interpolates (fills-in) the frames between the keyframes to produce fluid motion. This tutorial teaches you how to create a sequence that smoothly rotates the object you created in the previous tutorial and pauses between rotations to allow you to see each object face.

**Before you begin:** You need a Synergy switcher with at least one free MLE and the object you created in the previous tutorial (if you’re not doing the tutorials in order, you need to build a **Front & Left** preset object). The free MLE must be correctly set up so you can view your work on-screen. Your switcher must also be equipped with the **Squeeze & Tease 3D / WARP** option for the MLE you will be working with.
As you construct a sequence, you create a number of keyframes which define the paths that the keys and objects will traverse.

The sequence for this tutorial requires five keyframes: the first and second showing your object with today’s forecast facing forward, the third and fourth with the object rotated to show tomorrow’s forecast, and finally, the fifth keyframe shows today’s forecast again. You’ll see why we use duplicate keyframes later on in the tutorial.

The first keyframe is already prepared. Remember, you stored it in the first memory register in the last tutorial. Recall it now (see step 14 of tutorial 2 if you don’t remember how to recall a memory register).

If you can see the S&T Position/Crop Menu 1-2, go on to the next step, otherwise, press FLY KEY to display it.
3. Make sure you are working with your object (and not one of the two individual channels). Press **Channel** repeatedly until O1 is highlighted.

4. Press **UP ONE** to display the Squeeze & Tease WARP Main Menu 1-2. Then, press **Sequence** to display the S&T Sequence Menu 1-2.

5. What you have on-screen is what you want for the first keyframe. Press **Insert Keyframe** to create it.

The sequence menu updates to show the newly added keyframe in the timeline.
6 We want today’s forecast to display for a few seconds before moving to tomorrow’s forecast. Press **Insert Keyframe** again to create another keyframe identical to the first.

![Second Keyframe](image)

**Sequence Timeline Showing Second Keyframe**

Sequences do not support pausing for a specified duration so we simulate a pause by creating a new keyframe where the object does not move and setting the duration to the amount of time you wish to pause. The sequence will keep running but will appear paused since there is no change in the object between the two keyframes.

7 Press **Duration** if it’s not already lit. Notice how the duration for this second keyframe is set to 30 frames. We want today’s forecast to display for 5 seconds so we need to change the duration.

Turn the middle **Frames** knob to set a duration of 150 frames (5 seconds).

You need to overwrite the keyframe you created in the previous step to update it with the new duration. Press **Overwrite Keyframe** to update the keyframe.

![Keyframe 2 with 150 Frame Duration](image)

You can always overwrite a keyframe if you realize you made a mistake when creating it. You can use the **Previous Keyframe** and **Next Keyframe** buttons to move between keyframes if you need to change more than one.
8 Now, it’s time to rotate the object to display tomorrow's forecast. To do so, you must return to the S&T Position / Crop 1-2 Menu.

Press DVE in the Positioner Control Area to return to the Squeeze & Tease WARP Main Menu 1-2. Then, press Position / Crop to display the S&T Position / Crop 1-2 Menu.

Press Rotation and use the Positioner to rotate the object as shown at right. Rotate the object until you see tomorrow’s forecast.

9 Rotating to Tomorrow’s Forecast
10 Press DVE in the Positioner Control Area to return to the S&T Sequence Menu 1-2.

Press Duration (if it’s not already lit) and then turn the middle Frames knob to set a duration of 30 frames (1 second).

You now have your object set for the third keyframe. Insert it by pressing Insert Keyframe.

Next Keyframe

We want tomorrow’s forecast to display for five seconds (just like today’s forecast).

First, turn the middle Frames knob to set a duration of 150 frames (5 seconds). Now, press Insert Keyframe to create another keyframe identical to the previous one.

Notice that by setting the duration before adding the keyframe, you don’t have to correct the duration and then overwrite the keyframe.
Since this sequence is going to become a loop in the next tutorial, we need to add a final keyframe that is identical to the first.

Press DVE in the Positioner Control Area to return to the S&T Position / Crop 1-2 Menu.

Press Rotation and use the Positioner to return your object to today’s forecast. The X coordinate should be .000.

To make a seamless loop, the final keyframe must be identical to the first keyframe so as the sequence replays, you don’t notice the jump from the last keyframe to the first.

Press DVE in the Positioner Control Area to return to the S&T Sequence Menu 1-2.

Press Duration (if it’s not already lit) and then turn the middle Frames knob to set a duration of 30 frames (1 second).

Insert the final keyframe by pressing Insert Keyframe.
15 Your sequence is now complete and needs to be saved. Press Load/Save Sequence to display the S&T Sequence Load/Save Menu.

Turn the middle Sequence knob to select the sequence number in which to save your sequence (We’re using sequence 99 in the image to the right).

Finally, press Save Sequence to save the sequence.

16 Okay, now that you have saved your sequence, try running it to see how it looks.

Press DISS + WIPE + DVE SEND in the MLE’s Transition Group to access the S&T Runtime Menu. If you see a list of Squeeze & Tease wipes instead of the menu, press DISS + WIPE + DVE SEND a second time to access the S&T Runtime Menu.

Notice how the slot your sequence was saved in is now marked with an asterisk (*). Any slot containing a sequence is marked similarly.

The switcher gives your sequence a default name but you can rename it if you wish. See the gray box at the beginning of this tutorial for reference information.

The S&T Runtime Menu shows the timeline of the current sequence. Each keyframe is marked by a vertical line and the total run-time of the sequence is displayed as well.
17 Press **Auto Trans** in the MLE’s Transition Group and watch as your object starts at today’s forecast, pauses, and rotates to tomorrow’s forecast where it waits again. Finally, it returns to today’s forecast.

The object smoothly rotates between the two forecasts. Something isn’t quite right, though. Notice how the sequence appears to start slowly, then accelerates to the middle. Then, it appears to slow towards the end.

What you’re seeing is called **smooth** motion between keyframes. The switcher automatically calculates acceleration and deceleration values based on the length of the sequence and applies them to give a smooth start and finish.

We don’t really want that, however. We want the box to pause for the exact amount of time we specified, then rotate with no acceleration. We need to switch the motion of our sequence from **smooth** to **linear**.

18 Press **UP ONE** to return to the S&T Sequence Menu 1-2.

Notice how the name of the sequence now appears above the timeline. Once a sequence is saved, it is referred to by name rather than a number.

Double-press (press twice rapidly) **Previous Keyframe** to move to your sequence’s first keyframe.

19 Press **Duration** (if it’s not already lit) and then turn the top **Type** knob to **Linear**.

Now, press **Overwrite Keyframe** to update the keyframe.

20 Press Auto Trans in the MLE’s Transition Group and watch as your object starts at today’s forecast, pauses, and rotates to tomorrow’s forecast where it waits again. Finally, it returns to today’s forecast.

The object smoothly rotates between the two forecasts. Something isn’t quite right, though. Notice how the sequence appears to start slowly, then accelerates to the middle. Then, it appears to slow towards the end.

What you’re seeing is called **smooth** motion between keyframes. The switcher automatically calculates acceleration and deceleration values based on the length of the sequence and applies them to give a smooth start and finish.

We don’t really want that, however. We want the box to pause for the exact amount of time we specified, then rotate with no acceleration. We need to switch the motion of our sequence from **smooth** to **linear**.

Press UP ONE to return to the S&T Sequence Menu 1-2.

Notice how the name of the sequence now appears above the timeline. Once a sequence is saved, it is referred to by name rather than a number.

Double-press (press twice rapidly) **Previous Keyframe** to move to your sequence’s first keyframe.

Press **Duration** (if it’s not already lit) and then turn the top **Type** knob to **Linear**.

Now, press **Overwrite Keyframe** to update the keyframe.
21 Press **Next Keyframe** and repeat the previous step to overwrite the next keyframe. Do this for each keyframe in the sequence.

22 Press **Load/Save Sequence** to display the S&T Sequence Load/Save Menu.

We want to overwrite our sequence so turn the middle **Sequence** knob to select the same sequence position you used previously (99 in this case). You can tell which sequence registers have saved sequences by the asterisks (*) next to their names.

Finally, press **Save Sequence** to save the sequence.

Notice the asterisk next to our sequence name indicating that it has been previously saved.

23 Now, rerun the sequence to see the effect of changing motion types to **linear**.

Press **DISS + WIPE + DVE SEND** in the MLE’s **Transition Group** to access the S&T Runtime Menu. If you see a list of Squeeze & Tease wipes instead of the menu, press **DISS + WIPE + DVE SEND** a second time to access the S&T Runtime Menu.
This tutorial showed you how to use keyframes to define a sequence. You learned that a sequence can have many keyframes and move smoothly between them. You learned how to simulate a pause in the sequence by inserting duplicate keyframes with a duration set to the amount of time you wish to pause the sequence. You also learned how to edit an existing keyframe and overwrite it in the sequence. Finally, you learned that to use a sequence in a loop, the final keyframe must be identical to the first keyframe.

The next tutorial shows you how to use this sequence in a custom control that repeatedly loops back upon itself until you take it off-air. This self-looping custom control is a great way to create repeating effects that require little user intervention. After you take some time to review how you built your sequence, go on to the next page...
The previous two tutorials have been building up to this one. Custom controls are great for creating complex effects that would be difficult to reliably reproduce on-the-fly. But, what happens when you need an effect that repeats over-and-over until you turn it off? You don’t want to manually replay a custom control many times while still taking care of the rest of your show. What you need is a looping custom control!

This tutorial shows you how to build a looping custom control that loops back on itself, effectively creating a continuously-playing series of events. Are you starting to see the usefulness of looping custom controls? Continuing our idea of the weather forecaster and the continuously rotating box displaying today and tomorrow’s forecasts, you’ve already built the object and made a sequence to rotate it. All you need now is a looping custom control to make it rotate indefinitely. There is a bit of a trick to getting a loop into a custom control, however, and you will learn about that as well.

**Before you begin:** You need a Synergy switcher with at least one free MLE, at least three free custom control buttons, the sequence you created in the previous tutorial, and the object you created in the tutorial prior to that. The free MLE must be correctly set up so you can view your work on-screen. Your switcher must also be equipped with the **Squeeze & Tease 3D / WARP** option for the MLE you will be working with.
To prepare for the custom control, recall the first memory register that you have been working with for the previous two tutorials (Register 90 in this case). See step 14 in tutorial 2 for information if you need help recalling a memory register.

Recalled Memory Register

If you want to recall the object over a different background, press KEYS ONLY in the Global Memory System Group before recalling the memory register. Doing so, will not recall the background crosspoint that was active when the memory was saved.

Now you’re ready to actually start creating a custom control. Navigate to the Custom Control Menu by pressing HOME and then Custom Controls.
3 Choose a Custom Control bank and button to assign the custom control to by using the **Bank** and **Button** knobs or by pressing the actual Custom Control button directly on the panel. For this tutorial, we’ll use **Bank 8** and **Button 24**.

4 Press **Start Recording** to begin recording a custom control.

5 Now that recording has begun, execute the actions you wish to record.

First, recall the sequence you created in the previous tutorial. Although it was activated by recalling the memory register, press **PST PATT** in the **Key 1 Control Group** of the MLE you are using. This will display the **S&T Position / Crop Menu 1-2**.

Navigate to the **S&T Sequence Menu 1-2** by pressing **UP ONE** to get to the **Squeeze & Tease WARP Main Menu 1-2** and then **Sequence** to display the **S&T Sequence Menu 1-2**.

You press **PST PATT** to quickly access the Squeeze and Tease menu system and not to set the key type; **Key 1** should already be a Preset Pattern key.
6 Press Load / Save Sequence.

You should see the S&T Sequence Load / Save Menu.

```
S&T Sequence Load / Save
MLE 1 Key 1
Sequence: Sequence 99 (99)
Duration: 00:12:00
Keyframes: 5
Channels: 2
Objects: 1 2

Please do NOT power down frame for three minutes after modifying a sequence.

Load  Save  Delete  Rename
Sequence  Sequence  Sequence
```

S&T Sequence Load / Save Menu

7 Rotate the middle Sequence knob to select the correct sequence from the list (Sequence 99 if you completed the previous tutorial) and then press Load Sequence.

The sequence loads and you are returned to the S&T Sequence Menu 1-2.

```
S&T Sequence (1-2)
MLE 1 Key 1
Type: Linear
Channel 1: Live Video
Weather: (BNC 67)
Channel 2: Live Video
Still 1: (BNC 68)
Object 1: On
Object 2: Off
Sequence 99
Sequence 1 Rate: 00:12:00

Key 1

Keyframes: 5
```

Loaded Sequence

8 It takes a finite amount of time to actually load the sequence from memory, so you must add a slight delay in the custom control to allow the switcher to catch up.

Press HOME and then Custom Controls to return to the Custom Controls Menu.

Notice how the Custom Controls Menu indicates that your actions are still being recorded.

```
Custom Controls
Recording...
Bank: (7)
Selected: Bank 8 Button 24 [Custom24]
Button: (7)
Custom Control Legend:
0 - normal custom control button
```

Custom Controls Menu – Still Recording
9 Press **Insert Special** to display the **Insert Special Menu 1-2**. Then, press **Special** to display the **Special Menu**.

10 Rotate the top **Selection** knob to select **Pause CC**.

You can specify a pause in either seconds or frames but since it only takes a few frames to load a sequence, rotate the bottom **Frames** knob to **10** frames.

Press **Insert** to add the pause to your custom control and you will be taken back to the **Insert Special Menu 1-2**.

---

Synergy Series Operation Guide (v18)  
Appendix B. How Do I... • 17–33
Now that the sequence is loaded, it’s time to play it.

Press **DISS + WIPE + DVE SEND** in the MLE’s **Transition Group** to access the **S&T Runtime Menu**. If you see a list of Squeeze & Tease wipes instead of the menu, press **DISS + WIPE + DVE SEND** a second time to access the **S&T Runtime Menu**.

If you see this...

```
Squeeze & Tease
SpiralIn (41) WalkDown (43) Flare 2 (45) SepiaSpin (47) LensCntr (48)
(49) SpiralOut (42) Flare 1 (44) SpinV Up (46) Photo (48) MelISpin
MitEdgeIn (51) SlitSpin (53) Beam Up (55) PivotOn (57) SlabRt (50)
(59) SandLeft (52) Splitting (54) HardenLt (56) SlaBlRt (50) CubePush
FlagHve (61) PropelR (63) Splitting (65) Mirror 2 (67) RollBox (60)
(69) IceBox (62) QuadMirror (64) Intersect (66) CubeRotX (68) FourChns
2D Back (71) BoxDown2 (73) CoolWipe (75) Intersec (77) Award3 (79)
(78) 3D Back (72) CoolSlab (74) Chronsq (76) Award2 (78) Award4
```

...press **DISS + WIPE + DVE SEND** again to get to this...

```
S&T Runtime
```

```
S&T Runtime Menu
```

```
MLE 1 TRANSITION
```

```
Transition Group
```

```
```

```
```

```
```
12 Press **Auto Trans** in the MLE’s **Transition Group**.

Your sequence runs and is added to the custom control.

13 Now, it’s time to make the custom control loop. Since your sequence ends in the exact state that it begins, you can seamlessly replay it to create an endless rotation between forecasts.

Pressing **CUST 23** tells the custom control you are recording to play that custom control. Calling another custom control must be the last recorded event so notice how your custom control stops recording and you are taken back to the **Custom Controls Menu**.

Notice the asterisk (*) beside button 24. It indicates that our custom control is assigned to that button. Notice how there is no asterisk beside button 23. We set our custom control to call custom control 23 and now we have to define it.

Also note the default name given to your custom control. You can change this name to something more meaningful if you wish. See the gray box at the beginning of this tutorial for reference information.
Custom Control 23 is the looping mechanism. Since there is no direct way to make a custom control call itself, we made our custom control 24 call custom control 23. To loop, we make custom control 23 do nothing except call custom control 24.

Rotate the middle Button knob up to Custom23 and then press Start Recording.

The only thing we want this custom control to do is to call our previously recorded one.

Press the CUST 24 button to call Custom Control 24.

You’re done! Press HOME to return to the Main Menu 1-2.

Now, press CUST 24 in the Custom Controls Group to activate your looping custom control.

The box seamlessly rotates between today and tomorrow’s forecast indefinitely.
This tutorial showed you how to build a looping custom control that used the sequence and object you built in the previous two tutorials to create a repeating animated effect. You also learned that while a custom control cannot directly call itself, you can use two custom controls to create a loop and effectively create an endless custom control.

How could you use this effect? You could dedicate an MLE to running the looping custom control. Then, using re-entry, transition the object to air before initiating the custom control. When it’s time to stop, transition the MLE off-air and then stop the custom control.

The previous three tutorials have demonstrated how to produce a looping 3D effect. We used the example of a box displaying weather forecasts but you could use whatever you want. Using the techniques described in these tutorials, you can now create any number of looping 3D effects to enhance your broadcasts. Take some time to review the three tutorials and think about how you can apply them to your own programming needs.
Synergy control panels can interface with many video production serial devices including VTRs, DVEs, Servers, Routers, Still Stores, Audio Mixers, Character Generators, Robotic Cameras, and more. Before long, your facility may be using all the serial ports on the panel (5 for a Synergy 1 and 8 for a Synergy 4) and need more inputs. For this reason, the Synergy BSS4 Remote Port Expander is available. Plugged into one of the control panel remote ports, it provides four additional inputs so your Synergy switcher can interface with more devices.

Note that you cannot control a 360 Systems DigiCart Audio Server from a remote port on a BSS4. If you want to connect this device to the Synergy switcher, you will have to use a standard remote port.

This tutorial set will show you how to set up a BSS4 and program it to connect devices to the panel through each port.

Let's get started…

---

**How do I…**

**5 Connect Serial Devices Via the Remote Port Expander**

Connecting the BSS4 to the Synergy Control Panel

---

**Need more Information on...**

Remote Port Expander Cabling, see Synergy Installation Guide, Appendix C

---

**Before you begin:** For each Synergy control panel remote port you want to add a BSS4 to, you will need: a BSS4 Remote Port Expander, a 5V 100mA power supply and a 9-pin male-to-female cable supporting RS-422 communication

---

1 First, we need to decide where to locate the BSS4. This depends where your serial devices are located in relation to the Synergy switcher. Extension cables to the devices from the BSS4 can also be used.

Install it where you can access it later, during the configuration stage of the tutorials.
If you want to make a special RS-422 9-pin cable for connecting the BSS4 to the panel, the table on the right indicates the proper internal wiring connections.

Note that the BSS4 only supports RS-422 inputs. If your devices are using RS-232, you will need an adapter between the device and the BSS4.

Plug the AC power adapter unit to a supply source and plug the power connector into the BSS4’s Power socket.

Plug the male end of the 9-pin cable into the available panel remote port.

Plug the female end into the Master Port on the BSS4.

That’s it for cable connections.

This tutorial showed you how to connect the BSS4 to the Synergy control panel. Now, we need to set up the communications protocols on the switcher in order to use the Extended Remote Ports on the BSS4. You’ll do that in the next tutorial. Take a few minutes to review the setup procedure you just completed, and then go on to the next page.
The previous tutorial showed you how to physically connect the BSS4 to the panel. Now, we will configure the panel to recognize the BSS4 and its four slave ports.

Before you begin: You need a Synergy switcher with one remote port connected to an AC powered BSS4.

1. On the panel front, use the System Control Group to display the Communications Menu 1-2.
   - Press HOME to display the Main Menu 1-2.
   - Press MORE to display the Main Menu 2-2.
   - Press Setup to display the Setup Menu.
   - Press Installation to display the Installation Menu 1-2.

2. Press Communications to display the Communications Menu 1-2.
   - Use the top Com Port knob to select the port you connected the BSS4 to in the previous tutorial
   - Use the middle Device knob to select Expander.
3. Now you’re ready to assign the BSS4 to the Expander communications port. Press Type to display the Type Menu.

Use the top Com Port knob to select the remote port you have connected the BSS4 to.

Use the middle Device knob to select BSS4.

4. Press Com Settings to display the Communications Settings Menu.

Use the top Com Port knob to select the remote port you have connected the BSS4 to.

Use the middle Baud knob to select 115200 as the baud rate for the BSS4.

The bottom Parity knob is fixed at NONE.

5. Press Com Type to display the Communications Type Menu.

Select the type of serial communications that will be used to communicate with the BSS4 as follows:

Use the top Com Port knob to select the remote port you have connected the BSS4 to.

Use the middle Type knob to select RS-422 as the type of serial communication for the selected port.

The BSS4 will only support RS-422 communication, RS-232 devices will require a RS-422 to RS-232 converter.
This completes the procedure for configuring the Synergy control panel and a BSS4 Remote Port Expander. The BSS4 slave ports are now visible in the switcher’s menus and are ready for use. The next tutorial will show you how to install a remote serial device to the switcher via the BSS4. When you’re ready, go on to the next page.

6 Press HOME to display the Confirm Changes Screen.

Press Confirm to accept the changes you have made to the communications set up of the switcher.

Don’t press Continue yet. You must first do some setup on the BSS4, as outlined in the next step.

When you press Confirm, a second screen will be displayed prompting you to program the BSS4 Remote Port Expander.

7 On the BSS4, move the Set Up Switch to PROG.

Now disconnect and reconnect the BSS4 Power Supply to cycle the power Off and back On.

A menu screen informs you that the BSS4 Remote Port Expander has been successfully programmed.

8 Now press Continue on the Synergy control panel.

If you get an error message stating that the BSS4 could not be programmed, confirm your settings and try to program the BSS4 again.

9 On the BSS4, move the Set Up Switch back to NORM.

Now disconnect and reconnect the BSS4 Power Supply from the BSS4 to cycle the power Off and back On.

Notice the four new remote ports on the Communications Menu 1-2. These ports are labelled A, B, C and D, corresponding to the Slave Ports on the BSS4, and start with the number of the remote port that the BSS4 is connected to.
Synergy Series Operation Guide (v18) Appendix B. How Do I… • 17–43

A serial device is connected and set up through a BSS4 port the same way it is done on any other panel remote port. You connect the device to the port on the BSS4, select that port on the Communications Type Menu, and follow the procedures for connecting that device.

The previous two tutorials have been building up to this one. This tutorial shows you how to configure the Synergy switcher to communicate with serial devices through the BSS4.

Before you begin: You need a Synergy switcher with a BSS4 connected, and its ports visible in the panel menus.

1. As we saw at the end of the last tutorial, there are four new remote ports on the Communications Menu 1-2.

   If the BSS4 is connected to Remote Port 6 on the control panel, then the four Extended Remote Ports will be Remote 6A, Remote 6B, Remote 6C, and Remote 6D.

2. We assign devices to the new remote ports the same way we assigned the BSS4 to a port in the last tutorial. First, navigate to the Communications Menu 1-2.

   Press Type to display the Type Menu.

   Use the top Com Port knob to select the BSS4 port you want to assign a device to.

   Use the middle Device knob to select a peripheral device.

Need more Information on...

BSS4 Communication Setup, see Synergy Installation Guide, Ch. 7

Communications (1-2)

<table>
<thead>
<tr>
<th>Type</th>
<th>Select</th>
<th>Device</th>
<th>Com Port</th>
<th>Extra Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>REMOTE 6A</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>REMOTE 6B</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>REMOTE 6C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>REMOTE 6D</td>
<td></td>
</tr>
</tbody>
</table>

Communications — Expander Remote Ports

Communications (1-2)

<table>
<thead>
<tr>
<th>Type</th>
<th>Select</th>
<th>Device</th>
<th>Com Port</th>
<th>Extra Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>REMOTE 6A</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>REMOTE 6B</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>REMOTE 6C</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>REMOTE 6D</td>
<td></td>
</tr>
</tbody>
</table>

Communications — Select Type Menu

A router is selected in this example.
3 Press **Select Device** to display the **Select Device Menu**.

Use the top **Com Port** knob to select the BSS4 port you connected a device to.

Use the middle **Device** knob to select a peripheral device.

4 Press **Com Settings** to display the **Communications Settings Menu**.

Use the top **Com Port** knob to select the BSS4 port you want to assign a device to.

Use the middle **Baud** knob to select the baud rate for the device.

Use the bottom **Parity** knob to select the baud rate for the device.

5 Press **Com Type** to display the **Communications Type Menu**.

Use the top **Com Port** knob to select the BSS4 port you want to assign a device to.

Use the middle **Type** knob to select **RS-422** as the type of serial communication for the selected port.

6 Press **HOME** to display the **Confirm Changes Screen**.

Press **Confirm** to accept the changes you have made to the communications set up of the switcher.

Don’t press **Continue** yet. You must first do some setup on the BSS4, as outlined in the next step.

The BSS4 ports **only** supports RS-422 communication, RS-232 devices require a RS-422 to RS-232 converter.

When you press **Confirm**, a second screen is displayed, prompting you to program the BSS4 Remote Port Expander.
7 On the BSS4, move the **Set Up Switch** to **PROG**.

Now disconnect and reconnect the **BSS4 Power Supply** from the BSS4 to cycle the power Off and back On.

---

8 Press **Continue** on the Synergy control panel.

If you get an error message stating that the BSS4 could not be programmed, confirm your settings and try to program the BSS4 again.

---

9 On the BSS4, move the **Set Up Switch** back to **NORM**.

Now disconnect and reconnect the **BSS4 Power Supply** to cycle the power Off and back On.

---

This tutorial showed you how to configure the Synergy switcher and the BSS4 Remote Port Expander to communicate with peripheral devices through the added remote ports. The previous three tutorials have taken you through all the steps necessary to connect and configure a BSS4 Remote Port Expander.
News broadcasts, especially those including a panel discussion, often need to show the individuals being interviewed by the host. You could have the talent in the first Box with the individuals in a separate box. Add as many boxes for individuals, even as many as six including the host. Then you may want to bring a box forward to full screen to emphasize an important discussion topic. Or you may want to bring the host forward each time a question is posed to the group.

The next three tutorials will demonstrate the fundamental techniques for producing this effect and you will then be able to tailor these techniques to your own use. These tutorials can get a bit complex, so take a few moments between each one to review what you just learned before moving on to the next.

Let's get started...

### How do I…

#### Create a Six-Box Effect and Save it for Reuse

Creating Six Boxes and Storing the Configurations in a Memory Register.

**Need more Information on…**

- **Keying**, see Synergy Operation Guide, Ch 7
- **3D Space**, see Synergy Squeeze & Tease 3D/WARP Owners Guide, Ch 3

In this tutorial we are going to build six Boxes by setting up the background, building the keys, selecting a sequence and saving this as a memory.

You will begin by setting up **Key 1**, using the Positioner to modify the size and position of the key on-air. Then you will copy the key to the other five keyers on the switcher. For this tutorial, you will work primarily with the Squeeze & Tease menus and the **Pattern Control Group** on the Synergy control panel.

**Before you begin:** You need a **Synergy 3** switcher with at least one free memory and **Squeeze & Tease 3D/WARP** installed for each MLE. You will also need a video source for each key.

1. We will start with setting up re-entry and key priority for the Six-Box Effect.

   On the **PGM Bus**, select **MLE 1**. This will allow us to view the keys we are setting up on **MLE 1** on the Program monitor.

   On the **MLE 1 BKGD Bus**, select the crosspoint for the background source.
Now that we have selected the Background source, we can start to build **Box 1**.

First, we need to select the video source. In **MLE 1 Key 1**, select the **PST PATT** button. Notice that the **FLY KEY** button is now lit.

Select the video source for **Box 1** on the **Key Bus** of **MLE 1**. Press **CUT** in the **MLE 1 Key 1 Group** to bring the key on-air.

You will notice that the **ON** indicator for **MLE 1 Key 1** is lit **red**, indicating that the key is on-air.

Once we have selected the video source for **Box 1**, we can modify its position in 3D Space.

Press **MLE1** and **FLY KEY1** in the **Positioner Group** to assign the **Positioner Group** to the key. The Squeeze & Tease Position/Crop Menu 1-2 will be displayed, and the **MENU** button in the **Positioner Group** will be lit.

Use the **Positioner** to move the **Key 1** back, away from the screen, by twisting the knob on the Positioner counter-clockwise. Move the Positioner left and right, up and down, to position **Box 1** in the top-right corner of the screen.

**Box 1** is now complete.
Now that we have built Box 1, we can copy it from Key 1 to Key 2 to create Box 2. Copying from one key to another ensures that all boxes are the same size.

Press and hold the PST PATT button in MLE 1 Key 2. Press the PST PATT button in MLE 1 Key 1.

You have now copied the Box from Key 1 to Key 2.

Press CUT in the MLE 1 Key 2 Group to bring the key on-air.

Now that we have created Box 2, we can position it.

Use the Positioner to move Box 2 to the bottom, right corner of the screen. Box 2 should now be directly below Box 1.

Now we can copy the Boxes we created in MLE 1 to MLE 2.

Press and hold the BKGD button in the MLE 2 Transition Group and then press the BKGD button in the MLE 1 Transition Group. The contents of MLE 1 have now been copied to MLE 2.

The ON indicators in both the MLE 2 Keyers will be lit green, showing that the keys are active.
With **MLE 1** copied into **MLE 2**, we now must re-enter **MLE 1** into **MLE 2**, and **MLE 2** into **MLE 3** so that we can view **MLE 2** on screen.

On the **BKGD Bus** of **MLE 2**, select **MLE 1** to re-enter **MLE 1** into **MLE 2**.

With **MLE 1** re-entered into **MLE 2**, we can now re-enter **MLE 2** into **MLE 3** by selecting **MLE 2** on the **PGM Bus** of **MLE 3**. You will notice that the **ON** indicators in both **MLE 2 Keys** are now be lit **red**, showing that they are active and on-air.

With **Boxes 1** and **2** from **MLE 1** copied into **MLE 2**, creating **Boxes 3** and **4**, and **MLE 2** re-entered into **MLE 3**, we can now use the **Positioner** to select the two Boxes on **MLE 2**.

In the **Positioner Group**, press **MLE 2** and then both the **FLY KEY1** and **FLY KEY2** buttons at the same time. This assigns the **Positioner Group** to both **Key 1** and **Key 2** in **MLE 2**.

With the **Positioner** assigned to the keys on **MLE 2**, we can position them.

Move the **Positioner** to the left to move **Boxes 3** and **4** to the center of the screen.
Now we can copy the Boxes we created in MLE 2 to MLE 3.

Press and hold the BKGD button in the MLE 3 Transition Group and then press the BKGD button in the MLE 2 Transition Group. The contents of MLE 2 have now been copied to MLE 3.

When we copied MLE 2 into MLE 3, the re-entry settings for MLE 3 were lost. We now must re-enter MLE 2 into MLE 3 so that we can view MLE 2 on screen.

On the PGM Bus, select MLE 2.

With Boxes 3 and 4 from MLE 2 copied into MLE 3, the re-entry settings for MLE 3 were lost. We now must re-enter MLE 2 into MLE 3, we can now use the Positioner to select the two Boxes on MLE 3.

In the Positioner Group, press MLE 3 and then both the FLY KEY1 and FLY KEY2 buttons at the same time. This assigns the Positioner Group to both Downstream Key 1 and Downstream Key 2 in MLE 3.

With the Positioner assigned to the Keys on MLE 3, we can position them.

Move the Positioner to the left to move Boxes 5 and 6 to the left-side of the screen.
At this point you should assign video sources to the Keys.

Starting with MLE 1 Key 1, press the PST PATT button in each Keyer to assign the Key Bus to the Key and then select a crosspoint for the key. Repeat this for Boxes 1, 2, 3 and 4.

For Downstream Keyer 1 and Downstream Keyer 2, select a Source button on the Downstream Keyer to assign a video source to Boxes 5 and 6.

Write down the crosspoints selection you select for each key in the space provided. For the DSKs, this will be the crosspoint button that is assigned to the Source button. You will need this information later on. If the press and hold the Source button on the DSK, the crosspoint button assigned to it will light up on the PST bus of MLE 3.

Now that you have set up our Six-Box shot, you will store your switcher settings to Memory Register 60 on the switcher.


Select Memory Bank 6 by pressing and holding BANK, on the keypad, and pressing 6. Now select Memory Register 0 on that bank by pressing 0.

Press ENTER to save the settings to the selected memory.
This tutorial showed you how to build a Six-box Effect by setting up the background, creating Boxes in six keys, selecting a transition and saving this setup to a memory. Next you will learn how to build a Sequence for each Box and store the setup as a memory again.
Build Sequences for a Six-Box Effect

Creating and saving sequences for a Six-Box Effect.

A sequence is a series of events that can be created, saved, and run from any MLE on the switcher. You can use any 3D function to manipulate the keys and objects in a sequence. You create a sequence by specifying a series of keyframes that define the state and location of an object or key in 3D space. The switcher interpolates (fills-in) the frames between the keyframes to produce fluid motion.

This tutorial teaches you how to create a sequence for each of the Boxes you created in the previous tutorial. You will then recall the memory you created in the previous tutorial, add the new sequences and re-save the memory.

Before you begin: You need a Synergy 3 switcher with Squeeze & Tease 3D/WARP installed for each MLE. You will also need the memory you created during the previous tutorial, a video source for each box and six free sequence registers.

1 The first thing we must do before we start building the sequences is to put the switcher in a known state by recalling the memory.


Select Memory Bank 6 by pressing and holding BANK, on the keypad, and pressing 6. Now select Memory Register 0 on that bank by pressing 0.
With the switcher in a known state, we will start with setting up Box 1 for your sequences.

In the **Positioner Group**, select **MLE 1** and then **FLY KEY1**. The **MENU** button will light and the S&T **Position/Crop Menu 1-2** will be displayed.

In the **Positioner Group**, select **DVE** to display the S&T **Sequence Menu 1-2**.

Verify that the S&T **Sequence Menu 1-2** displays “**Keyframes: 0**”.

If the S&T **Sequence Menu 1-2** does not display “**Keyframes: 0**”, you must clear the workspace by pressing **MORE** and then **Delete Workspace**.

Now we start building the sequence for **Box 1**.

Set the **Keyframe Duration** of the first Keyframe to 0 using the middle **Frames** knob.

In the S&T **Sequence Menu 1-2**, press **Insert Keyframe** to insert the first position into the Sequence.
4 With Keyframe 1 created, we can insert Keyframe 2.

Press DVE in the Positioner Group to return to the S&T Position/Crop Menu 1-2.

Press CENTER in the Positioner Group to bring Key 1 full screen.

Press the DVE button again to return to the S&T Sequence Menu 1-2.

Use the middle Frames knob to select a duration of 30 frames. This is how long it will be for Box 1 to travel from Keyframe 1 to Keyframe 2.

Press Insert Keyframe to insert the second position for Box 1.

5 With the sequence created, we must now save it on the switcher.

In the S&T Sequence Menu 1-2, press Load/Save to display the S&T Sequence Load/Save Menu.

Use the middle Sequence knob to select Sequnc91.

Press Save Sequence. You will have to wait for the switcher to finishing replicating the sequence before you proceed.
With the sequence for Box 1 created, we must recall the memory we stored to bring the switcher back to the starting state.


Select Memory Bank 6 by pressing and holding BANK, on the keypad, and pressing 6. Now select Memory Register 0 on that bank by pressing 0.

Now that we have created the sequence for Box 1, we can now repeat the procedure for Box 2.

In the Positioner Group, select MLE 1 and then FLY KEY2. The MENU button will light and the S&T Position/Crop Menu 1-2 will be displayed.

In the Positioner Group, select DVE to display the S&T Sequence Menu 1-2.

Verify that the S&T Sequence Menu 1-2 displays “Keyframes: 0”.

You will notice that the current MLE and Key is indicated just below the menu title on the S&T Sequence Menus.

Now we start building the sequence for Box 2.

Set the Keyframe Duration of the first Keyframe to 0 using the middle Frames knob.

In the S&T Sequence Menu 1-2, press Insert Keyframe to insert the first position into the Sequence.
With Keyframe 1 created, we can insert Keyframe 2.

Press **DVE** in the **Positioner Group** to return to the S&T Position/Crop Menu 1-2.

Press **CENTER** in the **Positioner Group** to bring Key 2 full screen.

Press the **DVE** button again to return to the S&T Sequence Menu 1-2.

Use the middle **Frames** knob to select a duration of 30 frames. This is how long it will be for Box 2 to travel from Keyframe 1 to Keyframe 2.

Press **Insert Keyframe** to insert the second position for Box 2.

With the sequence created, we must now save it on the switcher.

In the S&T Sequence Menu 1-2, press **Load/Save** to display the S&T Sequence Load/Save Menu.

Use the middle **Sequence** knob to select **Sequence92**.

Press **Save Sequence**.

With the sequence for Box 2 created, we must recall the memory we stored to bring the switcher back to the starting state.

Press **ALL** in the **Recall Area** of the **Global Memory System Group**.

Select Memory Bank 6 by pressing and holding **BANK**, on the keypad, and pressing 6. Now select Memory Register 0 on that bank by pressing 0.
With Sequences 91 and 92 created for Boxes 1 and 2, go ahead and create Sequences 93 to 96 for the remaining Boxes on the other MLEs.

As you bring each successive Key full screen, you will notice that all the previous Keys will be behind the current one.

With all the sequences created, we must recall the memory we stored to bring the switcher back to the starting state.


Select Memory Bank 6 by pressing and holding BANK, on the keypad, and pressing 6. Now select Memory Register 0 on that bank by pressing 0.

With the sequences created, we must now put the Transition Group for MLE 3 into Sequence Mode.

In the Transition Area of MLE 3, select DSK 2.

Enable Sequence Mode in MLE 3 by pressing DISS, WIPE, and DVE SEND in the MLE 3 Transition Group at the same time.
With MLE 3 in Sequence Mode, we can load the sequence we created for Box 6 into the MLE 3 Transition Group.

The display in the Global Memory System Group will show 3D MLE3 SEQ2# – –. This indicates that the keypad has been assigned to the MLE 3 Transition Group to load a sequence. The SEQ2 indicates that we are loading a sequence for DSK 3 in MLE 3.

Load Sequence 96 by selecting 9 and 6 and then pressing ENTER.

With the sequence loaded, we must now enable Flip-Flip Mode so that the sequence will run forwards and then in reverse.

In the MLE 3 Transition Group, move the fader from one limit to the next. Box 6 should grow to full screen. If you move the fader back, Box 6 jumps back to the start position and grows again.

Press the FLIP FLOP button in the Pattern Control Group. Flip-Flop allows the sequence to run forward and then reverse. Run the sequence again and Box 6 will grow and then shrink on the second transition.
With the sequences created, and MLE 3 in Sequence Mode, we must now resave the memory to include the sequences.


Select Memory Bank 6 by pressing and holding BANK, on the keypad, and pressing 6. Now select Memory Register 0 on that bank by pressing 0.

Press ENTER to save the settings to the selected memory.

This tutorial showed you how to create and save each Box to a different sequence. Next you will build a custom control for each Box to bring it to full screen and back.
The Custom Control function of the switcher allows you to program sequences of keystrokes, and other special switcher functions, as a macro. This macro is stored to dedicated buttons and banks in the Custom Control bus. Once programmed, a custom control can be played back by pressing the button in the Custom Control Bus.

This tutorial teaches you how to create and save a custom control for each Box, enabling you to recall the sequences you created in the second tutorial.

**Before you begin:** You need a Synergy 3 switcher, the memory you stored the six boxes during the first tutorial and the sequences you created in the last tutorial.

1. The first thing we must do before we start creating custom controls is to put the switcher in a known state by recalling the memory.

   Press **ALL** in the **Recall Area** of the **Global Memory System Group**.

   Select **Memory Bank 6** by pressing and holding **BANK**, on the keypad, and pressing **6**. Now select **Memory Register 0** on that bank by pressing **0**.

   **Recalling the Settings from a Memory**
With the switcher in a known state, we will start with programming the custom control for Box 1 by selecting a custom control button and adding a pause.

Press HOME to display the Main Menu 1-2 and then Custom Controls to display the Custom Controls Menu.

Use the top Bank knob to select Bank 1 and the middle Button knob to select Custom01 # 1.

Press Start Recording to start recording your custom control.

Now we will insert the pause into the custom control for Box 1.

Press Insert Special and then Special to display the Special Menu.

Use the top knob to select Pause CC and the bottom Frames knob to select 1.

Press Insert to insert the pause into your custom control.
4. With Custom Control 1 recording, we must make MLE 1 Key 1 active so that we can load a sequence in it. Press the PST PATT button in the MLE 1 Key 1 Group.

5. With the Global Memory System Group assigned to MLE 1 Key 1, we can load Sequence 96 into it. This is what allows Box 1 to appear over all the other keys. The display in the Global Memory System Group will show 3D MLE1 SEQ1# – –.

Load Sequence 96 into MLE 1 Key 1 by selecting 9 and 6 and then pressing ENTER. Box 1 will disappear from the screen, this is ok and will be fixed in the next step.
With **Sequence 96** loaded into **MLE 1 Key 1**, we must load **Sequence 91** into **DSK 2**. If we do not do this, **Box 6** will disappear when the custom control is run.

Press the lit **Source** button in **DSK 2** to assign the **Global Memory System Group** to **DSK 2**.

Load **Sequence 91** using the keypad in the **Global Memory System Group** and pressing **ENTER**.

With the sequences loaded in the MLEs we need to swap the crosspoint selection so that the correct source is in the correct Box.

On the **Key bus** of **MLE 1**, select the crosspoint button for the video signal that is selected on the **DSK 2 Source** button.

Refer to **tutorial 8, step 14**, for the list of sources.

With the crosspoint from **DSK 2** selected on **MLE 1 Key 1**, we can assign the crosspoint from **MLE 1 Key 1** to the source for **DSK 2**.

Press and hold the **Source** button on **DSK 2** and select the crosspoint for the video signal from **MLE 1** on the **PST bus** of **MLE 3**.

Refer to **tutorial 8, step 14**, for the list of sources.
With the crosspoint selections swapped, we can now add a Hold to the Custom Control. The Hold is where you will be able to bring the Box full-screen and back.

Navigate to the Custom Controls Menu by pressing HOME and then Custom Controls.

Press Insert Special, and then Special to display the Special Menu.

Use the top knob to select Hold CC and the middle knob to select 1-time Popup.

Press Insert to insert the Hold into the Custom Control.

Now we will insert another pause into the custom control for Box 1.

Press Special to display the Special Menu.

Use the top knob to select Pause CC and the bottom Frames knob to select 1.

Press Insert to insert the pause into your custom control.
At this point in the custom control, you will have finished bringing the Box full-screen and sending it back. Now, we must change the sequences and crosspoint assignments back to how they were originally.

Press the PST PATT button on the MLE 1 Key 1 Group to assign the Global Memory System Group to MLE 1 Key 1.

Load Sequence 91 into MLE 1 Key 1 by selecting 9 and 1 and then pressing ENTER.

With Sequence 91 loaded back into MLE 1 Key 1, we must load Sequence 96 back into DSK 2.

Press the lit Source button in DSK 2 to assign the Global Memory System Group to DSK 2.

Load Sequence 96 using the keypad in the Global Memory System Group and pressing ENTER.

With the sequences back to their original position, we must now swap the crosspoint selection back to how they were in the beginning.

On the Key bus of MLE 1, select the crosspoint button for the video signal that is was originally on Key 1.

Press and hold the Source button on DSK 2 and select the crosspoint for the video signal that was originally on DSK 2.

Refer to tutorial 8, step 14, for the list of sources.
Now that the sequences and crosspoint assignments are back to how they were originally, we can finish recording the custom control for Box 1.

Press HOME and then Custom Controls to display the Custom Controls Menu.

Press Finish Recording to complete the custom control for Box 1.

With the custom control for Box 1 created, go ahead and create custom controls for Boxes 2 to 6. Remember to load the appropriate sequences into DSK 2 and Sequence 96 into each key.

Remember to record the custom control for each Box to the next successive custom control. Box 1 was recorded to Custom Control 1, so Box 2 should be recorded to Custom Control 2, and so on.

This tutorial showed you how to create and save multiple custom controls, allowing you to save a number of events, such as loading sequences, and adding pauses and holds. These custom controls will be used to run your Six-Box Effect in the next tutorial.
How do I...

Run a 6-Box Effect
Using custom control to prepare each Box.

The custom controls we created in the previous tutorials set up the switcher to allow the MLE 3 Transition Group to run each sequence. From here, we can bring each Box full-screen and back in any order. To bring any particular Box full-screen, you must run the custom control for that Box. The custom control will load the sequences, swap the crosspoints and then stop and the Hold CC. At this point you will be able to use the fader or Auto Transition button in the MLE 3 Transition Group to bring the Box full-screen and back. When you are done, you will press the custom control button to allow the custom control to reset the sequences and crosspoints in preparation for the next Box.

This tutorial teaches you how to use the custom controls created in the previous tutorial to actually bring each Box full-screen and back.

Before you begin: You need a Synergy 3 switcher, the memory you stored during the tutorial, the sequences you created in the tutorial, and the custom controls you created in the previous tutorial.

1

The first thing we must do before we start using the custom controls is to put the switcher in a known state by recalling the memory.


Select Memory Bank 6 by pressing and holding BANK, on the keypad, and pressing 6. Now select Memory Register 0 on that bank by pressing 0.
With the switcher in a known state, we can run a custom control and bring Box 1 full-screen and back.

Press Custom Control 1 to run the first custom control. This is the custom control that we created for Box 1. The custom control will instantly swap the sources and load the sequences and wait at the Hold CC.

The custom control button will remain lit, indicating it is still running.

With Custom Control 1 running, Box 1 is now active and can be brought full-screen and back using the fader or an auto transition.

Move the fader in the MLE 3 Transition Group from one limit to the other. Box 1 will grow from the start position to full-screen.

Move the fader back to its original position and Box 1 will shrink back to the starting position.

When you are done sending Box 1 back the starting position we can finish the custom control.

Press Custom Control 1 to allow the custom control to finish. The custom control will instantly load the sequences and swap the crosspoint back to how they were before the custom control was run.

It is very important that you finish the custom control before attempting to run another.
5 Now that we have brought Box 1 full-screen and back, we can activate Box 3 and perform the same action.

Press Custom Control 3 to run the custom control for Box 3. The custom control will instantly swap the sources and load the sequences and wait at the Hold CC.

6 With Custom Control 3 running, Box 3 is now active and can be brought full-screen and back.

Instead of using the fader, this time we will use the AUTO TRANS button in the MLE 3 Transition Group.

Press the AUTO TRANS button, Box 3 will be brought full-screen. The rate at which this happens is 30 frames, or 1 second. This is the rate we set for Keyframe 2 when we built the sequences.

Press the AUTO TRANS button again to send Box 3 back to the start position.

7 When you are done working with Box 3 we can finish the custom control.

Press Custom Control 3 to allow the custom control to finish. The custom control will instantly load the sequences and swap the crosspoint back to how they were before the custom control was run.

8 Now that we have worked with a few different Boxes, try bringing the remaining Boxes full-screen and back.

This tutorial showed you how to run custom controls and transition between any of the six boxes.
Glossary of Terms

**Active Video Lines** — All video lines not occurring in the vertical blanking interval. The portion of the video signal that contains picture information.

**Aspect Ratio** — The numerical ratio of picture width to height, for example, 4:3 or 16:9.

**Auto Transition** — An automatic transition that electronically simulates the manual movement of the fader handle. The transition starts when the AUTO TRANS button is pressed and takes place over a pre-selected time period, measured in frames.

**Border** — Effects created around the edges of a pattern or on a keyer. If an optional dual border generator card is installed, several border, shadow, and outline effects are available on that keyer as well.

**Border Generator** — Circuitry that generates various border effects on keys created by the switcher.

**Chroma Key** — An effect where video from one source replaces video of a specific hue in a second video source. The blue and green hues are most commonly used for chroma keying.

**Chrominance** — The “depth” or saturation of a color. The three characteristics of a TV color signal are chrominance, luminance and hue.

**Cut** — An instantaneous switch from one video signal to another.

**Dissolve** — A transition from one video signal to another where one signal is faded down while the other is simultaneously faded up. The term “mix” is often used interchangeably with “dissolve”.

**Downstream Keyer (DSK)** — A keyer that places a key “downstream” of the MLE effects system output. This “top level” effect usually consists of a character generator title.

**External Key** — A video input (non-primary video) used to produce a key effect. Examples of external key sources are character generators and cameras.

**Fade-to-Black** — A controlled change of the on-air picture signal level down to black level.

**Field** — One half of a complete picture (or frame) interval containing all of the odd, or all of the even lines in interlaced scanning. One scan of a TV screen is called a “field”; two fields are required to make a complete picture (which is a “frame”).
**Field Frequency** — The rate at which one complete field is scanned, approximately 50 times per second in 625 video, or 60 times per second in 525 video.

**Frame** — One complete picture consisting of two fields of interlaced scanning lines.

**GPI** — An abbreviation for General Purpose Interface, a device that typically allows remote control of the switcher’s automatic transition functions.

**Hue** — The characteristic of a color signal that determines whether the color is red, yellow, green, blue, purple, etc. (the three characteristics of a TV color signal are chrominance, luminance, and hue). White, black, and gray are not considered hues.

**Internal Key** — The use of a primary input to produce a key effect.

**Key** — An effect produced by “cutting a hole” in background video, then filling the hole with video or matte from another source. Key source video cuts the hole, key fill video fills the hole. The video signal used for cut and fill can come from the same or separate sources.

**Key Fill** — A video input which is timed to “fill the hole” provided by the key source video. An example of key fill is the video output of a character generator.

**Key Invert** — An effect that reverses the polarity of the key source so that the holes in the background are cut by dark areas of the key source instead of bright areas. The **KEY INV** push-button selects this effect.

**Key Mask** — A keying technique in which a pattern is combined with the key source to block out unwanted portions of the key source.

**Key Source** — The video signal which “cuts a hole” in the background video to make a key effect possible. Also called “Key Video”. In practice, this signal controls when a video mixer circuit will switch from background to key fill video.

**Key Video** — See Key Source.

**Linear Keys** — Linear keys make it possible to fully specify the transparency of a key from opaque, through transparent, to fully off. The transparency is specified by the key signal (also known as the “hole cutter” or “alpha channel”) that is associated with the key fill. A keyer capable of a linear key converts the key signal voltage directly to the transparency effect on the screen. Our switcher’s **KEY MEM** button allows the user to store the CLIP and GAIN settings required to match the incoming key signal to the keyer’s requirements.

**Line Frequency** — The number of horizontal scans per second. For 525 line 60 Hz systems, this is approximately 15734 scans per second.

**Luminance Key** — An effect in which video from one source is replaced by video that exceeds a set level in a second video source.

**Mask** — See Key Mask.

**Matte** — A solid color signal that is generated by the switcher and can be adjusted for hue, saturation, and luminance levels.

**Matte Key** — A key effect in which the fill video is matte, provided by one of the switcher’s matte generators.

**Memory** — The memory feature provides storage and recall of complete switcher setups.
MIX — See Dissolve.

MLE — An abbreviation for multi-level effects.

PGM Output — The on-air video output of the system.

Primary Input — Video sources selected by the control panel push-buttons for the crosspoint buses. These buses are normally labeled “KEY”, “PGM”, and “PST”.

PV Output — A switcher output that shows the scene that will go on-air when the next automatic or manual transition takes place.

Self Key — A key effect in which the same video signal serves as both the key signal and key fill.

Soft Edge — A pattern edge effect produced by mixing key source and key fill signals in such a way that the edge of the pattern is not sharp.

Split Screen — An effect in which a wipe pattern provides the key source signal. This is known as a “preset pattern” key.

Tally — An indicator which illuminates when the associated push-button or control is selected or is on-air.

Termination — A means of closing a circuit by connecting a resistive load to it. In video systems, a termination is typically a 75 ohm resistive load.

Transition — A controlled change from one video input to another video input or black. The change can occur through a wipe, cut, dissolve or “DVE Send” effect.

Transition Preview — A transition seen only on the preview monitor. It may be observed and adjusted without disturbing the program or “on-air” output.

Video — The electrical signal produced by a television camera, character generator or other image source. The signal amplitude varies in relation to the tonal scale from black to white presented at the source. White produces the highest amplitude; black produces the lowest signal amplitude.

Wipe — A transition from one video signal to another, in which the change proceeds according to the shape of a specific pattern. A moving transition line separates the two picture signals.
Index

Numerics

1+0 DVE .............................................................. 11-2
1+1 DVE .............................................................. 11-2
14x9
  aspectizer look........................................... 13-16, 13-31, 13-42
  tall aspectizer look...................................... 13-16, 13-31, 13-43
  wide aspectizer look.................................... 13-16, 13-31, 13-42
16x9/4x3 toggle
  Bus Mode ................................................... 13-24, 13-28, 13-30
  Input Mode .................................................. 13-14, 13-21

A

Alpha, clean feed.............................................. 11-8
Aprisa 100 Still Store interface.......................... 10-61
Arm mode, ROLL VTR ........................................ 14-4, 14-24
Asp pass cap................................................... 13-17, 13-44
Aspect ratio, setup.......................................... 13-10
Aspectizer
  bkgd color................................................... 13-17, 13-32, 13-43
  bus mode operation...................................... 13-33
  bus mode setup.......................................... 13-24
  double aspectizing in downstream mode ............ 13-38
  downstream mode setup................................ 13-37
  input mode setup........................................ 13-12
  look....................................................... 13-15, 13-30
  main menu................................................ 13-10, 13-11, 13-24, 13-37
  modes of operation..................................... 13-11
  overview.................................................. 13-2
  superblack................................................ 13-16, 13-32, 13-43
  upgrade softkey......................................... 13-10, 13-11
Aspectizer board
  description................................................ 13-2
  dual channel.............................................. 13-12
  location.................................................... 13-24
  setup...................................................... 13-10
  socket number.......................................... 13-12

Aspectizer look
  14x9...................................................... 13-16, 13-31, 13-42
  14x9 Tall................................................ 13-16, 13-31, 13-43
  14x9 Wide.............................................. 13-16, 13-31, 13-42
  description............................................. 13-4
  downstream mode...................................... 13-41
  full screen............................................. 13-15, 13-30, 13-41
  input mode.............................................. 13-13
  letterbox.............................................. 13-15, 13-30, 13-42
  menu...................................................... 13-14, 13-20, 13-30
  pan and scan.......................................... 13-16, 13-31, 13-42
  pillarbox.............................................. 13-15, 13-31, 13-42
Assign group, Aux Bus.................................. 10-69
Assignable Aux panel
  modes....................................................... 10-72
  overview.................................................. 10-70
  using...................................................... 10-73
Audio Servers
  clip (cut) registers................................... 14-16, 14-18
  clip control............................................. 14-2
  clip name................................................ 14-18
  clip setup.............................................. 14-18
  clip, communications setup......................... 14-5
  clips, overview....................................... 14-3
  control option......................................... 14-2
  custom controls....................................... 14-7
  Cut ID.................................................... 14-7, 14-16
  Cut Name................................................ 14-7, 14-16
  Cut Time................................................. 14-7, 14-16
  program clips.......................................... 14-18
  program custom control setup....................... 14-6
  using clips............................................. 14-22
Auto Chroma Key, Ultimatte.............................. 12-11
Auto transition, GPI...................................... 10-3
Aux Bus
  assign group............................................ 10-69
  bus follow mode..................................... 13-25
  bus follow mode, Ultimatte......................... 12-8
  bus mode................................................. 13-25
  bus mode, Aspectizer................................. 12-7
  crosspoint row........................................ 10-67
  external device assignment menu.................. 11-12
  group..................................................... 10-66
  group, Synergy 2....................................... 10-66
  group, Synergy 3....................................... 10-67
  group, Synergy 4....................................... 10-67
  remote panels......................................... 10-70
### Synergy Series Operation Guide (v18)

**B**

Betacam protocol........................................... 14-2
Bkgd color, aspectizer ........................................... 13-17
Black
  - balance .......................................................... 12-14
  - gloss .......................................................... 12-12
Blue
  - density .......................................................... 12-14
  - veil ............................................................ 12-16
BNC
  - assign .......................................................... 13-27
  - configuration menu tree ........................................ 16-2
  - name inputs ...................................................... 13-10
  - setup types ....................................................... 13-10
  - type menu .......................................................... 13-10
BNC Setup, video servers ........................................ 14-2
Bus Assign.......................................................... 13-26
Bus Follow
  - aux bus, aspectizer ........................................ 13-25
  - aux bus, Ultimatte .......................................... 12-8
  - bus mode, aspectizer .......................................... 13-26
  - bus mode, Ultimatte .......................................... 12-8
Bus Hold
  - Aux Bus Crosspoint row ......................................... 10-68
Bus mode, Aspectizer
  - aux bus .......................................................... 13-25
  - BNC assign ....................................................... 13-27
  - bus assign ....................................................... 13-26
  - bus follow ....................................................... 13-26
  - bus follow assign .............................................. 13-26
  - bus-pair selection ............................................ 13-24
  - bus-pairs ......................................................... 13-28
  - definition ......................................................... 13-24
  - features ........................................................... 13-8

**C**

Camera, remote control interface .................................. 10-6
Canon remote camera
  - auto control ...................................................... 10-12
  - focus, adjusting .................................................. 10-13
  - iris, adjusting ...................................................... 10-13
  - manual control .................................................... 10-12
  - operation ......................................................... 10-11
  - pan, adjusting ..................................................... 10-12
  - recall a shot ....................................................... 10-13
  - store a shot ......................................................... 10-13
  - tilt, adjusting ...................................................... 10-12
  - wiper, using the .................................................. 10-13
  - zoom, adjusting ................................................... 10-12
Carrier mode, Ultimatte Insider .................................... 12-2
CDK-111A-M
  - downstream key group, Synergy 2 ................................ 15-6
  - downstream key group, Synergy 3 and 4 .......................... 15-7
  - keying ............................................................... 15-3
  - overview ........................................................... 15-2
  - warnings ........................................................... 15-3
Chyron Character Generators
  changing preview text ........................................ 10-47
  operation overview ........................................ 10-44
  playing animation ........................................... 10-50
  recalling a page to preview ................................ 10-45
  selecting a folder .......................................... 10-44
  swapping preview and program ............................ 10-49
CLEAN FEED
  aux bus ....................................................... 10-68
  crosspoint .................................................... 10-68
Clean feed
  alpha .................................................................. 11-8
  menu .................................................................... 11-8
Clip
  audio server .................................................... 14-2
  audio server, communications setup .................... 14-5
  name menu ...................................................... 14-9, 14-12, 14-18
  program audio server ....................................... 14-18
  program custom control ................................... 14-6
  program video server ....................................... 14-11
  program VTR .................................................... 14-8
  programming .................................................... 14-8
  using audio server .......................................... 14-22
  using video server .......................................... 14-22
  using VTR ....................................................... 14-22
  video server .................................................. 14-2
  video server, communications setup .................... 14-5
  VTR control .................................................... 14-2
  VTR, communications setup ................................ 14-5
Clip Inpoint/Outpoint, video servers ......................... 14-13
Clip Name ................................................................ 14-9, 14-12, 14-18
Clip Registers
  audio server ...................................................... 14-16, 14-18
  naming .............................................................. 14-9, 14-12, 14-18
  timecode .......................................................... 14-9
  timecode, grab .................................................. 14-10, 14-15
  video server ..................................................... 14-11
  VTR ................................................................. 14-8
Closed Caption, Asp pass cap feature ......................... 13-17, 13-44
Color knob, Ultimatte ........................................... 12-12
Communications
  menu tree .......................................................... 16-4
  type menu ......................................................... 11-2
Connection, DVE ................................................ 11-2
Custom control
  audio server ...................................................... 14-7
  bank setup menu tree ........................................ 16-6
  GPI input setup ................................................. 10-4
  group ............................................................... 14-6
  looping, create a .............................................. 17-29
  menu tree ........................................................ 16-5
  VTR ................................................................. 14-6
Cut ID, Audio Server ............................................. 14-7, 14-16
Cut Name, Audio Server ........................................ 14-7, 14-16
Cut Time, Audio Servers ....................................... 14-7, 14-16
Cuts, Audio Server .............................................. 14-16, 14-18

D
Dedicated Aux Panel
  modes .............................................................. 10-72
  remote ............................................................ 10-70
  using .............................................................. 10-73
Density
  blue .................................................................... 12-14
  green .................................................................. 12-14
  red ...................................................................... 12-14
Digicart protocol ..................................................... 14-2
Disk menu tree ...................................................... 16-7
Downstream Keying with the CDK-111A-M ................. 15-3
Downstream mode
  aspect ratio ........................................ 13-41
  double aspectizing ................................ 13-38
  dual output production .................. 13-4, 13-5
  menus ........................................ 13-37
  MLE PGM ....................................... 13-37
  setup ........................................... 13-37
  uses ............................................. 13-9
  warnings ..................................... 13-41
  with bus mode ........................ 13-40
  with input mode ....................... 13-40

DSK
  key groups .................................. 15-6
  with the CDK-111A-M ................... 15-3

DSK 3/4 Menu ........................................ 15-3

Dual output production
  downstream mode .......... 13-4, 13-5, 13-37
  extra content ................. 13-4, 13-6

DVE
  1+0 ........................................ 11-2
  1+1 ........................................ 11-2
  connection types .................. 11-2
  enhanced remote control .......... 11-11
  INCL .................................... 11-11
  recall .................................... 11-11
  SEND ................................... 11-4
  SEND, Aux Bus ...................... 10-68
  send, clean feed alpha ............ 11-8
  send, important notes ............ 11-8
  send, perform transition ........ 11-4
  send, understanding operations ... 11-2
  send, valid transitions .......... 11-6
  send, with KEY OVER ............. 11-7
  shot box ................................ 11-11

DVE Xtreme protocol .................. 11-5

E

Eagle Pan Tilt System
  focus, adjusting ...................... 10-19, 10-31
  iris, adjusting ...................... 10-19, 10-31
  operation ............................. 10-18, 10-29
  pan, adjusting ...................... 10-19, 10-30
  pedestal, adjusting ............... 10-19, 10-31
  store a shot ......................... 10-20, 10-31
  tilt, adjusting ..................... 10-19, 10-30
  wiper, using the ................... 10-20

  zoom, adjusting .................... 10-19, 10-30

Editor interface ......................... 10-62

Effects Dissolve ....................... 17-2, 17-8

Effects, modifying CG events ........ 10-40

Effects, tutorial ................... 17-29

Enter Clip ID, video servers ........ 14-12

Extra content, dual output production .... 13-6

F

Fade to Black, GPI .................. 10-3

Flare suppression .................. 12-14

Follow mode, Aux Panel ........... 10-72

Full Screen aspectizer look ........ 13-15, 13-30, 13-41

G

Gate 1/3 ..................................... 12-15, 12-16

Gate 2 ...................................... 12-15

Global memory system group
  editor interface .................. 10-62
  still store mode ................ 10-61

GPI
  area ........................................ 10-3
  auto transition .................... 10-3
  aux panel override .............. 10-72
  control ................................ 10-2
  custom control setup .......... 10-4
  fade to black ...................... 10-3
  input control, area, button .... 10-2
  input function ..................... 10-2
  input setup menu ................ 10-2
  memory recall control setup .... 10-4, 10-5
  output control .................... 10-5
  output function .................... 10-2
  setup ................................... 10-2
  setup menu ........................... 10-2, 10-4

Grab
  timecode, video server ........... 14-15
  timecode, VTR ....................... 14-10

Gray Balance .......................... 12-14

Green
  density ................................ 12-14
  veil .................................... 12-16

Group
  aux bus ................................ 10-66
  downstream key .................. 15-6
  global memory system ........... 10-62
global memory system, still store mode .......................... 10-61
GVG protocol .................................................................... 10-62

H
How Do I...
Effect, repeat indefinitely ................................................................. 17-29
Effects Dissolve ........................................................................... 17-2, 17-8
Key, move smoothly ........................................................................ 17-2
Looping Custom Control, create a ............................................ 17-29
Object, create an ........................................................................... 17-8
Over the Shoulder Box
create an ..................................................................................... 17-8
move along a preset path ................................................................. 17-18, 17-53
reuse ................................................................................................ 17-8
Remote Port Expander
connect ......................................................................................... 17-38
connecting devices to ................................................................. 17-43
setup ............................................................................................... 17-40
Sequence, creating a ........................................................................ 17-18, 17-53
Serial Devices
communications setup ................................................................. 17-40
connect ......................................................................................... 17-38, 17-43
Six-Box Effect
building sequences ......................................................................... 17-53
creating custom controls to run ..................................................... 17-61
saving to a memory register ............................................................ 17-46

I
INCL DVE ...................................................................................... 11-11
Indicators
N/S, aux bus .................................................................................. 10-69
ON AIR, Aux Bus .......................................................................... 10-69
Inpoint, Video Server Clip .............................................................. 14-13
Input
GPI control ..................................................................................... 10-2
name BNC ....................................................................................... 13-10
Input Carrier Board option ............................................................ 12-2, 13-12
Input mode
assigning inputs ............................................................................... 13-12
definition ......................................................................................... 13-12
menus ............................................................................................... 13-13
mode selection ............................................................................... 13-12
operation .......................................................................................... 13-18
personality registers ...................................................................... 13-12
setup ................................................................................................. 13-12
single output production ................................................................. 13-4, 13-19, 13-20
uses ................................................................................................. 13-7
with downstream mode .................................................................. 13-38
Input vs. Bus vs. Downstream mode ............................................... 13-7
Installation setup menu tree ............................................................ 16-3

K
KEY OVER...................................................................................... 11-7
Key, move smoothly tutorial ........................................................... 17-2
Key1 bus-pair ................................................................................. 13-24
Key2 bus-pair ................................................................................. 13-24

L
Letterbox aspectizer look ................................................................. 13-15, 13-30, 13-42
Look
aspectizer ....................................................................................... 13-30
aspectizer, 14x9 ............................................................................ 13-16, 13-31, 13-42
aspectizer, 14x9 Tall ...................................................................... 13-16, 13-31, 13-43
aspectizer, 14x9 Wide ................................................................... 13-16, 13-31, 13-42
aspectizer, full screen ..................................................................... 13-15, 13-30, 13-41
aspectizer, letterbox ....................................................................... 13-15, 13-30, 13-42
aspectizer, pan and scan ............................................................... 13-14, 13-41
aspectizer, pillarbox ....................................................................... 13-15
aspectizer, softkey ......................................................................... 13-14, 13-41
Looping, VTR clip .......................................................................... 14-25
Louth see VDCP

M
Manual Mode, Character Generator .............................................. 10-33
Matte
density .......................................................................................... 12-12
gain ................................................................................................. 12-12
Matte Out Tie ON/OFF ................................................................. 12-16
Memory
area, still store mode ................................................................. 10-61
recall GPI input setup .................................................................... 10-4, 10-5
registers, Aspectizer bus mode ..................................................... 13-24
Menu
aux bus external device assignment .............................................. 11-12
aux bus setup ................................................................................. 13-25
BNC type ......................................................................................... 13-10
clean feed ...................................................................................... 11-8
clip name ......................................................................................... 14-9, 14-12, 14-18
communications type .................................................................... 11-2
DSK 3/4 ......................................................................................... 15-3
GPI input setup ............................................................................... 10-2
GPI setup ........................................................................................ 10-2, 10-4
input mode ....................................................................................... 13-13
option cards........................................... 12-4, 12-6
outputs ..................................................... 11-8
recall DVE .................................................. 11-11
remote control, video server clips................. 14-21
remote control, VTR clips ............................ 14-22
Router Matrix Control ................................ 10-64
tree, custom control banks ......................... 16-6
Ultimate color density ................................. 12-13
Ultimate flare balance ................................ 12-14
Ultimate flare gate ................................... 12-15
Ultimate matte out gain ............................... 12-11
Ultimate Matte Out Tie ON/OFF .................. 12-16
Ultimate matte size/position ...................... 12-13
Ultimate primary ............................ 12-11, 12-12
Ultimate shadow noise ................................ 12-12
Ultimate veil colors ................................ 12-16
Ultimate veil master ................................ 12-15
VTR clips ............................................. 14-8, 14-11, 14-18
Menu tree
BNC configuration .................................... 16-2
communications ..................................... 16-4
custom control ........................................ 16-5
disk ................................................................ 16-7
installation setup ..................................... 16-3
recall factory ......................................... 16-8
MLE 1 Aux Bus ....................................... 10-68
MLE 2 Aux Bus ....................................... 10-68
MLE 3 Aux Bus ....................................... 10-68
MLE aspect ratio setup ............................. 13-10
Mode
Character Generator ................................ 10-33
input vs. bus vs. downstream ...................... 13-7
Modes of operation, Aspectizer .................... 13-4
Multiple channels, video servers ............... 14-2
N
N/S Aux Bus............................................... 10-69
Naming
Audio Server Clips ................................ 14-18
BNC inputs ............................................ 13-10
Video Servers Clips ................................ 14-12
VTR Clips ........................................ 14-9
Non-sync, indication .................................. 10-69
O
Object, creating an.................................. 17-8
ON AIR Aux Bus .................................... 10-69
Operation
Aspectizer modes ..................................... 13-4
input mode ............................................. 13-18
routers ............................................... 10-64
Ultimate, bus mode ................................ 12-11
Ultimate, carrier mode ............................ 12-11
understanding DVE send ......................... 11-2
Option
audio server control ................................ 14-2
cards menu ...................................... 12-4, 12-6
disk .................................................. 16-4
disk .................................................. 16-7
roller ............................................. 16-3
recall factory ......................................... 16-8
MLE 1 Aux Bus ....................................... 10-68
MLE 2 Aux Bus ....................................... 10-68
MLE 3 Aux Bus ....................................... 10-68
MLE aspect ratio setup ............................. 13-10
Mode
Character Generator ................................ 10-33
input vs. bus vs. downstream ...................... 13-7
Modes of operation, Aspectizer .................... 13-4
Multiple channels, video servers ............... 14-2
N
N/S Aux Bus............................................... 10-69
Naming
Audio Server Clips ................................ 14-18
BNC inputs ............................................ 13-10
Video Servers Clips ................................ 14-12
VTR Clips ........................................ 14-9
Non-sync, indication .................................. 10-69
O
Object, creating an.................................. 17-8
ON AIR Aux Bus .................................... 10-69
Operation
Aspectizer modes ..................................... 13-4
input mode ............................................. 13-18
routers ............................................... 10-64
Ultimate, bus mode ................................ 12-11
Ultimate, carrier mode ............................ 12-11
understanding DVE send ......................... 11-2
Option
audio server control ................................ 14-2
cards menu ...................................... 12-4, 12-6
disk .................................................. 16-4
disk .................................................. 16-7
roller ............................................. 16-3
recall factory ......................................... 16-8
MLE 1 Aux Bus ....................................... 10-68
MLE 2 Aux Bus ....................................... 10-68
MLE 3 Aux Bus ....................................... 10-68
MLE aspect ratio setup ............................. 13-10
Mode
Character Generator ................................ 10-33
input vs. bus vs. downstream ...................... 13-7
Modes of operation, Aspectizer .................... 13-4
Multiple channels, video servers ............... 14-2
P
Pan and Scan, aspectizer look ............. 13-16, 13-31, 13-42
Panasonic Pan/Tilt Head
focus, adjusting ................................... 10-22
iris, adjusting ....................................... 10-22
operation .............................................. 10-21
pan, adjusting ..................................... 10-21
recall a shot ......................................... 10-23
store a shot ......................................... 10-23
tilt, adjusting ...................................... 10-21
wiper, using the ........................................... 10-22
zoom, adjusting ........................................... 10-21


Parkervision CameraMan camera
  focus, adjusting ........................................... 10-24
  iris, adjusting ........................................... 10-24
  operation ................................................ 10-23
  pan, adjusting .......................................... 10-24
  pedestal, adjusting .................................... 10-24
  recall a shot ............................................ 10-25
  store a shot ............................................. 10-25
  tilt, adjusting .......................................... 10-24
  zoom, adjusting ........................................ 10-24

Partial bus mode, Aspectizer ............. 13-25
Partial bus mode, Ultimatte ............ 12-7
Personality registers, Aspectizer ....... 13-12
PGM Aux Bus ........................................ 10-69

Pinnacle FXDeko II
  Effects ................................................. 10-54
  modifying effects .................................... 10-55
  operation overview .................................. 10-52
  recalling a page to preview ... 10-52, 10-59, 10-60
  recalling a page to program ...................... 10-53
  swapping preview and program .................. 10-58

Play mode, ROLL VTR ...................... 14-4, 14-23

Play Speed, VTR clip .......................... 14-24

Preview overlay, VTR timecode ........ 14-22

Programming
  clips ..................................................... 14-8
  custom control ....................................... 14-6

Protocol
  Betacam ............................................... 14-2
  DigiCart ............................................... 14-2
  DVExtreme ........................................... 11-5
  GVG .................................................... 10-62
  VDCP .................................................. 14-2

R

Radamec remote camera
  focus, adjusting ..................................... 10-10
  iris, adjusting ....................................... 10-10
  operation .............................................. 10-9
  pan, adjusting ....................................... 10-9
  pedestal, adjusting .................................. 10-9
  recall a shot ....................................... 10-10
  store a shot ........................................ 10-10
  tilt, adjusting ...................................... 10-9
  zoom, adjusting .................................... 10-9

Recall
  DVE menu ............................................. 11-11
  factory, menu tree .................................. 16-8

Red
  density ................................................. 12-14
  veil .................................................... 12-16

Regular mode, Aux Panel ................ 10-72

Remote
  Aux panel ............................................ 10-70
  Aux panel override .................................. 10-72
  Aux panels, Synergy 2 ............................. 10-70
  Aux panels, Synergy 3 ............................. 10-71
  Aux panels, Synergy 4 ............................. 10-71
  camera control, operation ....................... 10-6
  control menu, video server clips ............. 14-21
  control menu, VTR clips .......................... 14-22
  control, enhanced DVE ........................... 11-11

Remote camera control
  Canon ............................................... 10-11
  Eagle Pan Tilt System .................. 10-18, 10-29
  operation overview ................................. 10-6
  Panasonic Pan/Tilt Head ..................... 10-21
  Parkervision CameraMan camera ............ 10-23
  Radamec .............................................. 10-9
  Shotoku TR-8S ................................... 10-26
  Sony .................................................. 10-14
  Telemeterics ........................................ 10-6

Remote Port Expander
  communications setup, tutorial .......... 17-40
  connect, tutorial .................................... 17-43
  connect, tutorial on .............................. 17-38

Repair policy ...................................... 1-7

ROLL VTR
  arm mode ......................................... 14-4, 14-6, 14-23, 14-24
  play mode .......................................... 14-4, 14-23

Routers
  Communications Notes ....................... 10-65
  matrix control menu .............................. 10-64
  operation .......................................... 10-64

S

Selecting
  channels, Character Generator .......... 10-44
  Video Servers Clips ............................. 14-12
Sequence
- creating a, tutorial ........................................ 17-18, 17-53
- Mode, Character Generator ............................. 10-33
Serial Devices
- communications setup, tutorial ....................... 17-40
- connect ..................................................... 17-38
- connecting, tutorial .................................... 17-43
Setup
- BNC types ................................................... 13-10
- GPI ........................................................... 10-2
- MLE aspect ratio ......................................... 13-10
- Ultimatte auto select key ................................. 12-10
Shadow, noise ................................................. 12-12
SHIFT, Aux Bus ............................................. 10-68
Shot box, DVE ................................................ 11-11
Shotoku TR-8S
- focus, adjusting .......................................... 10-27
- iris, adjusting ............................................ 10-27
- location, adjusting ....................................... 10-27
- operation .................................................... 10-26
- pan, adjusting ............................................ 10-26
- recall a shot .............................................. 10-28
- store a shot ............................................... 10-28
- tilt, adjusting ............................................. 10-26
- zoom, adjusting ......................................... 10-26
Shuttle Speed control ........................................ 14-25
Single output production
- bus mode .................................................... 13-4, 13-5, 13-34
- input mode ................................................ 13-4, 13-19
Slots, Synergy .................................................. 10-75
Slow motion, VTR clips ..................................... 14-23, 14-24
Sony robotic camera
- auto mode .................................................. 10-15
- digital zoom .............................................. 10-15
- focus, adjusting ........................................ 10-16
- image ratio, adjusting .................................. 10-16
- iris, adjusting .......................................... 10-16
- manual mode ............................................ 10-15
- operation ................................................... 10-14
- optical zoom ............................................. 10-15
- pan, adjusting .......................................... 10-14
- picture effect, adjusting ............................... 10-16
- recall a shot .............................................. 10-17
- shutter speed, adjusting .............................. 10-16
- store a shot .............................................. 10-16
- tilt, adjusting ............................................ 10-14
- white balance, adjusting ............................. 10-16
- zoom, adjusting ........................................ 10-14
Speed Control, VTR ......................................... 14-25
Static discharge ............................................. 1-6
Still Store
- changing still ID ......................................... 10-61
- global memory system mode ......................... 10-61
- interface ................................................... 10-61
- using the Global Memory System Group ......... 10-61, 10-62
Superblack, aspectizer bkgd ............................. 13-16, 13-32, 13-43
Synergy 2
- aux bus group .......................................... 10-66
- OverDrive operation ................................... 10-62
- remote aux panels ..................................... 10-70
Synergy 3
- aux bus group .......................................... 10-67
- remote aux panels ..................................... 10-71
Synergy 4
- aux bus group .......................................... 10-67
- remote aux panels ..................................... 10-71
Synergy Slots .................................................. 10-75

T
Telemetrics remote camera
- focus, adjusting ........................................ 10-7
- iris, adjusting .......................................... 10-7
- location, adjusting ..................................... 10-8
- operation ................................................... 10-6
- pan, adjusting .......................................... 10-6
- pedestal, adjusting .................................... 10-7
- recall a shot .............................................. 10-9
- store a shot .............................................. 10-8
- tilt, adjusting ............................................ 10-6
- zoom, adjusting ........................................ 10-6
Telemetrics remote camera ................................ 10-6
Toggle 16x9/4x3
- Bus Mode .................................................. 13-24, 13-28, 13-30
- Input Mode ............................................... 13-13, 13-14
Transition
- DVE send .................................................. 11-4
- valid, DVE send ......................................... 11-6

U
Ultimatte
- Auto Chroma Key ........................................ 12-11
- auto select key setup .................................. 12-10
timecode overlay........................................... 14-22
using clips..................................................... 14-22
VTR Speed control........................................... 14-25

W
Warnings
  bus mode..............................................13-33, 13-35, 13-36
  downstream mode........................................... 13-41
  general rules........................................... 13-18
  input mode.............................................13-20, 13-22, 13-23
Warranty ......................................................... 1-7
White Balance ........................................... 12-14

X
  X Position ............................................. 12-13
  X Size ..................................................... 12-13

Y
  Y Size ..................................................... 12-13